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To get the best image quality from your 
SLR or compact system camera, you need 
to be shooting in the raw image format. 
Raw files contain much more detail in 
the scene compared with a simple JPEG, 
and provide far more flexibility to adjust 
contrast, colour and exposure at the 

editing stage. If you tried to do the same with a JPEG, you’ll 
soon end up with a pixelated mess!

There are many ways to process your raw files, and the 
most popular and best software is one of the Photoshop 
family of programs. Whether you use Photoshop CS or CC, 
Photoshop Lightroom or Photoshop Elements, the conversion 
process is powered using the powerful built-in plugin called 
Adobe Camera Raw.

The range of controls you get in Adobe Camera Raw 
depends on the version of Photoshop you’re using. You get 
a greater range of features with Photoshop CC, for instance, 
than you do with Photoshop Elements 12. But the core 
functionality is available in all versions, so whatever version 
of Photoshop you’re using, you’ll be sure to find plenty in 
this book to improve your photo-editing skills.

We hope you enjoy learning with this guide. And because 
you bought this book we’d also like to offer you a 40% 
discount off our extended 50-part Teach yourself 
Raw in Photoshop interactive DVD training course. 

To claim the discount, simply use the voucher code  
MFMDVD at www.myfavouritemagazines.co.uk/photo

George Cairns, Author
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Organise 
with Bridge
Get started in raw processing fast by learning the 
best ways to import and organise your images

08 Introducing the 
Bridge workspace
Get to know the key areas of Bridge’s 

photo-organising workspace and discover how to 
customise it to suit your needs

10 Import your photos 
into Bridge
Import images from your camera 

into Bridge, and organise and convert them in 
preparation for editing in Photoshop

12 Add metadata and 
keywords to your images
Discover how to protect your photos 

and make them easier to find in the future using 
embedded image metadata

16 Organise your 
images in Bridge
Use Bridge’s asset management tools

to help you find particular pictures quickly and
easily using Collections
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Introducing the 
Bridge workspace
Get to know the key areas of Bridge’s photo-organising workspace 
and discover how to customise it to suit your needs

Get to know the key features of Adobe Bridge

Photoshop Anatomy The Bridge workspace

1 FOLDERS

Click the Folders tab to browse to 
any folder of images stored on your 
PC. Drag your most commonly used 
folders into the Favorites panel.

3 WORKSPACES

These links enable you to change the 
way panels and images are displayed 
in Bridge. For example, the Filmstrip 
option gives you larger previews.

2 THUMBNAILS

Bridge displays your images as 
thumbnails. You can use the slider 
at the bottom of the workspace to 
increase the thumbnail size.

4 METADATA

This panel emulates the display on your 
digital SLR. It reads the metadata stored 
in the currently active thumbnail so that 
you can discover what shutter speed, 
ISO and aperture settings where used 
to capture the image. It also shows the 
metering modes.

 
5 FILTERS

This panel enables you to present files 
that meet specific criteria, such as 
those with a specific star rating. You 
can also filter the files’ metadata and 
discover images that were captured 
with a particular shutter speed setting, 
for example.

6 KEYWORDS

This panel enables you to quickly assign 
descriptive keywords to a photo. You 
can then use the Filter panel to display 
photos that contain a specific keyword. 
We’ll demonstrate how to add and 
search for keywords later in this chapter.

O
ne of the biggest problems we face 
as digital photographers is our 
ever-growing collections of images. 
We may have thousands of photos 

scattered across hundreds of folders on our 
computers. These folders tend to display 
images according to when they were captured, 
so we have to rely on our memory of what was 
shot when as we search for a particular photo.

All versions of Photoshop attempt to deal 
with this asset management problem 
using similar tools. The Photoshop Elements 
Organizer allows you to add star ratings and 
keywords. Lightroom’s Library module does 
a similar job. Photoshop CC and CS use a 
companion application called Bridge. If you 
access the full version of Photoshop as a 
download via the Creative Cloud service, 

you’ll need to download the Bridge 
application separately.

Bridge is a powerful image browser that 
enables you to take control over your digital 
assets before exporting them to Photoshop 
for editing. On this spread we’ll introduce you 
to the key features of Bridge, and demonstrate 
how to customise the workspace to display 
images in a more useful way. 

5 4

6

3
1

2

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Take a closer look at your pictures using the Filmstrip view

Overview Customising Adobe Bridge

1 FILMSTRIP

By clicking the Filmstrip workspace icon you display the 
selected thumbnail at a much larger size in the Preview window. 
Shift-click to select and compare multiple images, as we’re 
doing in this image.
 

2 LOUPE VIEW

The easiest way to see if an image is in focus is by looking at it 
at 100% magnification. To do so, click the image to activate the 
Loupe view. Drag the loupe to examine the image. We can see 
that the image on the right is blurred.
 

3 STACKING

To stop similar-looking images from cluttering up the 
workspace, Shift-click to select them and then choose 
Stacks>Group As Stack. Click the play icon to see each 
thumbnail contained in a stack (or drag the scroll bar).

4 EDITED IMAGES

If the colours, sharpness or tones of a raw format photo have 
already been adjusted in Photoshop, you’ll see this icon. You 
may also spot more specific icons that indicate that an image 
has been cropped, for example.
 

5 THUMBNAIL QUALITY

By default you browse a raw file’s content by displaying the 
low-resolution thumbnail that was embedded with the file 
when it was captured. For a more accurate preview of colours 
and tones, click here and choose High Quality display. This will 
demand more processing power, however.

6 SORT BY

To see your files in chronological order (with the oldest ones 
appearing on the left of the Filmstrip), set this Sort By drop-
down menu to Date Created. You can also use this option in the 
Essential workspace to display the oldest files at the top.

1

5 6

3 4

2
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1 Attach your camera
On the previous pages we pointed out how to use Bridge to browse 
images that are already stored on your computer, courtesy of the 

Folders panel. This panel acts like any browser or finder window. You 
can also use Bridge to import and store images directly from an attached 
camera or memory card into folders on your PC. Kick off by attaching 
your camera via a USB cable, and then click the Import Photos from 
Camera icon in Bridge.

2 Launch Photo Downloader
A dialog will appear, inviting you to make the Photo 
Downloader launch automatically whenever a camera or card 

reader is attached. Click Yes or No as desired. You can always change 
this option later by choosing Adobe Bridge>Preferences>General and 
then tick or clear When Camera is Connected, Launch Adobe Photo 
Downloader. Whether you click Yes or No, the Photo Downloader 
window will appear.

Import your  
photos into Bridge
Import images from your camera into Bridge, then organise 
and convert them in preparation for editing in Photoshop

B
ridge is a plugin that comes 
included with all versions of 
Photoshop. If you’re not using 
Lightroom to import, organise and 

catalogue your images, then Bridge is the 
perfect tool that fully integrates with 
Photoshop. Under the File drop-down 
menu on the main menu you can 
either open Bridge as a 
standalone window or use the 
Mini Bridge option as a 

panel within your Photoshop workspace. 
Whichever option you choose you can easily 
browse to your images and incorporate them 
into your workflow.

However, Bridge is so much more than a 
browser, you can also use it to add metadata, 

create catalogues, image stacks, apply star 
ratings and more. It also offers a host 

of other useful features too, such 
as the option to select multiple 

images and merge them.

CONVERT TO DNG

If you choose the Convert to DNG option, the 
Photo Downloader will convert third-party raw 
format files (such as Canon’s CR2 or Nikon’s 
NEF) into the Adobe Digital Negative format as 
it imports them. It will preserve the original raw 
format files and create a DNG copy in a 
separate folder. We recommend you keep the 
original raw files somewhere very safe.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR



Teach yourself Raw in Photoshop
ORGANISE WITH BRIDGE

11

3 Choose a location and label
Click the Advanced Dialog button. Clear any thumbnails that 
you don’t want to import. In the Save Options section, click 

Choose and browse to where you want to store the files, or leave it set 
to the default Pictures folder. Set the Create Subfolders drop-down 
menu to choose your preferred folder labelling format, such as Shot 
Date (ddmmyy). You can also rename the source files to include the 
Shot Date. They will then be numbered sequentially.

5 Advanced options
By default Adobe Bridge is set to open once you’ve imported 
the files. You can set the Photo Downloader to delete the 

original files on the memory card after they’ve been imported, 
so you can capture new images with the card without having to 
reformat it. You can also save copies of the imported files onto an 
external drive to create a backup of your photos. Click Choose to 
select your backup location.

4 Convert to DNG
In the Advanced Options panel you can decide to convert 
raw files to the DNG format as they are imported. This 

can be useful if you’re planning to share your raw files with other 
Photoshop users. Different camera manufacturers use different 
formats to create a raw version of an image and some of these 
can’t be opened in older versions of Photoshop. Adobe’s DNG 
format is also more compatible with third-party applications.

6 Apply metadata
If you plan to share your images electronically, it makes 
sense to attach your details and the copyright status, 

such as Creative Commons or Royalty Free, to each photo as it’s 
imported. This will save you the hassle of adding this information 
to individual files at a later date. We’ll look at ways to add more 
information to metadata on the following pages. Click Get Media 
to import the selected files. 
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A
t the end of the workflow on the previous spread we 
demonstrated how to quickly add your name and the 
copyright status to each file as it was imported to your 
computer by the Photo Downloader. This useful 

information is stored inside each file’s metadata, so when the image is 
shared online or emailed to a client they will know who it belongs to.

The Photo Downloader only enables you to add a limited amount 
of information to a batch of images, but once you’re browsing your 
imported images in Bridge you can add much more useful data to 
them, such as your contact details and website address. This helps 
people contact you if they need to use the image, or at least credit you 
as its creator. In this walkthrough we’ll demonstrate how to edit fields 
in the IPTC Core panel to assign your contact and copyright details to 
a file’s metadata.

You can add other useful details to metadata in Bridge, such as 
keywords that describe the contents of an image. This enables you to 
find a file according to its subject, instead of having to scroll through 
a chronological list of images trying to remember when you shot a 
particular picture. Keywords remain embedded in a file’s metadata, 
so they can be used by others to locate an image, which is handy if 
you want to sell your work as stock photography, for example. We’ll 
demonstrate quick ways to add keywords and then search for them 
using the filter tools in Bridge.

Add metadata 
and keywords 
Discover how to protect your photos and 
make them easier to find in the future 

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Examine the metadata
When importing images into Lightroom you can type your 
name into the Photo Downloader’s Creator field. If you’ve 

chosen this option, you can check that your name is attached to 
the file. Click the thumbnail of an image and then toggle open 
the IPTC Core section of the Metadata panel. Next to the Creator 
label you’ll see your name. If you didn’t add your name while 
importing, you can still do so by typing in the adjacent text field.

3Apply the changes
If your image contains a person or a place, then you can add 
the appropriate details in Bridge’s IPTC Extension panel. This 

panel also enables you to inform viewers of the image if there’s 
a model or property release form available, which is useful for 
purchasers of stock photography. Once you’ve finished editing the 
metadata, click anywhere outside the Metadata panel. You’ll then be 
asked if you want to apply the changes. Click Apply.

2Assign your copyright
You can also add your contact and website details to the 
file’s metadata by typing in the appropriate fields. Scroll 

down in the IPTC Core panel to find the Copyright Status pop-
up menu. Choose an option such as Copyrighted. When the 
photograph is opened in Photoshop the image tab will display a © 
symbol, indicating that the image is copyrighted. Viewers of the 
image can go to File>Info and read the info that you’ve added.

4Create a metadata template
To speed up your workflow you can use Bridge to create a 
metadata template that contains useful generic information, 

such as your contact and copyright details. To do so, go to 
Tools>Create Metadata Template. Give the template a name, such 
as ‘My contact details’. Type in the information. Any properties 
you add will automatically be checked. Click Save. You can create 
as many custom metadata templates as you like.
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5Batch process the metadata
Once you’ve created a custom metadata template you can 
apply it to multiple images. Shift-click to select a range of 

thumbnails in Bridge. Go to Tools and choose Append Metadata. 
You can then choose your custom metadata template. Your contact 
details will then be added to all the selected files in an instant. 
Click a thumbnail and check the Metadata panel’s IPTC Core 
section to see the added information.

7Create new keywords
To assign existing keywords to a selected image, tick the 
box next to a keyword category, such as People, or a 

subcategory, such as a person’s name. If a keyword isn’t available, 
click the fly-out icon at the top right of the Keywords panel and 
choose New Keyword. Type the keyword into the text field. Hit 
Enter. Drag the new keyword into a particular category. Tick the 
new keyword to assign it to the selected thumbnails.

6Add keywords
The IPTC Core panel also has a keyword field, so you can 
add a series of descriptive keywords to a particular file, 

such as macro, butterfly, leaf etc. You could also add common 
keywords, such as your name, to a metadata template. To help 
you add keywords quickly, Bridge has a Keywords panel adjacent 
to the Metadata tab. Here you’ll find a collection of useful preset 
keywords, plus any that you’ve manually added to any images.

8Filter via keywords
To find images that contain a particular keyword, go to 
the Filter panel on the left of the Essentials workspace, 

then simply click a keyword in the list to display the appropriate 
thumbnails in the Preview window. You’ll see a number next to 
each keyword that indicates the number of files that contain that 
particular keyword in their metadata. You can also type keywords 
into the Search field at the top right of Bridge’s workspace. 
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A
s we revealed on the previous pages, Bridge 
enables you to create and assign keywords to 
single images or batches of images so that you 
can find them with ease using filters. Keywords 

provide one of the most powerful and useful ways of 
helping you to locate specific photographs, although 
Bridge has other tools that will help you to organise 
your ever-growing library of images.

In pre-digital days we’d place our favourite prints into 
photo albums. These tended to gather and present images 
using particular themes, such as weddings or holidays, for 
example. In these digital days we have many more images 

to manage, so we can end up scrolling through hundreds 
of thumbnails in search of a particular image. In this 
walkthrough we’ll demonstrate how to use the old photo 
album model to collect themed images together so that they 
are easier to access, courtesy of Bridge’s Collections panel. 
You’ll also learn how to use the powerful Smart Collections 
feature to find photos according to specific metadata 
information, such as the shutter speed or camera model used 
to capture the images.

We’ll kick off by demonstrating how to quickly separate 
the wheat from the chaff by assigning labels and star ratings 
to particular pictures.

Organise your 
images in Bridge
Use Bridge’s asset management tools to help you find 
particular pictures quickly and easily using Collections

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2 Label your images
You can also assign ratings by clicking the Label menu 
at the top of the workspace. There are also colour-

coded labels that indicate the status of a file. If a picture is 
ready for print, you could apply a green Approved label. 
Images that require editing might have a purple To Do label.

1 Assign ratings
Click the Filmstrip workspace so that you can get a good 
look at each image when you click its thumbnail. If you 

like an image, you can click the star icons below a thumbnail 
to assign up to five stars. You can also assign star ratings by 
pressing Cmd/Ctrl+ a number between 1 and 5.

4 Create a Collection
To create an album-style Collection, click the 
Collections panel. Click the New Collection icon at 

the bottom. Label the Collection with an appropriate name, 
such as Landscape collection. Drag thumbnails from the 
Filmstrip into the Landscape collection’s folder.

3 Filter your photos
Once you’ve assigned ratings and labels, you can 
search using them. Go to the Filter panel and click a 

coloured label to see all the files with that label. Narrow down 
your search by clicking other criteria such as a particular 
rating. You can also use the Filter items by rating option.

6Export to Photoshop
Once you’ve finished organising files in Bridge, you can 
double click to take a specific file into Photoshop. You 

can also go to Tools>Photoshop and use shortcuts that will 
jump-start a variety of Photoshop edits, such as placing two 
images into separate layers in the same document. 

5Create a Smart Collection
Click the New Smart Collection icon. Choose a Source 
for Bridge to look in. In Criteria, choose an attribute, 

such as Rating equals five stars. Click the + icon to add other 
criteria if necessary. Click Save. The Smart Collection will 
automatically gather appropriate images together.
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The Camera 
Raw editor
Familiarise yourself with the controls in Photoshop’s 
professional-level image-processing digital darkroom

20 Raw versus JPEG: which 
is the better format?
Discover the advantages of shooting 

and editing photos using your camera’s raw format, 
compared with the JPEG format

22 Introducing the 
Camera Raw panels
Learn how to fix common photo 

problems using the tools in the powerful image-
processing panels in Camera Raw

24 Introducing the 
Camera Raw toolbar
Familiarise yourself with the wide 

range of picture-processing tools placed in the 
Camera Raw toolbar

26 Master preferences and 
workflow settings
Set up Camera Raw with your 

preferred colour space, bit depth and more to suit 
your image-processing requirements

28 A typical Camera 
Raw workflow
Discover how to open a raw file, fix its 

colour and tone problems, sharpen it for print, and 
then save the changes
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Raw versus JPEG: 
what’s the difference?
Discover the advantages of shooting and editing photos using 
your camera’s raw format, compared with the JPEG format

hen your camera captures an 
image, it saves it as a raw file or 
a JPEG. JPEG format images are 
compressed, so these files present 

a shorthand description of the colours and 
tones in the scene. If you shoot images using 
your camera’s raw format, then the photos 
will be uncompressed, meaning much more 
information about the colours and tones in 
the images are captured.

Shooting in the JPEG format is comparable 
to snapping your subject with a Polaroid 

camera. Once the image has been developed 
in-camera, you’re stuck with the finished 
print. Shooting in raw format is like using 
print or slide film. You can take your negative 
into the darkroom and recover missing tonal 
detail more easily. Indeed, Adobe’s raw DNG 
format reflects the nature of a raw file by 
calling it a digital negative.

Like traditional negatives, your DNG 
files need to be worked on before they look 
their best. This is why we refer to the Camera 
Raw workspace as the digital darkroom. 

When you capture a photo as a JPEG, the 
camera applies processing settings to the 
image, and you risk adding unwanted 
artefacts such as noise and blocky pixelated 
areas when you try to improve the image. 
By shooting in raw, you have more freedom 
to make changes while preserving the 
quality of the image. For example, you can 
change the colour balance of a raw photo 
with a click, as if you were back on location 
experimenting with your camera’s white 
balance presets. 

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Get better-looking pictures by shooting and editing in raw

Photoshop Anatomy Head to head

Different camera 
manufacturers use 
different processing 
techniques to 
produce raw 
files, and the files 
created by the latest 
cameras may not 
be compatible with 
older versions of 
Photoshop. Adobe 
introduced the DNG 
(digital negative) 
raw format [1] to 
make it possible 
for photographers 
to open raw files 
using older versions 

of Photoshop. 
Canon cameras 
save raw files with 
a CR2 suffix [2] 
(which stands for 
Canon Raw 2). 
Nikon cameras 
save raw files 
with a NEF suffix 
(Nikon Electronic 
Format) [3]. Some 
of the latest Nikon 
cameras produce 
NRW (Nikon Raw) 
files [4]. You 
can open any of 
these formats in 
Photoshop CC.

BELT AND BRACES

Like a traditional print or film 
negative, a raw file will need to be 
processed in Photoshop before 
it’s ready to be shared. This will 
take time. You can set your 
camera to create a raw and JPEG 
version of a photo at the same 
time. The JPEG will feature the 
results of the camera’s current 
scene mode. For example, the 
camera’s Landscape scene 
mode will boost the saturation 
of natural colours such as blues 
and greens. You can instantly 
upload the processed JPEG to an 
online gallery or mail it to a client. 
If you need to make changes to 
the photo, then you have a high-
quality raw file to work on at your 
leisure. You can also use the raw 
file to experiment with different 
looks and effects.

5 WHITE BALANCE

The whites in our processed JPEG look a little cold. 
The White Balance presets and Temperature slider in 
Camera Raw enable you to quickly get whites looking 
white, creating tint-free colours in the rest of the image.

6 CLARITY

The Clarity slider in Camera Raw enables you to tease 
out more fine midtone detail, such as the textures in 
the water in this photo. It also adds contrast, creating 
a much punchier image.

1 TONAL RANGE

When shooting a high-contrast scene, your camera 
will struggle to capture detail in the shadows and 
highlights at the same time. With a raw file you have a 
much better opportunity of restoring missing highlight 
or shadow details.

2 DRAB COLOUR 

After brightening a JPEG’s under-exposed areas, you’ll 
notice that they lack colour information, even after 
boosting the Vibrance. A raw file will have more hidden 
colours for you to reveal in Camera Raw.

3 ARTEFACTS

In a JPEG version of a scene, compression artefacts 
can appear as jagged blocks or noticeable bands. In 
the raw version, the same area will be displayed as a 
smoother gradient.

4 NOISE

If there’s an exposure problem with a JPEG, you’ll 
struggle to restore tonal detail without adding artefacts 
such as noise. The processed raw version of a scene 
will feature less noise.

Understanding…
RAW FORMATS 
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Introducing the 
Camera Raw panels
Learn how to fix common photo problems using the tools 
in the powerful image-processing panels in Camera Raw

Fix common photo problems using the tools in this key panel

Photoshop Anatomy The Basic panel

1 TABS

Click the icon on a tab to access its 
raw-editing tools. The Basic panel is 
selected by default because it features 
the most commonly required tools.

3 AUTO

Click here and Camera Raw will adjust 
the sliders automatically in an attempt 
to create a healthy spread of tones 
and tint-free colours.

2 WHITE BALANCE

This basic drop-down menu enables you to 
access white-balance presets that will help 
you to produce natural-looking colours in 
various lighting conditions.

4 EXPOSURE

This slider enables you to 
make global changes to the 
photograph’s exposure in 
a similar way to opening or 
closing the camera’s aperture 
on location. The value in the 
box equates to your camera’s 
exposure compensation setting.

5 HIGHLIGHTS 
AND SHADOWS

These Basic panel Highlights 
and Shadows sliders enable you 
to target and fix specific tones, 
such as over-exposed highlights, 
without altering other parts of 
the photo.

6 CLARITY, 
VIBRANCE AND 
SATURATION

This separate panel section 
is designed to help you boost 
colour saturation. Vibrance 
is designed to boost weaker 
colours without over-saturating 
stronger ones, which helps you 
to keep the colours within a 
printable range.

f you open a raw file in Bridge or 
by using File>Open in Photoshop, 
Photoshop will recognise the file’s 
raw format and automatically 

bring it into Camera Raw. This is your digital 
darkroom, with a collection of tools designed 
to help you process your photos.

In Camera Raw, you can claw back missing 
tonal detail caused by incorrect camera 

settings, thanks to the extra information 
packed into an uncompressed raw file. You 
can easily correct problems with colour, 
too. Inappropriate or ineffective camera 
white-balance settings can produce washes 
of cold blue or warm orange. You can use 
the white balance presets in the Basic panel 
to experiment with different white balance 
settings and produce natural tint-free colours 

with just a few clicks. Unlike a JPEG format 
file, your raw format file is free from the 
processing applied by the camera’s chosen 
scene mode, so you can experiment with 
different looks much more easily.

We’ll kick off by looking at the most 
commonly used image-processing tools in 
Camera Raw’s Basic panel, and then move on 
to introduce the other tabbed panels. 
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Discover other tabs that can help you to improve or creatively process your images

Overview Other key editing panels

1 TONE CURVE

This tab gives you access to even more powerful tone-tweaking 
tools that enable you to make selective tonal adjustments by 
dragging sliders or manipulating points on a curve. It also has a 
collection of Point Curve presets.

2 DETAIL

This useful tab enables you to sharpen up a soft-looking 
photo to tease out more fine detail. This is an effective way of 
producing a print with more punch. You can also reduce the 
presence of colour and luminance noise in shots captured using 
a high ISO setting.

3 HSL/GRAYSCALE

This tab enables you to target and tweak the hue, saturation 
and luminance of specific colours. It also enables you to create 
a more effective monochrome conversion by using colour 
sliders to lighten or darken particular parts of the image based 
on their original colour information.

4 SPLIT-TONING

After desaturating a photo using the HSL/Grayscale tab, you 
can add washes of colour to the shadows and highlights to 
change the mood of the monochrome conversion.

5 LENS CORRECTION

This panel enables you to use lens profiles to correct lens-
related distortions. It also features sliders to help you 
counteract distortions manually, and remove artefacts 
such as chromatic aberration.

6 EFFECTS

This panel enables you to mimic film effects by adding natural-
looking grain. You can also add or counteract vignetted corners, 
and these darkening or lightening corrections will still be 
applied evenly to the corners even after you crop the image.
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Introducing the 
Camera Raw toolbar
Familiarise yourself with the wide range of picture-processing 
tools with the icons placed on the Camera Raw toolbar

n a traditional print darkroom, 
a photographer would have access 
to a collection of tools that 
enabled him to tweak the colours 

and tones of a negative to produce a well-
exposed print. For example, by placing bits 
of card between the enlarger and the photo 
paper, a photographer could vary the amount 
of light hitting the paper and create selective 
exposures that revealed detail in lighter or 
darker parts of a scene.

Camera Raw has a toolbar that’s packed full 
of tools that do similar jobs to those tools 
offered by the traditional darkroom. The 
advantage of working with Camera Raw tools 
is the fact that the adjustments that you make 
are non-destructive. If a traditional darkroom 
photographer makes a mistake, he has to 
throw away the exposed photo paper and 
start from scratch. A Camera Raw user can 
experiment with more freedom, such as 
trying out different compositions using the 

Crop tool and then reverting the image to 
the original composition (even if he closes 
and then re-opens the processed raw file). 
A raw file’s original information can’t be 
destroyed or altered by any of the Camera 
Raw tools and panels. Camera Raw simply 
records the changes that you make using its 
tools, and then applies them to the raw file 
when you re-open it. Here we’ll introduce 
you to the key image-processing tools in 
Camera Raw. 

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Get to know the key digital darkroom tools Camera Raw offers

Photoshop Anatomy The toolbar

If you rotate the 
camera to shoot in 
portrait or landscape 
orientation, the 
image will need to 
be displayed the 
right way up. Most 
digital cameras will 
store the orientation 
of the camera in 
the metadata of a 
photo so that it will 
automatically be 
displayed correctly in 
Camera Raw. However, 
you can also click to 

rotate the photo in 
a clockwise [1] or 
counter-clockwise [2] 
direction. The Color 
Sampler [3] enables 
you to discover the 
RGB values used to 
create the colour of an 
area. If the resulting 
RGB values are equal, 
the sampled colour is 
a shade of grey. The 
Radial Filter [4] is like 
the Graduated Filter, 
but it creates a 
circular gradient.

XMP

When you process a raw format 
image such as a Canon CR2 file or 
a Nikon NEF file in Camera Raw, 
Photoshop creates a sidecar XMP 
file that stores all the Camera 
Raw tool and slider settings used 
to adjust the image. When you 
re-open the image at a later date, 
this XMP file ensures that the 
settings are as you left them. You 
can then continue fine-tuning the 
raw file at your leisure. If you share 
the raw file, but forget to include 
the XMP file, then the settings 
won’t be applied. However, if you 
save your edited raw file using 
Adobe’s cross-platform DNG 
(digital negative) file format then 
the changes made by the tools and 
panel sliders will be stored within 
the DNG.

5 ADJUSTMENT BRUSH

This tool enables you to make selective brush-
based adjustments, such as lightening (dodging) 
or darkening (burning). Unlike traditional darkroom 
dodge-and-burn tools, you can modify the results 
produced by these digital versions.

6 GRADUATED FILTER

This tool acts like a graduated neutral density filter on 
a camera’s lens, enabling you to darken bright skies 
without blowing out a correctly exposed landscape. 
Alternatively, you could use it to brighten an under-
exposed landscape without over-exposing the sky.

1 WHITE BALANCE

This tool enables you to fix a white-balance problem 
by sampling something that should be white. If the 
sampled pixels are too warm, the tool will cool down 
the colours to make whites look white. This will remove 
colour casts from the rest of the photograph.

2 TARGETED ADJUSTMENT

This powerful tool enables you to adjust the tones of a 
particular area of the image. Click the image and drag 
upwards to lighten the tones, or downwards to darken 
them. You can set the tool to selectively adjust colour 
saturation too.

3 CROP TOOL

This enables you to improve composition by 
removing some of the edges of the frame. The tool 
is non-destructive, so you can restore missing edge 
details at any time. Hold down the mouse button 
on the Crop tool icon to modify the way it behaves. 
The neighbouring Straighten tool enables you to 
counteract tilted horizons.

4 SPOT REMOVAL

This tool enables you to hide unwanted image 
elements such as sensor spots in skies or spots on 
the subject’s face in a portrait. It’s the Camera Raw 
version of the main editor’s Clone Stamp and 
Healing Brush tools.

Understanding…
OTHER RAW 
TOOLS
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Master workflow 
and preferences
Set up Camera Raw with your preferred colour space, bit 
depth and more to suit your image-processing requirements

Set up workflow presets to meet various image-editing challenges

Photoshop Anatomy Workflow options

1 WORKFLOW

Click here to open the Workflow 
Options window. The edited workflow 
settings will replace the Camera Raw 
default values.

3 COLOR SPACE

Click here to choose a colour space. If 
you’re editing for print, choose Adobe 
RGB (1998). If you’re editing your 
work for digital display, chose sRGB.

2 PRESET

Click here and choose New Workflow 
Preset. A New Workflow Preset window 
will appear. Type in a suitable workflow 
name such as Print or Web. Click OK.

4 DEPTH

To access more information in your 
raw files, consider increasing the Bit 
Depth to 16/Bits Per Channel, although 
this will reduce the number of menu 
commands you can apply in the main 
Photoshop editor.

5 RESIZE

If you’re editing a series of photos that 
are destined for print, set Camera Raw 
to automatically resize them to typical 
print-friendly dimensions. You can also 
choose a high resolution to pack the 
print with detail.

6 SHARPEN

A little sharpening will give printed 
pictures more impact. Choose a suitable 
paper type and sharpening amount 
from the drop-down menu in this 
section of the Workflow Options window.

7 SMART OBJECTS

Once you open a raw file in Photoshop, 
it behaves like an ordinary JPEG. By 
ticking this box, you can edit the photo 
in Photoshop and then re-open it in 
camera Raw to fine-tune. To override 
this preference for specific images, 
press Shift when you click Open Image.

efore processing your photos in 
Camera Raw, it’s worth taking 
a little time to set up the 
preferences and tailor its workflow 

options to suit your specific image-editing 
needs. This enables you to speed up the way 
you work, and produce more effective results.

For example, if you plan to print your 
pictures, you’ll benefit from setting up a 

Camera Raw colour space that produces 
printer-friendly colours. Your PC displays 
millions of colours by mixing the red, green 
and blue channels together. Printers, on 
the other hand, create a narrower range of 
colours by mixing cyan, magenta, yellow and 
black. Set up Camera Raw to use a printer-
compatible colour space, such as Adobe RGB 
(1998), and the prints of your carefully edited 

images will look more similar to the on-
screen versions.

You can also modify the Camera Raw 
preferences to speed up your workflow. This 
enables you to adjust the default settings so 
that Camera Raw will automatically apply 
tonal adjustments when you open an image, 
for example. We’ll kick off by setting up 
print-friendly and web-based workflows. 
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Customise the way Camera Raw behaves to suit your way of working

Overview Choose your preferences

1 PREFERENCES

To access the Camera Raw Preferences window, click here in 
the toolbar. Alternatively, you can summon the Camera Raw 
Preferences window while working in Photoshop by going to 
Preferences>Camera Raw.

2 SIDECAR

Any Camera Raw slider or tool-related changes you make are 
recorded in an XMP file that’s stored in the same folder as the 
raw file. If you move the raw file, you need to move the XMP file 
too, to preserve the changes to the image.

3 DATABASE

You can store a record of any adjustments made to a raw file in 
a database on your Mac or PC. This database is indexed by file 
content, so the image will retain Camera Raw adjustments even 
if the raw file is moved or renamed.

4 AUTO TONE

Tick this box to have Camera Raw analyse the exposure of 
the image and automatically adjust the sliders in the Basic 
panel to try to create a healthier spread of shadows, midtones 
and highlights.

5 DEFAULTS

You can customise the Noise Reduction settings to apply 
different amounts of default smoothing to photos captured with 
fast or slow ISO speeds.

6 CACHE

The cache stores information about changes made in Camera 
Raw, which helps speed up the opening of images in Camera 
Raw. It also rebuilds previews in Bridge when an image is 
adjusted in Camera Raw.
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1 Open the image
If you’re using Bridge, right click the supplied starting image and 
choose Open in Camera raw from the context-sensitive pop-up 

menu. Alternatively, if you’re in Photoshop choose File>Open. Browse to 
the starting image and click Open. The file is a DNG (digital negative), 
so it will automatically open in Camera Raw. The shot looks under-
exposed, the contrast is flat, the colours are drab and the water looks 
warm and muddy.

2 Boost the exposure
To understand the exposure problem more clearly, take a look 
at the Histogram panel. In this instance, the graph is clumped 

towards the shadows on the left, with no strong highlight information 
on the right. This is a typical histogram shape for an under-exposed 
photo. By dragging the Exposure slider right, the graph’s under-
exposed tones slide towards the highlights, creating brighter highlights 
in the image. A value of +1.5 does the trick in this instance.

The Camera  
Raw workflow
Discover how to open a raw file, fix its colour and tone problems, 
sharpen it for print, and then save the changes you’ve made

ll the information about the 
colours and tones in a scene are 
contained in the raw file, but 
you’ll need to do some work to 

display tones that are missing in darker or 
brighter areas. You may also find that 
colours suffer from a warm or cool tint due to 
incorrect white-balance settings used by the 
camera at the time of capture.

In this tutorial we’ll show you a typical 
photo-fixing workflow that will demonstrate 

the ways you can use to analyse a raw file 
for typical exposure and colour problems, 
and then correct them using the sliders in 
the Basic panel. Once your processed photo 
looks more like the scene did on location, 
you can build on this 
basic workflow by 
applying more 
complex tools 
and effects to 
the image. 

SAVING OPTIONS

Once you’ve improved your photo, you have 
a variety of choices. Click Done to record the 
slider changes and store them with the raw 
file, so you can fine-tune them at a later date. 
To continue editing the image in Photoshop, 
choose Open Image. To save a JPEG version to 
share online, click Save Image. Set the Format 
drop-down menu to JPEG and click Save.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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3 Lighten the shadows
Our photo now has a wider spread of tones, but the shadows 
lack detail. You can selectively target tones like these by 

dragging the Shadows slider right to +81. If a photo’s highlights were 
too bright, then you’d drag the Highlights slider left to claw back 
missing detail. Camera Raw enables you to make effective selective 
tonal adjustments and create a stronger contrast. Drag Contrast to +17 
for slightly blacker shadows and whiter highlights.

5 Increase Clarity
When you reveal tones in under-exposed scenes, the 
colours can look drab. Pop down to the last section in the 

Basic panel and drag Vibrance right to +46. This boosts blues and 
greens in nature shots (while avoiding over-saturating warmer skin 
tones in portraits). In the same section you’ll find the Clarity slider. 
Use this to boost midtone contrast and tease out fine details and 
textures. A value of +28 will do the trick in this example.

4 Improve the colour
If the colours look too warm or cold you can experiment 
with different white-balance presets to produce 

whiter whites. This will create more natural-looking tint-free 
colours in the rest of the image. For this image, manually drag 
Temperature left to 4600K to cool down the warm colour and 
create neutral, less muddy-looking whites. Press Q to cycle the 
Before and After views.

6 Sharpen the image
Camera Raw applies a little post-production sharpening to 
your image. If you plan to print your photo, you can give 

the hard copy extra impact by sharpening it a little more. Select the 
Zoom tool and right click to see the image at 100%. This enables 
you to see how sharp it is. Go to the Detail tab and increase the 
Amount slider in the Sharpening section to around 44. You’re now 
ready to save your processed picture. 
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Camera Raw 
basic editing
Learn how to open and process multiple raw files 
and perform basic image-editing transformations

32 Introducing the magnifier 
and grab tools
Work more effectively on particular

parts of a raw file with help from the Camera Raw 
image navigation tools

34 Use the Histogram 
to assess exposure
Discover how to use the Histogram 

window to analyse the spread of tones in a raw 
image, and then fix any exposure problems

36 Batch process 
your raw files
Save time and effort by opening

and processing multiple photos taken at the same 
time in the same lighting

38 Improve colour 
and tone locally
Target and tweak the hue, saturation 

and brightness of specific regions of a photo using 
the Targeted Adjustment tool

42 Resize and save your 
processed raw files
Discover how to save your edited 

photos in different image formats at different sizes 
to suit your file-sharing needs
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The magnifier 
& grab tools
Work more effectively on particular parts of a raw file 
with help from the Camera Raw image-navigation tools

o successfully improve your raw 
files, you’ll need to get to grips 
with the Camera Raw navigation 
tools. For example, if you look at a 

raw file on your camera’s LCD display, it may 
look nice and sharp. However, the file may 
be actually soft due to the camera’s inability 
to find a focal point, or because of a shallow 
depth of field caused by a wide aperture set-
ting. You can only discover how soft or sharp 
a photo really is by opening it in Camera Raw 

and then magnifying the image to see its 
actual pixels.

As with the Photoshop workspace, Camera 
Raw has a toolbar that contains a Zoom tool. 
This navigation tool enables you to magnify 
the image in a series of increments so that 
you can take a closer look at soft-focus  
areas, or tackle retouching challenges more 
easily such as cloning out a small but 
unsightly sensor spot. There are a range of 
techniques that enable you to jump to a 

closer look of a particular section of a 
raw file, and we’ll cover all of these in our 
annotated image on the next page. You can 
then experiment and decide which zooming 
method you prefer.

Once you’ve zoomed in for a closer look, 
you’ll need to pan around the magnified image 
to discover more problematic areas to fix. The 
Zoom tool works in tandem with the Hand 
tool, so you can scrutinise and edit the pixels 
of your picture quickly and effectively. 

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Take a closer look at any part of a picture

Photoshop Anatomy Navigation tools

The maximum 
magnification that 
you can achieve 
using the Camera 
Raw Zoom Level 
options or the Zoom 
tool is 400% [1]. 
At this extreme 
magnification, you 
can see the blocks 
of colour and tone 
[2] that create 
the image. Each 
photo is made up 
of millions of these 
pixels (hence the 

term, megapixel). 
Although each pixel 
is square, they are 
small enough to 
create smoothly 
curved shapes when 
viewed at a lower 
magnification such 
as 100% or Fit in 
View [4]. When 
editing an image in 
Photoshop, you can 
zoom into a massive 
3200%, which gives 
you a much closer 
look at the pixels.

KEYBOARD 
SHORTCUTS

When working with 
any tool in Camera 
Raw, you can zoom 
in by simultaneously 
pressing Cmd/Ctrl 
and the + key, or 
zoom out by pressing 
Cmd/Ctrl and the 
– key. To quickly 
zoom into 100% 
magnification, double 
click the Zoom tool 
icon in the Camera 
raw toolbar. In 
Photoshop’s General 
Preferences menu, 
you can tick a box that 
enables you to zoom 
in using your mouse’s 
scroll wheel, but this 
option doesn’t work in 
Camera Raw.

5 CONTEXT-SENSITIVE MENU

Right clicking with the Zoom or Hand tools summons 
the Zoom Level window wherever the cursor happens 
to be, which saves your cursor a trip down to the 
bottom left corner of the workspace.

6 SPECIFIC ZOOM

The Zoom Level commands enable you to magnify the 
image in specific incremental jumps. To zoom into a 
specific object or area of the image, drag a rectangle 
with the Zoom tool.

1 ZOOM TOOL

If you need to take a closer look at an area, click this 
icon in the Camera Raw toolbar to activate the Zoom 
tool. Alternatively, press Z to summon it with the 
keyboard shortcut.

2 HAND TOOL

Once you’ve magnified the image using the Zoom tool, 
click this icon to summon the Hand tool (or press H). 
You can temporarily summon the Hand tool when 
using any other tool by holding down the space bar. 
Let go of the space bar to jump back to the previously 
active tool.

3 DRAG

When the Hand tool is active, this icon will appear over 
the cursor. Drag the mouse to pan the magnified image 
in any direction.

4 ZOOM LEVEL

Click the plus or minus icons to zoom in or out in 
increments, type a specific percentage value into 
the field, or click the pop-up menu and choose a 
magnification percentage.

Understanding…
MAGNIFIED  
PIXELS
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Use the Histogram 
to assess exposure
Discover how to use the Histogram window to analyse the spread 
of tones in a raw image, and then fix any exposure problems

Discover the exposure problems in any image

Photoshop Anatomy The Histogram 

1 OPEN IMAGE

Choose File>Open, browse to our 
PMZ61_histogram starting image. 
It will open in Camera Raw. It looks 
under-exposed to the naked eye.

3 SHADOWS

The shot has plenty of midtone and 
shadow information. The strength of 
the darkest shadows are represented 
at the far left.

2 SHADOW CLIPPING

Click the Shadow Clipping warning 
to reveal clipped (under-exposed) 
shadows as patches of blue.

4 GRAPH

The undulating graph shows the 
strength and spread of the shadows, 
midtones and highlights in the image.

5 HIGHLIGHTS

The brightest highlights peter out in 
the middle of the histogram. In a well-
exposed photo, they’d stretch to the 
far right.

6 HIGHLIGHT CLIPPING

Click the Highlight Clipping warning to 
reveal clipped (over-exposed) highlights 
as patches of red.

ne of the main challenges we face 
when taking a photograph is to 
meter the scene to capture detail 
in the shadows, midtones and 

highlights. After capturing an image, you may 
discover that it’s under- or over-exposed. 
Some cameras enable you to summon a 
Histogram graph in the camera’s Live View 
display when setting up the shot. This graph 

demonstrates the spread of tones in the 
scene. A correctly set camera should display 
a histogram graph that spreads from the far 
left (where the darkest shadows are) to the far 
right (where the brightest highlights are).

Despite your best efforts, you may capture 
an image that has exposure problems, such 
as our under-exposed starting image. Camera 
Raw’s Histogram window enables you to 

analyse the spread of tones in a picture so 
that you can see precisely where the exposure 
problems are. You can then use the Histogram 
window to help you create a wider spread of 
tones that reveals missing detail and creates 
more contrast. In our first annotation, we’ll 
look at how to analyse our under-exposed 
photo’s histogram, before moving on to fix it 
in the second annotated image. 
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Adjust the spread of tones in the histogram graph

Overview Create a correct exposure

1 REGIONS

Place the cursor on part of the graph, and you can see which 
tonal region is being represented as a lighter grey bar.

2 EXPOSURE

In this example, we’ve placed the cursor on the part of the 
histogram graph that represents the tones controlled by the 
Exposure slider.

3 DRAG

By dragging right inside a specific region (such as Exposure) 
you can slide the graph right toward the highlights. This also 
increases the value of the Exposure slider.

4 REMAP

By boosting the Exposure and Highlights you remap the under-
exposed midtones and highlights and give them brighter values. 
The graph now stretches further to the right, indicating a wider 
spread of tones.

5 WHITES

You can target and tweak a narrow range of tones by using 
sliders such as Whites. This slider brightens the lightest 
pixels without interfering with tones in the rest of the image. 
A correctly exposed photo should have some black shadows 
and white highlights for a strong contrast.

6 BEFORE AND AFTER

Click here to toggle through the various before-and-after views 
so you can compare your adjusted image with the original.

1

5

6

3
4

2



Teach yourself Raw in Photoshop
CAMERA RAW BASIC EDITING

36

2Tweak the colour and tone 
Click PMZ11_batch DNG. Click Select All to include 
the other images. Drag Exposure up to +0.70 to 

brighten up the under-exposed image. Pull Highlights left to 
-20 to avoid blowing out detail on the brighter petals. Cool 
the Temperature to 4100 and drag Tint to +20.

1Open the images
In Bridge, Shift click to select our batch of three start 
images - PMZ11_batch DNG, PMZ12_batch DNG and 

PMZ13_batch DNG. Alternatively, in Photoshop choose 
File>Open and Shift click to select the three files. Click Open. 
The open files’ thumbnails will be visible in Camera Raw.

hen shooting a series of shots in the same lighting 
conditions (and using identical camera settings), 
you may end up with a collection of images that 
have similar problems with colour and tone (such 

as our under-exposed starting images). You could open each 
image in turn and manually tweak its colours and tones, but 
this would be rather time-consuming.

Because our collection of images have similar problems 
we can use the Basic Camera Raw sliders to apply the same 
tonal and colour adjustments to every shot in the series 
and they’ll look consistently better. Adobe understand 
that most photographers would prefer to spend more time 
taking photographs and less time editing them, which is why 
Camera Raw enables you to batch process multiple photos at 
the same time.

As you’ll see from our walkthrough, Camera Raw 
enables you to make manual adjustments to a photo that is 
representative of the problems in a batch of similar images, 
and it will simultaneously apply the adjustments to all of the 
open files. If necessary you can then look through the batch-
processed files and fine-tune the adjustments to suit their 
individual needs.

Batch process 
your images
Save time and effort by opening and processing multiple 
photos taken at the same time in the same lighting

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Fine-tune individual images 
The changes will be applied to all the files. Click the 
other thumbnails to see if they need fine-tuning. 

The other two images are slightly brighter, so tweak their 
Exposure to -65. Drop Highlights to -70. Click the Before 
and After icon to see how the edited images compare. 

3Reduce Vibrance
Boost Clarity to +16 to increase contrast and reveal 
fine details. For more natural-looking colours, drag 

Vibrance down to -15. Vibrance selectively reduces the 
saturation of the stronger colours without desaturating the 
weaker ones. This helps to keep the colours printable.

BEFORE

BEFORE



Teach yourself Raw in Photoshop
CAMERA RAW BASIC EDITING

38

4Adjust the Hue  
If you set the Targeted Adjustment tool to Hue, then 
you can drag on a particular colour and quickly change 

the hue of all similar colours. Here we dragged down on the 
red top to change the hue of the Reds in the HSL panel to 
pink. This turned the red lipstick pink too.

3Adjust the colour
Click and hold the Targeted Adjustment tool icon and 
choose Saturation. Click to sample a colour. Drag up-

wards to make that colour more saturated. Drag down to make 
it less saturated. This automatically changes the appropriate 
colour sliders in the HSL panel’s Saturation tab.

2Darken the shadows
Click to sample a shadow and drag down to make 
all the blacks in the image look blacker. These curve 

tweaks give the image a stronger contrast. Notice that the 
appropriate Highlights and Shadows sliders in the Parametric 
Curve panel have been adjusted automatically.

1 Brighten the highlights
Open PMZ61_targeted DNG. Click the Targeted 
Adjustment tool in the Tools panel. To see how the tool 

tweaks the photo’s curves, click the Tone Curve panel and 
choose the Parametric Curve tab. Click to sample the eye 
whites and drag upwards to brighten the highlights. 

amera Raw is packed full of tools and sliders 
that enable you to selectively target and adjust 
properties such as colour or tone. However, it can 
be quite daunting to decide which tool to pick or 

slider to adjust. The beauty of the Targeted Adjustment tool 
is that you can click a particular area to sample it, and then 
drag to adjust a range of properties.

The Targeted Adjustment tool will tinker with the 
Parametric Curve, which you’ll find in the Tone Curve 

panel. This panel provides you with a powerful way to 
adjust specific tones, but you can get carried away and end 
up blowing out highlights or clipping shadows if you’re 
unfamiliar with curves. The Targeted Adjustment tool 
enables you to tweak curves without using the sliders in the 
Parametric Tone Curve panel, so it’s more intuitive to use.

We’ll show you how to tweak colour hue, saturation and 
general tones simply by clicking them and dragging the 
cursor up or down.

Improve colour 
& tone locally
Alter the hue, saturation and brightness of specific 
regions of a photo using the Targeted Adjustment tool

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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After using the Targeted Adjustment tool to perform common 
photo fixes such as increasing contrast and boosting colour 
saturation, you can use it to experiment with more creative 
looks. Here we set the Targeted Adjustment tool to alter 
Hue and turned the sampled blues a more cross-processed 
cyan [1]. We also altered the Hue of the Reds to turn them 
orange. Here’s an alternative cross-processed look with 
greener graffiti, created by sampling and changing the Hue 

of the Blues and Purples [2]. You can also set the Targeted 
Adjustment tool to Grayscale Mix. This enables you to drag 
down on a sampled colour to create darker tones in a 
monochrome conversion, or up to lighten the tones. Here 
we’ve created luminous white skin to make the model stand 
out more in contrast with the darker background [3]. Here 
we’ve sampled and darkened the Reds of her dress and lips 
for a gothic look [4]. 

1

3

2

4
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4Choose a size
Use Image Sizing to create a version of your raw file 
with specific dimensions (such as a 4x7-inch print). 

For a high-quality print, keep resolution at 300. For the web, 
you can drop the resolution to 72. Sharpen the file for screen 
or print. Click Save to create a resized JPEG version. 

3Set the quality
The Format drop-down menu will change to the file 
format you’ve chosen. To create a smaller JPEG you 

could drop the Quality setting, though obviously, this creates 
a lower quality image. If you plan to share the photo onscreen 
set Color Space to sRGB. Use Adobe RGB for print.

2Choose a format
To save the image in a web-friendly format, click the 
Save Image button at the bottom left. The Save Image 

window will appear. In Destination, click Select Folder and 
choose a folder to store your saved photo in. Click Select. 
Label the photo and choose a format such as JPG.

1Process the picture
Open PMZ31_save DNG. Our raw file is too warm, so 
drag Temperature to 450 for more natural skin tones. 

The highlights are too bright, so drop Contrast to -23 and 
Highlights to -43. Drag Blacks to -53 for more contrast. Set 
Clarity to -11 for softer skin and boost Vibrance to +33.

fter processing a raw file, you have a choice of 
several image-saving options. By default, when 
you make changes to a raw file and click Done 
to close the image, Camera Raw will create an 

XMP file that’s stored in the same folder as your original 
raw file. This sidecar file describes the position and value of 
any sliders that were tweaked in Camera Raw, as well as any 
modifications that you’ve made using tools to crop, clone or 
selectively tone the raw image. When you re-open the raw 

file in the future, Camera raw will read the XMP file and then 
automatically reapply all the image adjustments and slider 
settings that you made earlier.

You may want to click Open Image to continue editing 
the raw file using tools and filters that aren’t available in 
Camera Raw. Alternatively, you might want to create a 
compressed version of the processed picture that’s suitable 
for posting online. Here’s how to save your raw file in a 
variety of formats.

Resize and save 
your raw files
Discover how to save your edited photos in different image 
formats at different sizes to suit your file-sharing needs

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Fix photo 
problems
Quickly improve composition, tones, and colour, 
and remove unwanted elements from your photos

46 Improve image 
composition
Straighten tilted horizons and crop 

your photos to give your subjects more impact 
using Camera Raw’s composition tools

50 Improve the tonal quality 
of your photos
Discover how to brighten under-

exposed images and add punch with additional 
contrast using the Basic panel

52 Improve image colours 
with the Basic panel
Use the colour-enhancing tools in the 

Basic panel to create strong and natural-looking 
colours in your photos

54 Remove unwanted 
spots and marks
Discover how to identify and remove 

unsightly spots, blemishes and other unwanted 
artefacts in your photos

56 Remove large 
distractions
Remove large unwanted elements from 

your images by combining the healing with cloning 
functions in Camera Raw
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Annotation/headers

Teach yourself Raw in Photoshop
FIX PHOTO PROBLEMS

46

W
hen capturing photos on location you may not 
have time to consider the optimum composition 
for your subject, especially when shooting a busy 
event such as a wedding. If you’re shooting 

handheld then you might add a slight tilt to the image’s 
horizon. Thanks to the large size and resolution of your 
camera’s raw files you can use the Camera Raw Crop tool to 
re-compose a photo’s subject at your leisure and change the 
way that they are perceived in the frame. By removing some 
of the image’s edges you can zoom in for a closer look at a 
subject and make them more prominent in the frame. If you 
forget to shoot both a portrait and landscape oriented photo 

on location you can use the Crop tool to change the shot’s 
aspect ratio and discover which shape best suits your subject.

As you’ll see from our walkthrough, the Crop tool enables 
you to fix problems such as a tilted horizon. Alternatively, 
you can crop to experiment with more creative composition 
angles, as if you’d deliberately tilted the camera on location. 
We’ll show you how to crop using a range of presets and 
create custom aspect ratios. You’ll so learn how to crop to 
create common print sizes so you can produce hard copy 
pictures to fit in a frame or album. We’ll also demonstrate 
how to darken the edges of the cropped frame to help draw 
the eye to the main subject and create a natural border.

Improve image 
composition
Straighten tilted horizons and crop your photos to give your 
subjects more impact using Camera Raw’s composition tools

BEFORE

STRAIGHTEN

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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TILT PORTRAIT

SQUARE



Backgrounds of boxes
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1Straighten the horizon
Go to File>Open and select PMZ3_compose. Click Open. The 
digital negative format raw file will open in Camera Raw. If 

you’re using Bridge, click our starting image’s thumbnail and choose 
File>Open in Camera Raw. The horizon is tilting down to the right. 
To fix a wonky horizon, click to select the Straighten tool from the 
Camera Raw toolbar. Drag the tool to draw a line that follows the tilt 
of the horizon.

3Save the straightened image
The image will still look tilted. To see the results of the 
Crop tool, you need to click to choose any other tool in the 

toolbar (such as the Hand tool). The image will then be cropped and 
straightened. You can now click Save and produce a JPEG version of 
your corrected image. As editing in Camera Raw is a non-destructive 
process, you can click back on the Crop tool at any time and you’ll see 
the original cropped edges.

2Crop the shot
The Straighten tool will automatically rotate the shot to 
counteract the angle of the tilt. The Crop tool will become active 

and a crop overlay window will appear. The Crop tool needs to crop the 
rotated image to avoid adding transparent edges to it. The edges of the 
image that will be removed by the Crop tool appear as partially greyed 
out. You could drag the crop overlay’s corner handles to fine-tune the 
tightness of the crop.

4Rotate the overlay
Click back on the Crop tool to summon the crop overlay that 
you created with the Straighten tool. Place the cursor outside 

the crop overlay to activate a rotate icon. Drag to rotate the crop 
overlay clockwise until it creates a portrait-oriented shape. As you 
rotate the crop overlay, a mesh will appear. Use the mesh to align 
the rotated overlay with the tilted horizon. This will ensure that the 
portrait-shaped image has a straight horizon.

48
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5Use the rule of thirds
Drag inside the crop overlay to recompose the image so that 
the train of the bride’s dress is in shot. The crop overlay’s Rule 

of Thirds grid enables you to make sure that the bride is in the centre 
of the frame. Hold Shift to constrain the overlay’s shape and drag a 
corner handle to tighten the composition. Drag inside the overlay to 
place the sand in the Rule of Thirds grid’s bottom row. Click another 
tool to view the new cropped composition. 

7Choose a new ratio
Go to the toolbar and hold down the mouse button on the 
Crop tool’s icon. In the pop-up menu, choose a new aspect 

ratio such as 1:1. Drag the square crop overlay’s corner handles to 
resize the image. Drag inside the overlay to recompose the subject. 
The Post Crop Vignette will automatically be re-applied to the 
edges of your photograph’s new shape, so you don’t need to spend 
time fine-tuning it.

6Add a vignette
Click the Effects panel. In the Post Crop Vignette section, set 
the Style drop-down menu to Color Priority. This allows the 

vignette to gently darken the shot's original edge colours rather than 
just adding grey to them. Set Amount to -27 to add a natural-looking 
vignette to the edges of the cropped image. Increase Midpoint to 63 
to push the vignette effect out towards the edges while preserving the 
vignetted corners. Save your portrait-oriented version of the scene.

8Experiment with angles
After saving a square version of your cropped shot, experiment 
by clicking the Crop tool’s icon and dragging the crop overlay’s 

corner handles to zoom in for a tighter composition. Drag outside the 
overlay to deliberately rotate the shot to produce a tilt that adds energy 
and drama to the original image’s formal composition. Once you’ve 
saved a range of new compositions, you can always choose Clear Crop 
from the Crop tool’s drop-down menu. 
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4Tweak the contrast
For a healthy contrast we need some white whites 
and black blacks. We could drag the Contrast slider 

to darken shadows and lighten highlights equally. For more 
control drag Whites to +17. Darken the Blacks slider to -10. 
This allows a touch of blue shadow clipping patches to appear 
in unimportant areas. 

3Reveal shadow detail
In this example the clipped highlights only appear in 
the specular reflections in her eyes and earring, so 

we’re not losing any important highlight detail. It’s good to 
have some bright highlights in an image if it gives a healthy 
contrast. To reveal detail hidden in the photo’s shadows, 
boost the Shadows slider to +55.

2Discover clipped highlights
When boosting highlights you risk clipping (over-
exposing) them and losing detail. Clipped highlights 

appear as a peak at the right of the graph. To reveal them in 
the image, click the Highlight clipping warning icon at the 
right of the Histogram, or press O for over-exposed. Clipped 
highlights will appear as patches of red.

1Boost highlight strength 
Open PMZ09_tones in Camera Raw. The histogram 
graph needs to stretch from the far left to the far right if 

we’re to have a correctly exposed shot. As the highlights are 
weak, drag the Highlights slider right to 100. This causes the 
graph’s weak highlights to slide right too, indicating that they 
have been made stronger.

A
shot that looks correctly exposed on your camera’s 
illuminated display may look a little dull and 
suffer from a lack of contrast when printed out as 
a hard copy. Our starting image looks fairly 

well-exposed to the naked eye, but if we look at the Camera 
Raw Histogram we can see that the undulating graph doesn’t 
quite stretch to the far right. This indicates that while the 
shot has plenty of shadow and midtone information, it lacks 
strong highlights. It’s a simple matter to tweak a few sliders 

in the Camera Raw Basic panel to selectively boost the 
strength of the weak highlights. We’ll also show you how to 
reveal some extra detail in our subject’s darkest shadows, 
while creating an image that enjoys a strong contrast with 
some black shadows and white highlights. This increase in 
contrast will help the image look less flat and give it more 
impact. As the Basic panel’s tone-tweaking sliders enable you 
to target and adjust specific tonal ranges, you can use them to 
fix common exposure problems quickly and effectively.

Improve tones
Discover how to brighten under-exposed images and add 
punch with additional contrast using the Basic panel

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2Warm up the colours
Go to the White Balance drop-down menu. Here you’ll 
find a series of settings that are similar to those you 

can select in camera. Experiment to see which produces the 
most tint-free colours. In this instance Auto does a good job 
of removing the cold blue colour cast.

1Open the image
Open PMZ76_colour in Camera Raw. Our unprocessed 
starting image’s colours look very drab, so we need to 

reveal the extra colour information hidden in the raw file. The 
colours look a little cold too, so we’ll need to warm them up 
slightly to remove the slightly blue colour cast.

I
f you capture your photos in JPEG format then 
the colour settings that you choose in your 
camera’s menu will be applied to the image 
as it's saved onto the memory card. This 

means that it will be harder for you to change a photo’s 
pre-processed colours in Photoshop. By using in-camera 
colour settings such as Vivid or Natural you’ll produce a 
range of dramatically different looking colours. If you use 
an inappropriate white-balance setting when shooting 
JPEGS then your photos may suffer from colour casts too. 
These warm or blue tints in a compressed JPEG will also 
be more challenging to correct in Photoshop compared 
to working with a raw file.

By photographing in raw you have more colour 
information to work with. The colour boosting and 
correcting tools in the Camera Raw Basic panel can be 
used to produce a range of different looks, from a vivid 
colour palette to a more natural, less saturated look. 
This gives you more freedom and quality than you’d 
get by applying an in-camera colour preset to a JPEG 
version of the image. Here’s a quick colour-enhancing 
walkthrough you can apply to your photos.

Improve 
image colour
Use the colour-enhancing tools in the Basic panel to 
create strong and natural-looking colours in your photos

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Boost the saturation
Drag Vibrance up to +19. This selectively boosts the 
saturation of weaker colours without over-saturating 

stronger ones. This makes the colours look more evenly 
saturated. Give the colours a global boost by pushing 
Saturation up to +36. A Clarity of +15 reveals more texture. 

3Correct the exposure
From the histogram we can see that the image is 
under-exposed. It’s always worth fixing exposure 

problems before adjusting colour saturation, because this 
can reveal more colour problems. Drag Exposure up to +0.50. 
Increase Highlights to +32 and Whites to +36.
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W
hen shooting subjects that feature a large 
clear expanse of bright colour or tone, such 
as a sky or a studio backdrop, then you may 
notice small grey blobs in these sections of 

the image. Unsightly sensor spots are caused when 
specks of dust enter the camera body (when changing 
lenses, for example) and come to rest on the sensor. 
Your SLR may enable you to vibrate the sensor in an 
attempt to clean it, but this may not be enough to shake 
the more tenacious spots. You could attempt to clean 
the sensor by removing the lens, opening the shutter 
and blasting the sensor with a gust of air from a blower 
brush. However, this physical fix won’t remove sensor 
spots from older photos in your collection.

If shooting a portrait, then your subject may suffer 
from spots and pimples on the skin. Although these 
types of spots aren’t a camera-induced artefact, you 
may still want to flatter the subject by creating 
a spot-free complexion.

Camera Raw has a spot-removal tool that can 
eradicate skin or sensor spots quickly and effectively. 
It works by sampling clean pixels and placing them over 
an adjacent spot. We’ll show you how to modify the 
tool to reveal the location of spots more effectively, so 
that you can remove them with a few clicks.

Remove unwanted 
spots and marks
Discover how to identify and remove unsightly spots, 
blemishes and other unwanted artefacts in your photos

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2   Adjust the tolerance
To reveal more subtly contrasting spots lurking in 
smooth patches of skin, drag the Visualize Spots slider 

right. This makes it more sensitive. The trick here is to get a 
balance between revealing spots in patches of white, without 
including other details such as skin pores.

1 Find the spots
Open PMZ83_spot. Click the Spot Removal tool in 
the toolbar (or press B to summon it). To discover the 

location of the most unsightly spots, tick the Visualize Spots 
box in the Spot Removal panel. By default only the most 
contrasting edges will be visible in white.

4 Reposition the overlays
Untick Visualize Spots to see the image. As you click 
a spot, a red overlay surrounds it. The attached green 

overlay automatically samples a clear patch of skin to place it 
over the unwanted spot. Reposition a green overlay to find a 
cleaner patch of skin.

3 Set up the tip
Increase the Size slider so that the Spot Removal 
tool’s tip is large enough to cover the average spot. 

Set the Type drop-down menu to Heal. This will cause 
sampled and relocated skin to be seamlessly blended with its 
new surroundings. Click a white spot to turn it black.

6Remove lines
The latest version of Camera Raw enables you to draw 
irregular shapes with the Spot Removal tool, so that 

you can select and remove lines and wrinkles in a single 
stroke. These longer strokes are represented by pins. Click a 
pin to activate and edit the attached overlay. 

5 Fine-tune the size
Drag the edge of an overlay to resize it. To restore 
a missing birth mark or freckle that’s a permanent 

part of the subject’s character, click an overlay and hit the 
Backspace key to delete it. To get a clearer look at the subject, 
tick the Show Overlay box.



Teach yourself Raw in Photoshop
FIX PHOTO PROBLEMS

56

A
s its name suggests, the Spot Removal tool was primarily 
designed to help you remove tiny spots and blemishes from 
your images. You could use it to replace sensor spots with 
clear patches of sky or hide an unsightly pimple with a 

couple of clicks. Before the release of Photoshop CC 2014, the Spot 
Removal tool was generally limited to this type of subtle cosmetic 
photo fixing. If you needed to remove a more complex object (such as a 
lamppost sticking out from behind a subject’s head) then you needed to 
open the image in Photoshop to access its more versatile brush-based 
Clone Stamp tool. This meant that you lost the quality benefit of 
editing in Camera Raw.

With the advent of Camera Raw 8.4.1, the Spot Removal tool has 
been updated and enhanced to bring it in line with the version that 
appeared in Lightroom 5. You can now change the size and shape of the 
Camera Raw Spot Removal tool to paint over an unwanted object using 
longer strokes instead of lots of circular overlays. This enables you to 
hide complex objects more easily, without having to leave Camera Raw.

In this walkthrough we’ll combine the healing powers of the Spot 
Removal tool with its capacity to clone. Healing relocates and blends 
sampled pixels, but that can create unwanted texture artefacts in 
complex subjects such as our piglet’s textured snout. Cloning relocates 
sampled pixels without blending them with their new neighbours, so 
you can preserve more complex details. By combining the two modes, 
you can create seamless results.

Remove 
unwanted 
distractions
Remove large unwanted elements 
from your images with healing tools

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Magnify the image
In Bridge, right click PMZ80_clone and choose Open in Camera 
Raw. Alternatively, you can double click the photo’s thumbnail. 

As it’s a digital negative format file it will automatically open in 
Camera Raw, Photoshop’s digital darkroom. To get a closer look at the 
unwanted piece of straw over the piglet's face, use the Zoom Level 
option to magnify the shot to 40%. Drag using the Hand tool to get a 
clear look at the straw.

3Sample a section
Click and paint downwards to cover the first section of straw as 
it overlaps the fur. This will create a red overlay. An identically 

shaped green overlay will automatically sample an adjacent selection 
of pixels and place them inside the red overlay. Choose a more suitable 
selection of pixels to sample, drag inside the green overlay, and place it 
alongside the red. This makes the top of the sampled snout replace the 
details hidden by the straw.

2Set the size
Grab the Spot Removal tool from the Camera Raw toolbar 
(or press B to summon it with a keyboard shortcut). The 

Spot Removal panel will appear. Set the Type drop-down menu 
to Heal. Move the cursor over the distracting piece of straw to see 
how large it is. Set the Size to 16 so that the Spot removal tool’s 
overlay is large enough to cover the width of the straw. Set Feather 
to 84 and Opacity to 100.

4Reposition the overlay
Click and drag to draw over the next section of straw. You 
can’t start drawing inside an existing overlay, but you can draw 

outside an existing overlay and then make your new stroke overlap it. 
The second overlay should automatically sample pixels from a more 
suitable area, but feel free to reposition the green overlay if necessary 
to place appropriate details (such as a wrinkle) over the straw. The 
healing won’t be perfect, but we’ll fine-tune the results later.
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5Change to cloning
When moving over more complex areas such as the nose, 
change the Type menu in the Spot Removal panel to Clone. 

This creates cleaner edges to the sampled and relocated pixels. 
Draw over the next section of nose. Drag the green overlay to make 
the right nostril overlap the missing left nostril hidden by the straw. 
Drag Feather to a sharper 68 to include more sampled nostril detail 
and hide traces of unwanted straw.

7Sample little and often
Once you’ve cloned out the largest sections of straw using 
long strokes, drop the Spot Removal tool’s tip Size to around 

7 pixels and click to place circular overlays over the remaining traces 
of straw. Reposition each green overlay to place appropriate bits of 
piglet skin into the circular overlays. The pins from the longer strokes 
can obscure your retouching work, so feel free to Untick the Show 
Overlay box for a clearer view.

6Extend the snout
Draw a horizontal stroke over the obstructed section of 
the piglet’s snout and then click the green overlay’s pin 

to select it. Drag the green overlay to the right so that it samples 
and extends the bottom of the clean snout into the red overlay. 
By cloning in smaller sections, you can begin to place parts of 
the piglet’s features over the unwanted piece of straw to create 
a suitable new patch.

8Add the finishing touches
If an overlay doesn’t do a good job, click its red or green 
pin and hit the Backspace key to delete it. You can also 

adjust an existing overlay’s Feather value to fine-tune the way it 
conceals an unwanted object. Continue clicking and stroking to 
replace traces of straw with patches of piglet until the unwanted 
object has been removed. Reposition existing green or red pins to 
fine-tune the way they perform. 
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There are some adjustments you’ll need to make to almost 
every photo. Find out what they are and how to apply them

62 Reduce unsightly 
image noise
Smooth away distracting luminance 

and chrominance noise caused by using high ISO 
settings in low-light conditions

64 Correct lens distortion 
and vignetting
Remove unwanted lens effects 

from your photos such as image distortion 
and vignetting using lens profiles

68 Correct perspectival 
distortion
Straighten converging verticals in 

your photos of buildings using the powerful 
Upright command in Camera Raw

70 Recreate in-camera 
picture styles
Make changes to the colours and tones 

of a photograph with just a few clicks by applying 
different camera profiles

74 Sharpen up 
your images
Discover how to make your photos 

appear crisp and sharp without introducing image 
noise in blurred areas

Essential 
corrections
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Reduce 
unsightly image noise
Smooth away distracting luminance and chrominance noise 
caused by using high ISO settings in low-light conditions

W
hen shooting in low lighting 
conditions your camera will 
struggle to capture a correct 
exposure. You could pop up the 

flash to add artificial light, but this may not 
always help. Flash won’t illuminate distant 
objects and may not be permitted in certain 
locations. By setting your camera to a faster 
ISO speed you can make it more sensitive to 
available light. This enables you to use a 
narrower aperture and a faster shutter speed 
in low light, but it can result in pictures 
suffering from noise. There are two types of 

digital noise present in a photo captured 
using a high ISO. The most distracting is 
Chrominance (or colour) noise. This appears 
as rainbow-coloured dots scattered 
throughout the image. Fortunately, this 
unsightly type of noise is easy to remove 
without smoothing out important details.

The second type of noise is Luminance 
noise. This appears as greyscale specks of 
digital grain. Camera Raw counteracts this 
type of noise by smoothing it using the Detail 
panel’s Noise Reduction sliders. However, this 
operation can also smooth out fine details in 

the image, so you need to juggle the sliders 
to get a balance between smoothing noise 
while preserving detail.

There are lots of different ISO speeds to 
choose from on most modern digital 
cameras. However, the higher the ISO speed, 
the noisier the results. After showing you 
how to smooth noise while preserving detail, 
we’ll demonstrate how to set up the Camera 
Raw preferences so that the correct amount 
of noise reduction will be applied to suit the 
specific ISO speed of any picture that you 
open in future. 

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Remove luminance and chrominance noise using the Detail panel

Photoshop Anatomy Noise Reduction

By default, the Camera 
Raw Noise Reduction 
sliders are set with 
Luminance at 0 and 
Color at 25. You can 
tailor these Noise 
Reduction defaults to 
apply suitable settings 
to different ISO speed 
images. Go to Camera 
Raw preferences and 
tick Make defaults 
specific to camera 
ISO setting. Click OK. 
Open an image with a 
particular ISO speed 

(such as our lizard’s 
ISO of 1000). Set 
the Noise Reduction 
sliders to smooth out 
the noise [1]. Click the 
fly-out icon [2]. Click 
Save New Camera 
Raw Defaults [3]. 
Click Done to close 
the raw file. When you 
open another ISO1000 
image, click here [4] to 
apply the appropriate 
Noise Reduction 
settings that you 
applied previously.

GIVE IT 100%

To see precisely how much noise 
is blighting your photograph, you 
need to view the shot at 100%. 
This actual-size magnification 
enables you to use the Noise 
Reduction sliders to smooth 
out noise more accurately while 
preserving important details in the 
scene. Click the Select Zoom Level 
pop-up menu and choose 100% 
from there. Alternatively, you can 
double click the Zoom tool icon 
in the toolbar, and the image will 
automatically jump to 100%. You 
can then press H to summon the 
Hand tool and drag the magnified 
image to find a noisy area to 
work on. We chose a section that 
showed a mixture of smooth 
background and the lizard’s 
detailed texture.

5 COLOR DETAIL

This slider provides a balance between reducing 
colour bleed and colour speckling. Drag it right 
to reduce bleed or left to reduce speckling. 
A value of 73 will be fine in this instance.

6 COLOR SMOOTHNESS

This slider is designed to remove low- 
frequency colour mottling, though in the 
case of this image the default setting of 50 
produces good results.

1 COLOUR NOISE

Chrominance noise is visible 
as specks of colour. By default 
the Camera Raw Color slider 
is automatically set to 25 to 
remove colour noise from all 
photos. To remove it from this 
image a Color value of 35 is 
sufficient.

2 LUMINANCE 
NOISE 

This type of greyscale digital 
noise equates to the grain 
produced by fast ISO speed 
film, although clumps of grain 
are considered more attractive 
than sharp dots of digital noise.

3 LUMINANCE

Drag this slider right to smooth 
out noise. Drag it left to restore 
fine detail. This is the most useful 
slider to start working with. 
A value of 69 dramatically 
reduces the presence of noise, 
especially in the background blur.

4 LUMINANCE DETAIL

Enables you to get a balance between smoothing out luminance 
noise while protecting important details. Drag right to sharpen 
blurred details, or left to blur more noise. You can reveal fine detail by 
increasing Luminance Contrast, though that will exaggerate noise.

Understanding…
PREFERENCES
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W
hat you see with the naked eye isn’t always what you get 
in a photo. This is due to problems produced by the 
camera’s lens. When shooting with a wide-angle lens, 
horizontal and vertical lines can look curved instead of 

straight. This distortion is especially noticeable when shooting 
architecture. Barrel distortion causes the edges of the frame to bulge 
outwards (as if you’d wrapped the photo around a barrel). Pincushion 
distortion causes the edges to bulge inwards. These types of 
lens-related problems are referred to as geometric distortion.

Due to the way a lens is manufactured, you may find that less 
light enters at the edges. The resulting uneven exposure can cause 
the edges of the frame to look darker (or vignetted). You may find 
fringes of green or purple clinging to the contrasting edges of your 
subject. This ugly and distracting chromatic aberration is caused 
by the lens’s inability to focus different wavelengths of light onto the 
same spot on your camera’s sensor. It’s more noticeable when using 
cheap lenses, but even the L-series lens used to take our starting 
image features a little fringing. We’ll show you how to use the Lens 
Correction panel’s Color tab to remove colour fringes automatically, 
or take manual control where necessary. The aptly named Lens 
Correction panel also has tools dedicated to counteracting geometric 
distortion and vignetted corners. One of the most useful tools is the 
Profile tab, because it enables you to remove lens-induced artefacts 
with a click.

Fix lens 
distortion
Remove unwanted lens effects 
from your photos such as image 
distortion and vignetting

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Open the image
Open PMZ15_lens correction in Camera Raw. If you look below 
the Histogram window you can see that a wide-angle lens was 

used to capture the picture. The additional @24 information tells us 
that the lens was at its widest setting. This will cause some geometric 
distortion and possibly lead to vignetting around the edges. Thanks 
to the lens’s wide-angle setting, the building’s edges also suffer from 
perspectival distortion.

3Before and after
If your lens’s make and model details don’t automatically appear, 
choose your lens’s manufacturer (such as Canon) from the Make 

drop-down menu. This should be enough for Camera Raw to find the 
precise lens used, and apply a profile that counteracts any geometric 
distortions that the lens produces. Toggle the profile on and off to see a 
before-and-after version of the shot. You can see that the image suffers 
from vignetted edges and barrel distortion when the profile is off.

2Use a profile
Click the Lens Corrections panel. Click the Profile tab. You can 
use this tab to make a lens profile from the metadata stored in 

the raw file. Once Camera Raw knows which lens and focal length you 
used to capture the image, it will automatically be able to counteract 
geometric distortion and create more evenly exposed edges. Tick 
Enable lens Profile Corrections. Your lens’s manufacturer and lens 
model details should appear.

4Fine-tune the corrections
In the uncorrected version of the image, the sky is darker at 
the top left corner. The profile counteracts this vignetting and 

creates a more evenly exposed sky. You can fine-tune the effect of 
the profile using the Correction Amount sliders at the bottom. To 
counteract the barrelling even more, push the Distortion slider right 
to 143. To gently reduce the strength of the vignette correction, drag 
Vignetting left to 66.
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5Create a custom profile
After tweaking the Correction Amount sliders, you’ll have created 
a custom profile. You’ll see the word Custom appear in the Setup 

drop-down menu. If you want to apply the same corrections to other 
images captured with this lens, click the Setup drop-down menu. Click 
Save New Lens Profile Defaults. Setup will change to Default, but now 
when you apply the Default profile to a shot, it will use the numerical 
values you applied to the Correction Amount sliders.

7Remove the coloured fringes
If the Remove Chromatic Aberration box doesn’t work, you 
can manually choose the colour of the fringes that you need to 

remove. Untick the box. Drag the Green Amount slider right to 16. The 
green fringe is still visible. To widen the range of the tool to include 
more green hues, drag the Green Hue slider to the right. In this case a 
value of 86 is enough to include and remove the colour of the unwanted 
green fringe. Set Purple Amount to 9 to remove the purple fringe.

6Remove the chromatic aberration
Grab the Zoom tool and click to magnify the image to 100%. 
Hold down the spacebar to summon the Hand tool and drag 

to view the church tower. You’ll notice a green fringe clinging to the 
right of the tower as the dark building contrasts against the lighter sky. 
Clinging to the left of the tower is a less noticeable but still visible 
purple fringe. In most cases you should be able to remove all traces of 
fringing by clicking the Remove Chromatic Aberration box.

8Correct the perspectival distortion
Zoom out to see the whole image. The church’s walls are 
converging inwards towards the top. To straighten them, click 

the Manual tab. Drag the Vertical slider to the left to counteract the 
perspectival distortion – a value of -30 does the trick in this example. 
After manually adjusting the verticals, you’ll need to use the Crop tool 
to hide the transparent corners at the bottom of the frame. We’ll look 
at this panel in more detail on the next spread. 
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2Auto correction
Although the tower is corrected, the 
walls at the far left and right are still converging, and 

we’ve created transparent edges that need cropping. As an 
alternative, tick the Auto button in the Upright section. This 
produces a similar perspectival correction and scales up the 
shot to remove the transparent edges.

1Straighten the building
Open PMZ16_upright DNG. Open the Lens Corrections 
panel and click Manual. Tick Show Grid. By dragging 

Vertical left to -22 you can make the tower’s vertical lines 
run parallel with the frame edge. If the corrected building 
looks a little too squat, drag the Aspect slider right to slim 
it down a little.

W
e take it for granted that most buildings have 
vertical walls that extend at a 90-degree angle 
from the ground. However, in photographs, the 
walls often appear wider apart at the ground, but 

tilt inwards towards the top (as you can see in our starting 
image). These converging vertical lines are created by 
perspectival distortion.

As you get closer to a building, you’ll need to tilt your 
camera at a steeper angle to get the top of the structure 
in shot. This will create the perspectival distortion. 
Converging lines can also be exaggerated when you use 
a wide-angle lens to fit the building into the frame.

The Manual tab on the Lens Correction panel contains 
a Distortion slider that enables you to counteract 
converging verticals. However, this can create large 
transparent areas at the bottom of the image that will 
need to be cropped out. The Upright tools enable you to 
distort your image automatically to make the subject’s 
verticals actually look vertical. They can also produce 
results that need less cropping. If you do need to crop a 
corrected shot, we’ll show you a trick that enables you 
to fill in the transparent edges with appropriate detail.

Correct 
perspectival 
distortion
Straighten converging verticals in your photos of buildings 
using the powerful Upright command in Camera Raw

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

BEFORE
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4Remove the transparent edges
Click Open>Image. To fill any transparent edges 
with appropriate pixels, grab the Magic Wand tool. 

Untick Contiguous. Click to select the edges. Choose 
Select>Modify>Expand. Type in a value of 15. Click OK. 
Choose Edit>Fill. Set Use to Content-Aware. Click OK. This 
fills the transparent edges with grass. 

3Force the verticals
The Auto button produces a subtle, balanced 
perspective correction. This means that the edge 

verticals will still tilt a little. To force all the walls of the 
building to run parallel with the edge of the frame, click the 
Vertical button. You can then drag the Scale slider left to 
reveal more of the frame’s edge details.
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2Choose a profile
Leave Process set to 2012 (Current) to use the latest 
raw processing tools. Camera Landscape increases 

contrast and boosts the colour saturation of natural colours 
such as greens without over-saturating the subject’s skin 
tones, so settle with that profile as a starting point.

1Choose your processing options
Open PMZ20_calibration. Click the Camera Calibration 
panel. Camera Raw 8 uses the 2012 processing engine, 

but you could jump back to the 2010 process to replace the 
Basic panel’s Highlights and Shadows slider with the older 
Recovery and Fill light sliders.

M
any digital cameras provide the 
opportunity to process a shot as they 
capture it, using a range of preset 
applied adjustments such as Portrait, 

Landscape, Neutral and so on. These presets change 
the look of the captured shots’ colours and tones. 
For example, a camera’s Landscape preset might 
boost the saturation of natural colours such as 
blues and greens. The Neutral preset will avoid 
boosting the colour and contrast so that you can 
get the look you want manually by adjusting the 
sliders in Camera Raw.

If you shoot in JPEG format, then the results 
of these in-camera presets will be harder to alter 
in Photoshop. However, if you shoot in your 
camera’s raw format then you can experiment with 
different looks quickly and effectively, courtesy of 
the profiles and sliders in the Camera Calibration 
panel. This panel provides you with a springboard 
for quickly adjusting a raw file’s colour and tone. 
You can then fine-tune the results of a particular 
preset profile using the Basic panel’s sliders.

Recreate in-camera 
picture styles
Make changes to the colours and tones of a photograph 
with just a few clicks by applying different camera profiles

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Back to Basic
Pop back to the Basic panel to finish improving the 
image. Set the Shadows slider to +34 to reveal more 

detail in the dark irises. Drop Clarity to -13 to smooth skin 
pores. Push Vibrance to +17 to boost weaker colours without 
over-saturating stronger ones (or skin tones).

3Fine-tune the profile
Draw attention to the vegetation by boosting Vibrance 
to +40. This selectively boosts the saturation of typical 

landscape colours without over-saturating any skin tones that 
may be present. Click the Presets tab. Click the New Preset 
icon at the bottom of the tab.
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If you want to take more manual control over the colours and 
tones of an image, use the Camera Neutral profile. This gives 
you a very flat contrast and helps avoid clipping detail in the 
shadows and highlights [1]. It also produces desaturated 
colours. You can then boost the colour saturation and increase 
the contrast using the sliders in the Basic panel. For an instant 
high-contrast shot with vivid colours, choose the Vibrant profile 

as your starting point [2]. For more creative looks, experiment 
with the mix of Primary Reds, Primary Greens and Primary 
Blues. Here [3] we’ve adjusted the Hue and Saturation values to 
create a shift towards a predominantly yellow hue. You can also 
use the Camera Calibration panel to tint the photo’s shadows 
green or magenta, courtesy of the Tints slider. We’ve boosted the 
presence of the magentas in this example [4]. 

1

3

2

4

Want to know more?
NOW TRY THIS…



Discover Britain’s
best-selling photo mag…

Digital Camera is the definitive guide to SLR photography. Every issue is packed with 
in-depth advice and practical tips for better photos. We also publish the toughest 

tests around, helping you buy cameras and lenses with confidence.

Subscribe today at http://bit.ly/digitalcameramagazine
Join our friendly online communities at

Twitter
@DCamMag

Facebook
www.facebook.com/
Digitalcameraworld

Flickr
www.flickr.com/groups/
digitalcameraworld

NO. 1 
FOR 

GIFTS

FREE DISC EVERY ISSUE! 
Plus a host of other great gifts – see your local newsagent today



Teach yourself Raw in Photoshop
ESSENTIAL CORRECTIONS

74

I
t can be a challenge to get your shots looking 
sharp. For starters, some digital cameras have a 
built-in filter that blurs the shot a little in an 
attempt to avoid producing moiré patterns. This 

low-pass (or anti-aliasing) filter can also soften important 
details such as the fine textures in an insect’s eye. If you 
shoot with a wide aperture then key details may become 
blurred due to the resulting shallow depth of field. An image 
that may look nice and sharp on your camera’s display can 
turn out to be soft when viewed on a larger PC monitor.

The Camera Raw Detail panel has a Sharpening section that 
has a collection of sliders designed to tease out fine details 

in a soft shot. These post-production sharpening techniques 
work by increasing the contrast around the edge of details 
in the image, giving them more impact. However, when you 
digitally sharpen an image, you risk exaggerating picture 
noise in smooth areas such as our starting image’s clean 
blurred background. You can also introduce artefacts such as 
blown-out highlights, clipped shadows and distracting haloes 
clinging to the edge of the sharpened areas.

We’ll demonstrate how to use the Detail panel to restrict 
the sharpening to key areas, while protecting other sections 
of the image from being sharpened (and therefore minimising 
unwanted artefacts).

Sharpen 
your images
Discover how to make your photos appear crisp and 
sharp without introducing image noise in blurred areas

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2  Increase the sharpening
By default Camera Raw applies a sharpening Amount 
of 25 to give the picture a bit more punch. We’ve set 

Amount to 0 so that you can see how soft the subject really 
looks. By dragging Amount to the maximum of 150 you can 
tease out the fine textures in the moth’s eye.

1 Magnify the image
Open PMZ46_sharpen in Camera Raw. To see exactly 
how sharp the shot really is, grab the Zoom tool. Right 

click and choose 100% from the pop-up menu. Hold down 
the space bar to summon the Hand tool and drag to view the 
eye. Click the Detail panel’s tab.

4 Adjust the Radius
Experiment by dragging Radius back and forth. This 
increases the spread of the contrast change, which 

helps make contrasting details look sharper. If you combine a 
high Amount with a high Radius you add black or white lines 
(or haloes) to edges in the scene. Set Radius to 2.0.

3 Reduce the noise
By increasing the Amount you increase the strength 
of the contrast change around details in the image. 

This makes the fly’s eye look sharper, but it also exaggerates 
the picture noise in the smooth blurred background. Drop the 
Amount to a lower 96 to reduce the noise.

6Adjust the Masking
This slider stops noise in smooth areas from being 
sharpened. Hold Alt and drag the Masking slider until 

the background appears in black and the fly in white. Now 
the sharpening adjustments will only be applied to the white 
areas. You can now boost the Amount to 130. 

5 Adjust the Detail
The Detail slider helps you get a balance between 
sharpening the shot while keeping noise to a 

minimum. Drag it left to soften the scene and remove the 
noise, or right to reveal more detail and noise. Hold Alt as you 
drag to get a greyscale preview of the details being revealed.
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Improve 
tones
Adjust the highlights, shadows and midtones 
of a photo either globally or in selected areas

78 Improve exposure 
and contrast
Diagnose a photograph’s tonal 

problems, reveal missing tonal detail, and avoid 
clipping the highlights and shadows

82 Reveal detail in the 
highlights and shadows
Target and tweak the highlights 

and shadows of a photo independently to reveal 
missing tonal detail

84 Improve tones 
with curves
Target and adjust specific tones 

in an image by editing the shape of the tone 
curve in Camera Raw

88 Dodge and burn with 
the Adjustment Brush
Learn how to make selective brush-

based tonal adjustments to tease out detail in your 
photos where it’s needed

92 Reproduce the 
solarisation effect
Harness the power of the Tone Curve 

panel to mimic a traditional darkroom image-
processing technique
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BEFORE

O
ne of the most common challenges we face as 
photographers is to capture a correctly exposed 
scene. If we shoot in manual mode, we may find 
that the image is either over- or under-exposed. 

In this walkthrough we’ll demonstrate how to analyse the 
spread of tones in a photo courtesy of the Histogram, and 
then use this tool to create a correctly exposed image. 

When adjusting tones, you risk clipping the darkest 
shadows or brightest highlights. Clipped shadows will 
lack detail and print out as pure black. Clipped highlights 
will also lack detail and print out as pure white. We’ll 
demonstrate how to use the Histogram’s clipping warning 
tools so that you can avoid losing detail in important areas 
while increasing contrast in the scene.

In contrasting lighting conditions your camera may 
struggle to correctly expose both the shadows and the 
highlights at the same time. In our starting image we have 
a bright sky, a distant sunlit hill and a large section of 
foreground river in shadow. The camera has metered to 
capture sky detail, but this has caused the shaded foreground 
to be very under-exposed. The details in the foreground lack 
contrast too.

Camera Raw is packed full of selective tone-tweaking tools 
that enable you to create a more balanced exposure, with 
detail in both the shadows and the highlights. We’ll also 
demonstrate how to increase the contrast between shadows 
and highlights, which will help make objects and textures in 
the scene stand out more effectively.

Improve contrast 
& exposure
Diagnose a photograph’s tonal problems, reveal missing 
tonal detail, and avoid clipping the highlights and shadows

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Analyse the histogram
Open PMZ102_exposure in Camera Raw by double clicking the 
thumbnail in Adobe Bridge. Take a look at the Histogram graph. 

The graph peaks towards the left, indicating that there are lots of 
strong shadows in the image. The graph dips in the middle, indicating 
some midtone detail. It plummets towards the right, indicating a 
few weak highlights. This is exactly as expected with a dark, gloomy 
image like this one.

3Boost Exposure
The clipping warnings will help you keep clipping to a 
minimum as you reveal detail where it’s needed. On location we 

could have opened up our camera’s aperture to let more light hit the 
sensor. The Exposure slider lets us do a similar job. If you drag it to 
2.00 it’s the equivalent of opening the aperture by two f-stops. This 
lightens up the shadows, but red highlight clipping warnings indicate 
that we’re losing some sky detail.

2Shadow clipping
Click the blue Shadow clipping warning icon at the top left of 
the Histogram (or press U for Under-exposed). Any clipped 

shadows will show up as patches of blue. You can see a few clipped 
shadows at the right of the photo. Press O (Over-exposed) to turn 
on the highlight clipping warning. This will display over-exposed 
highlights in patches of red. At this stage, there are no clipped 
highlights in our unprocessed under-exposed image.

4Brighten the shadows
Drop the Exposure slider to +1.00. This loses the red highlight 
clipping warning but reintroduces some blue shadow clipping. 

You can brighten up the shadows without over-exposing the 
highlights using the Shadows slider. Drag it to+84. You can now see 
more shadow detail in the foreground. It’s worth leaving a hint of 
shadow clipping because this means that the shot has some black 
pixels in the shadows.



Teach yourself Raw in Photoshop
IMPROVE TONES

81

5Recover the highlights
The exposure boost we created in step three has brightened the 
sky a little too much, and we’re losing some detail. To claw back 

more highlight information without altering the shadows, drag the 
Highlights slider left to -55. This helps restore colour and detail to the 
brighter sky. The histogram graph has slid to the right, indicating that 
our processed picture now has a healthier spread of shadows, midtones 
and highlights.

7Enhance the colour
When making dramatic tonal changes it’s worth pressing Q to 
cycle between before and after views of the processed picture. 

This helps you see how your image is shaping up. Boost Vibrance 
to +43 to make the various colours stand out. The foaming water 
looks a little green, so counteract this unhealthy tint by going to the 
White Balance section of the Basic panel and dragging Tint to +11. 
Go back to Single View.

6Adjust Clarity
Once you’ve created a more wider spread of shadows and 
highlights, turn your attention to the midtones. By increasing 

the midtone contrast, you can make subtle textures and details stand 
out more effectively. Drag Clarity to +42. This brightens the foam on 
the water and darkens the midtones on the rocks. This subtle increase 
in midtone contrast gives the water more impact. It also adds a few 
clipped shadows, but we’re not losing important detail in these areas.

8Make a contrast tweak
You may find it confusing to understand the difference 
between the Highlights and Shadows sliders and the similar 

Whites and Blacks. For maximum contrast, a photo should feature 
some black pixels and some white ones. If you drag Whites to 
+6 then a red highlight clipping warning patch will appear on the 
brightest cloud. This is fine because there’s no crucial detail being 
lost here. Drop Blacks to -4 for a hint of shadow clipping. 
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2Adjust the shadows
Drag the Highlights slider down to -30 to correctly 
expose them. To reveal more shadow detail without 

interfering with the correctly exposed highlights, drag the 
Shadows slider right to +50. The shadows in the histogram 
have slid right a little, indicating their brighter status.

1Adjust Exposure
Open PMZ92_shadowhighlight in Camera Raw. You can 
see from the histogram that the image features strong 

shadows and a few weak highlights. Drag the Exposure slider 
to +0.85. This reveals more shadow detail, but the highlights 
now look a little too bright.

I
n the starting image for this tutorial the 
foreground mountains are in shadow due to the 
clouds, but the distant sunlit hills and sky are 
much brighter. If we meter the camera to capture 

detail in the shadows then we blow out the highlights in the 
distance. As it’s harder to recover missing highlight detail 
than it is shadow, we’ve prioritised the highlights when 
setting the exposure. As a result, our unprocessed raw file 
features a large area of under-exposed shadows that lack 

detail. We need to brighten up the shadows without over-
exposing the highlights. The Camera Raw Basic tab enables 
you to combine global exposure adjustments that brighten or 
darken the entire image with local adjustments that enable 
you to adjust the shadows or highlights independently. By 
combining global and local adjustments, you can reveal detail 
precisely where its needed and produce a photo with 
correctly exposed shadows and highlights. You’re editing a 
raw file, so there will be much more tonal detail to work with.

Reveal detail
Target and tweak the highlights and shadows of 
a photo independently to reveal missing tonal detail

4 Increase the midtone contrast
Drag the Clarity slider right to +18. This increases the 
midtone contrast and makes the textures in the rocky 

shadows stand out more effectively. We’re only adjusting the 
midtones so the correctly exposed shadows and highlights 
remain unaltered. Boost Saturation to +8 for extra colour. 

3Boost the colour
When you brighten up under-exposed shadows, the 
colours that are revealed in these areas tend to look 

drab. By dragging Vibrance to +48 you can boost weaker 
colours in the shadows without over-saturating strong 
highlights in the brighter areas.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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C  amera Raw recreates a photo’s shadows, 
midtones and highlights using a range of tonal 
levels. The darkest blacks have a level of 0, 
while the brightest highlights have a level of 

255. All the shades in a picture are produced using levels 
that fall between these two extremes. When you import 
an unprocessed raw image into Camera Raw, you will see 
the tones created by its input levels. These are tones that 
are captured using the camera’s aperture and shutter 
speed settings. In the case of our starting image, the shot 
is under-exposed. The shadow input levels are too low 
and lacking in detail. We need to remap these low (dark) 
input levels to higher (brighter) output levels. In the 
Histogram window, our starting image’s highlights peter 
out before they hit the far right of the graph. 

This indicates that the highlight input levels aren’t as 
strong as they could be, so we can remap these too.

The Basic panel’s tone-tweaking tools (such as the 
Shadows and Highlights sliders) are designed to target 
a specific range of input levels and remap them to new 
output levels. In most cases you can overcome typical 
problems with exposure using these sliders. An alternative 
way to target and adjust a specific range of levels can 
be found in the Tone Curve panel. This tool also uses a 
histogram to present the image’s current input levels as 
an undulating graph. A diagonal straight line crosses the 
histogram, from the darkest section at the bottom left to 
the brightest section at the top right. By making parts of 
the line curve up or down you can lighten or darken the 
levels of specific tones on the underlying histogram.

Use curves to 
improve tones
Target and adjust specific tones in an image by 
editing the shape of the tone curve in Camera Raw

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Examine the levels
Open PMZ52_curves in Adobe Camera Raw. To get a clearer 
understanding of the tonal levels that make up the shot, grab 

the Zoom tool. Move the Zoom tool over the brightest area that 
you can find, such as the white patch on the dress. Below the 
Histogram you’ll see the RGB values of the sampled area. In this 
example we have a value of 214, 211 and 188. A pure white area 
would have levels of 255, 255, and 255.

3Open the Tone Curve panel
To brighten up this under-exposed shot and reveal more 
detail in the shadows and midtones, click the Tone Curve 

panel. Curves come in two categories – a Parametric curve and a 
Point curve. The Parametric curve is easier to use because it breaks 
the curve up into four tonal regions – Shadows, Darks, Lights and 
Highlights. You can use sliders to target and adjust a specific region 
without altering tones with different levels. 

2Sample the shadows
From the sampled level we can see that the brightest whites 
are quite dull and under-exposed. Press U to turn on the 

shadow clipping warning. You’ll notice a blue patch of clipped pixels 
on the dress. Move the Zoom tool over this area to take an RGB 
reading. This clipped section has RGB values of 0,0, and 0. This 
indicates that this part of the picture is pure black, and will print 
with no detail.

4Adjust the shadows
Initially, our curve is a straight diagonal line. To start curving 
it (and remapping the input levels to new output levels) drag 

the Shadows slider right to +30. This causes the lower left section of 
the diagonal line to curve upwards. As this part of the curve overlaps 
the darker sections of the histogram graph, it remaps these shadow 
areas to brighter output levels. The remapped shadow tones in the 
Histogram window will slide right a little.
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5Adjust the midtones
To lighten up the midtones, drag the Darks slider to +50. This 
pushes the middle of the curve upwards. This section of the 

curve overlaps the midtones on the histogram, so they are remapped to 
a lighter level. The subject’s midtones and shadows now look lighter, 
and more detail is visible. We still have a little shadow clipping on the 
dress, but there’s no important detail here, and it’s good to have some 
black shadows for contrast.

7Fine-tune the look
You can fine-tune the effect of the four sliders by tweaking 
the range of levels that they alter. To let more midtones fall 

under the influence of the Shadows slider, go to the bottom of the 
Parametric curve’s histogram. Here you’ll find triangular control points 
that indicate the boundary between each slider’s region. Drag the left 
control point from its default value of 25 to 38. This lightens up the 
midtones a little more.

6Adjust the highlights
Press O (for over-exposed) to turn on the Highlight clipping 
warning so that you can spot blown-out (pure white) highlights 

as patches of red. To make the highlights slightly brighter, push the 
Lights slider to +10 and the Highlights slider to +4. The top right of 
the curve will move upwards, brightening levels at the far right of the 
histogram graph. Don’t push the highlights too far or you’ll exaggerate 
the unflattering sweat reflections on the skin.

8Add contrast with a Point curve
The adjacent Point Curve tab is handy if you have a shot that 
lacks contrast. The Curve drop-down menu allows you to 

choose preset point curve adjustments such as Strong Contrast. This 
creates a classic S-curve shape. A point pulls the curve down at the 
left to darken the shadows. Another point pulls the curve up at the 
top right to lighten the highlights. You can drag the points to fine-
tune the results. 
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T  he Camera Raw Basic panel has plenty of tone- 
targeting sliders that are designed to selectively 
adjust a shot’s shadows, midtones and highlights. 
The Shadows slider lightens shadows without 

over-exposing stronger highlights. You can claw back missing 
highlight detail without under-exposing correctly exposed 
shadows thanks to the Highlights slider. The Clarity slider 
enables you to increase midtone contrast and make subtle 
textures and details pop out from the processed picture. 
Camera Raw also has tools that enable you to make gradated 
tonal adjustments, so you can darken a bright sky without 
altering the correctly exposed terrain in the bottom section 
of the scene. You can even click the Histogram and see which 
tonal region is represented by a particular part of the graph. 
If you drag to the right you can brighten the selected region 
of tones (such as shadows), or drag left to darken them.

Most tone-related problems can be tackled by applying a 
combination of the tools or techniques mentioned above, but 
for even more selective tonal corrections, you can use Camera 
Raw to mimic the traditional darkroom technique of dodging 
and burning. By placing a shaped piece of card between the 
enlarger and photo paper, a photographer could reduce the 
amount of light hitting parts of the print. This dodging 
would lighten the masked sections. To darken a particular 
area, the photographer would cut a shape in a piece of card. 
The extra light travelling through the hole would darken (or 
burn) details in the print. We can recreate these dodging and 
burning techniques using the Adjustment Brush.

Dodge and burn with 
the Adjustment Brush
Learn how to make selective brush-based tonal adjustments 
to tease out detail in your photos where it’s needed

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Open the image
Open PMZ100_dodge and burn in Camera Raw. The Histogram 
indicates the presence of strong shadows on the left of the 

graph, but the tones peter out towards the highlights on the right. 
The image is under-exposed. Before we make time-consuming 
selective brush-based adjustments, we should use the Basic panel’s 
sliders to give the photograph a healthier looking histogram with a 
wider tonal range.

3Lighten the shadows
You now have a photo that possesses some bright highlights. 
To reveal more detail in the shadows, click near the left of the 

Histogram to target the Shadows. Drag right on the Histogram to 
remap the original shadows to a brighter value. The Shadows slider 
will move to the right. A Shadows value of +72 is a good starting 
point. The Histogram graph now has a wider spread of tones, and the 
image looks more correctly exposed as a result.

2Boost the highlights
Place the cursor on the section of the Histogram graph that 
represents and controls the Highlights. The label Highlights 

will appear below the graph. Drag right to lighten the under-exposed 
highlights. The highlight section of the graph will slide to the right, 
indicating the presence of brighter tones. Drag until the Highlights 
slider reads 100. Drag the Whites slider right until a hint of red 
clipping warning appears in the brightest area.

4Adjust the midtones
The picture is now correctly exposed, but it lacks contrast. 
Textures such as the motion-blurred foamy water lack 

impact. This area is a mass of flat contrast midtones. To tease out 
more detail in the water, increase the Clarity slider to +45. This 
increase in midtone contrast lightens the water and darkens the 
greyscale rocks that were hidden just under the surface, making 
them more visible.
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5Dodge the water
Use the Select Zoom Level tool to view the image at Fit In View. 
We’ve made all the selective tonal tweaks that we can using the 

Basic panel’s sliders, so it’s time to grab the more versatile Adjustment 
Brush from the toolbar. The Adjustment Brush panel will appear. Click 
to place a pin on the greyscale foamy water. Push Exposure up to +0.15. 
Set Contrast to +43. Set Highlights to +63. Boost Clarity to 60. Paint 
with a soft-edged brush over the foamy water to lighten (dodge) it.

7Burn the clouds
The distant grey clouds on the horizon are barely noticeable 
because they’re lost in hazy midtones. We can darken the grey 

clouds while boosting the contrast of their lighter surroundings to 
help them stand out. Click New (or press N) to start making a new 
adjustment. Click to place a pin on the distant clouds. Set Contrast to 
+43 and Highlights to +63. Drop Shadows to -65. Boost Clarity to +60. 
Tick Auto Mask.

6Lighten the rocks
Click the New button at the top of the Adjustment Brush 
panel. To tease out more detail and colour in the rocks, click to 

place a second pin. Set Shadows to +43 and boost Clarity to +57. Push 
Saturation up to +6. Paint over any rocks poking out of the water. The 
settings will lighten the rock’s shadows and increase their contrast, 
which helps emphasise their texture. A hint of shadow clipping will 
appear, but there's no important detail to lose in these areas.

8Use Auto Mask
Paint with a small soft brush tip along the horizon to darken 
the grey clouds and make them contrast with their lighter 

surroundings. The Auto Masks option stops the effects of the 
Adjustment Brush from straying below the distinct horizon line. 
Turn on Show Mask to see which areas are being adjusted and which 
are being left untouched by this particular pin. We’ll look at Auto 
mask in more detail in the next chapter. 



Teach yourself Raw in Photoshop
IMPROVE TONES

92

4Fine-tune the effect
By remapping the brightest highlights from a bright 
255 to a dark 0, you've turned them black. For a more 

striking contrast, drag the central control point upwards so it 
has an Input of 128 and a brighter Output of 255. In the Basic 
panel, drop Blacks to -50 for a darker background. 

3 Invert the highlights
Click the Tone Curve panel and then click the Point 
Curve tab. Click to place a control point on the middle 

of the linear diagonal line at an input and output value of 128. 
Click the highlight control point at the top right of the line 
and drag it down to an Output of 0 to create a curve.

2 Increase the contrast
Go to the Basic panel. Pop Exposure up to +0.20. 
Increase Contrast to +22. Boost the Highlights slider 

to +70 to make the lightest skin tones stand out against the 
darker background. For darker contrasting shadows, drop 
Blacks to -30. Drop Clarity to -20 to smooth the skin.

1Desaturate the image
Open PMZ107_solarise in Camera Raw. Kick off by 
going to the HSL/Grayscale panel and clicking the 

Convert to Grayscale box. Tick the Auto button to help 
create a little more contrast. Push Oranges up to +14 to 
lighten the skin a little.

T
hroughout this chapter we’ve demonstrated how 
to remap your photographs’ tones to reveal detail 
were it’s needed, including using the Tone Curve 
panel to selectively adjust shadows, midtones and 

highlights. You can also use the Tone Curve panel to emulate 
the darkroom-based solarisation technique made famous by 
surrealist photographers such as Man Ray. This developing 
technique harks back as far back as 1920s. At first glance, 
a solarised photo may look like a negative version of a mono 

image. However, in a negative all the shadows and highlights 
are reversed so that blacks become white and vice versa. In 
solarised images, only some of the tones are reversed. 
Another distinctive property of a solarised photo is the sharp 
white line that appears around high-contrast areas.

The solarisation effect was discovered by accident and is 
tricky to produce in a traditional darkroom. By combining 
the Camera Raw Basic sliders with the Point Curve, you can 
create a solarised image with ease.

The solarised look
Harness the power of the Tone Curve panel to mimic 
a traditional darkroom image-processing technique

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Improve 
colour
Sensitively enhance the colour rendition in your photos 
and add extra interest with creative special effects

98  Understand 
white balance
Discover how to diagnose colour-cast 

problems in your photos, and correct them using 
white-balance techniques

102 Create spot-colour 
special effects
Isolate and preserve the colour of a 

specific element in a monochrome conversion for a 
stylish creative effect

104 Selectively adjust 
colour saturation
Use the HSL sliders in Camera 

Raw to target and tweak the saturation of specific 
colours to make them pop!

106 Enhance colours 
in portraits
Use the Vibrance slider to 

enhance weaker colours in a portrait without over-
saturating the skin tones of the subject

108 Recreate the cross- 
processed look
Target and tweak the tone curves 

of individual colour channels to get a creative 
cross-processed effect
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4Boost the Vibrance
Our raw file’s colour temperature was a warm 6150. 
Thanks to the White Balance tool, the Temperature 

slider now reads a cooler 3800, creating a Custom White 
Balance preset that suits the image. Boost Vibrance to +30 to 
enhance the colours without over-saturating the skin tones. 

3Balance the whites
If the RGB values taken by the Color Sampler are still 
quite different, click the White Balance tool on a 

different area until the values are more similar. Here we sam-
pled an area that produced an RGB value of 170, 174, and 175. 
Our whites are now more natural tint-free colours.

2Counteract the tint
Grab the White Balance tool. Click an area that should 
be white (such as the eye) to sample it. If the tool 

detects a tint, it will counteract the colour temperature to 
warm up or cool down the shot to make whiter whites. 
The sampled RGB values should become closer.

1 Sample the whites
Open PMZ32_white balance in Camera Raw. Grab the 
Color Sampler tool. Click twice to sample the whites of 

the eyes. If the RGB values are equal, the sampled areas will 
be a neutral grey. The sampled RGB values are around 24, 168, 
and 139 so we can see that a tint is present.

D
ifferent light sources produce different colour 
temperatures. To a camera, natural daylight is a 
cold blue, while artificial indoor light is a warmer 
orange. Your camera’s automatic white balance 

(AWB) setting attempts to get white details in the scene 
looking white, so that other colours will be tint-free and 
natural-looking. If the whites look too warm (orange) the 
camera will cool them down. If they’re too cold (blue) then 
the camera will warm them up to remove the cold blue colour

cast in the entire image. If the camera balances the whites 
correctly, the resulting photograph will be tint-free and 
present the scene’s true colours. However, sometimes a photo 
will look too cold or too warm despite the camera’s best 
efforts. Our starting image suffers from a warm colour cast, 
which makes the subject’s skin tones look too orange. We’ll 
show you how to use the Color sampler tool to identify the 
presence of colour casts and then apply the effective White 
Balance tool to create tint-free shots.

White balance
Discover how to diagnose colour-cast problems in your 
photos, and correct them using white-balance techniques

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Your camera’s menu has a series of white balance presets 
designed to help it capture true colours in a range of lighting 
conditions. Camera Raw also has white balance presets to 
help counteract colour casts or change the mood of a shot 
by deliberately adding tints. Daylight has an average colour 
temperature of 5500 degrees K, so the Daylight preset cools 
down our warmer 6150 starting image, but it still looks too orange 

[1]. Artificial tungsten light adds a warm yellow hue, so the 
tungsten preset counteracts this with a cold blue temperature 
setting of 2850 [2]. Fluorescent lights can add a greenish hue, so 
the Fluorescent preset adds a +21 hint of magenta to counteract 
the green, as well as cooling the photo to 3800 [3]. Auto does 
a similar job to the White Balance tool, which produces the best 
results than the other presets in this instance [4]. 

1

3

2

4

Want to know more?
NOW TRY THIS…
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2Restore selective colours
Grab the Targeted Adjustment tool from the tool bar. 
Because you're working with the Saturation panel, this 

tool will automatically be set to target and adjust saturation. 
Click parts of the fly and drag upwards to restore colour to 
the sampled sections.

1Desaturate the image
Open PMZ85_colour. Click the HSL/Grayscale tab. 
Normally, we’d create a monochrome image by clicking 

the Convert to Grayscale box, but to preserve traces of colour 
we need to desaturate the image manually. Click the 
Saturation panel and drag all the sliders down to -100.

O
ne way to draw the eye to a specific subject in a 
photograph is to preserve that object’s colour 
information while converting the rest of the 
image’s tones to monochrome. This spot colour 

technique might be considered by some to be a bit tacky, but 
for others it’s a popular creative processing technique that’s 
fun to indulge in. For example, you can’t wander through a 
London street without seeing spot-colour postcards that 
feature iconic red buses against a monochrome backdrop.

The HSL panel enables you to target and tweak a 
photograph’s colour strength (Saturation) and brightness 
(Luminance), so you can enhance a landscape’s drab sunset 
by endowing it with more vibrant reds and oranges, while 
lightening the tones of under-exposed green hills to make 
them more prominent. In this creative walkthrough we’ll 
use these HSL controls to selectively desaturate all the 
colours in our starting image except for those of the fly. 
We’ll show you how to customise the selective slider-based 
colour adjustments by applying desaturating strokes via 
the Adjustment Brush. This enables you to restrict specific 
colours to the main subject (in this case the fly) while 
removing traces of the same colours from the background.

Make spot 
colour effects
Isolate and preserve the colour of a specific element in a 
monochrome conversion for a stylish creative effect

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Desaturate background colours
Once most of the fly’s colours have been restored, grab 
the Adjustment Brush. In the Adjustment Brush panel, 

set the Saturation slider to -100. Set Size to 8 and choose a 
Feather of 45. Set Flow and Density to 100. Paint to remove 
unwanted traces of background colour. 

3Boost the greens
As you sample and drag the cursor, similar colours in 
the rest of the frame will become saturated too, such 

as the green stems. We’ll restore these to mono in the next 
step. Avoid increasing the strength of the yellows to keep the 
flower looking monochrome.
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4Adjust the Hue
To make colours stand out even more, click the Hue 
tab and set the Blues Hue to -23. This creates a colder 

blue that contrasts with the warm skin. Drag the Purples 
slider to -52. This makes the glasses look more blue, so the 
warmer paint specks are more noticeable. 

3Tweak the skin tones
Boost the Blues slider to +44 to make the blue paint 
stand out more effectively. To contrast the colourful 

paint specks with the subject’s skin, drop Oranges down to 
-21. This also creates more natural-looking skin tones, and 
stops the shadows from looking too orange.

2Make selective adjustments
Some of the skin tones in the shadows look too orange, 
so drop Vibrance to 0. For greater control over 

saturation, click the HSL/Grayscale panel icon. Click the 
Saturation tab. Drag the Purples slider up to +34 to give her 
glasses more impact. Tease out green blobs of paint by 
dragging the Greens slider up to +47.

1Adjust Vibrance
Open the starting image in Camera Raw. Our portrait is 
packed full of colours. Experiment by dragging 

Saturation up to +50. The paint specks look more vibrant, 
but the skin looks too orange. Reset Saturation to 0. Drag 
Vibrance to +50. The paint and glasses look more saturated, 
while the skin looks less orange.

T
he colours that you see onscreen don’t always look 
the same when you print your picture. This is 
because your computer’s display creates millions 
of colours by mixing the red, green and blue 

channels together while your printer combines cyan, 
magenta, yellow and black ink to create fewer colours. If you 
boost the saturation of a photo to create more vibrant 
colours, you might make weaker colours look stronger, but 
you’ll over-saturate the more vibrant colours and make them 

unprintable. You also risk making skin tones look too orange. 
You can make selective colour adjustments to a photo using 
the Vibrance slider. This selectively boosts the saturation of 
weaker colours without over-saturating stronger ones. 
Vibrance also leaves skin tones alone. 

Vibrance is biased towards boosting typical landscape 
colours such as blues and greens. If you need to boost the 
saturation of other colours then you need the services of the 
HSL panel and its colour-specific sliders.

Adjust colours
Use the HSL sliders in Camera Raw to target and tweak 
the saturation of specific colours to make them pop!

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2Boost the Saturation
The woman’s face looks a little bright, so drag 
Highlights to -41 to reveal more detail. By boosting the 

Saturation slider to +43 you can reveal more blues in the 
railings and enhance the greens of the plants, but this causes 
the subjects’ skin tones to look too warm and orange.

1Open the image
In Bridge, right click the PMZ54_vibrance thumbnail and 
choose Open in Camera Raw from the context-sensitive 

pop-up menu. Or choose File>Open in Photoshop and browse 
to the shot. Choose Open. The digital negative format image 
will open in Camera Raw.

W
hen you shoot a JPEG your camera will apply 
colour presets directly to the image. This can 
make your photographs look too vibrant, or they 
may look rather drab depending on the preset that 

you assigned using the camera’s menu options. Settings such 
as Portrait are good for producing natural-looking skin tones, 
whereas a Vivid mode might make skin tones look too 
orange. By shooting in the raw format you can process your 
images in Camera Raw and get the colours looking just the 
way you want. This gives you the power to improve on 
disappointing results produced by in-camera presets. After 
removing colour casts using tools such as White Balance 
presets or the White Balance tool, you can adjust the 
saturation of the photo’s colours to give them more impact, 
and draw the eye to specific objects in the frame.

The Saturation slider in the Basic panel enables you 
to boost the colour saturation by an equal amount. This 
provides a quick way of creating a more vividly coloured 
image, but it can over-saturate skin tones. Some colours 
(such as blues) don’t print very accurately if they are too 
saturated, so we’ll show you how to make selective colour 
saturation boosts.

Enhance colours 
in portraits
Use the Vibrance slider to enhance weaker colours 
in a portrait without over-saturating the skin tones

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

BEFORE
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4Tweak the Saturation
Due to its bias towards altering natural colours such as 
blues and greens, the Vibrance slider is great for 

enhancing the colour in typical landscape photos. After 
boosting Vibrance, tweak the global colour strength by 
increasing Saturation to a more subtle +14. 

3Boost the Vibrance
Drop the Saturation slider down to 0 for the moment. 
By increasing the value of the Vibrance slider you 

can selectively boost the saturation of the weaker blues and 
greens while leaving the skin tones as they are. This avoids 
producing a print featuring an orange-looking couple.
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2Tint the blues
Click the middle of the diagonal curve to place a 
control point. The point’s Input and Output values 

should read 128 each. Click the cursor on the lower half of the 
curve where that the Input is 64. Drag the point upwards to 
create an output value of 14. This adds a cyan tint.

1Choose a channel
Open PMZ02_cross process in Camera Raw. Click the 
Tone Curve panel and then click the Point Curve tab. By 

default you’ll see a curve that controls the RGB channels at 
the same time. To target a specific colour channel, click the 
Channel drop-down menu and choose Blue.

A
photograph’s colours are created by mixing the 
red, green and blue colour channels together. By 
targeting and tweaking points on a particular 
channel’s tone curve you can produce dramatic 

changes in hue. This provides an effective way to create a 
cross-processed look. The term cross-processing refers to a 
developing technique used in chemical darkrooms. It involved 
deliberately developing print negatives using chemicals that 
were designed for use with slide film (or visa versa). The use 
of incorrect chemicals resulted in a shift in colour hue, 
leading to stylised and eye-catching images. Cross-processed 
blues often took on a green hue, for example, while a shot’s 
shadows might feature a hint of magenta.

This developing process (or at least the look that the 
traditional cross-processing technique produced) is 
still popular, especially with fine art, fashion and stock 
photographers who want their work to stand out from the 
crowd. In the days of the traditional darkroom, the results 
could be a bit hit or miss, so you had to experiment to try 
to get the desired shifts in colour and tone. By tweaking the 
tone curve of individual colour channels, you can replicate 
almost any chemical combination you might desire.

Get the cross- 
processed look
Target and tweak the tone curves of individual colour 
channels to get a creative cross-processed effect

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

BEFORE
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4Tint the shadows
On the Green curve, set an anchor point at an Input 
and Output of 128. Place a new point at an Input of 63 

and drag it to a lower Output of 53. This adds a magenta hue 
to the photo’s shadows. You now have cross-processed cyan 
blues and magenta tinted shadows. 

3Adjust the reds
Set the drop-down menu to Red. Place a point at an 
Input and Output value of 128. This central anchor 

point allows you to target tones on one side of the point 
without altering tones on the other. Drag another point to 
an Input of 192 and an Output of 175.
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Selective 
adjustments
Discover how to isolate particular parts of a photo 
so you can make localised image adjustments

112 The Adjustment 
Brush tool
Lighten or darken specific regions 

of an image using the Adjustment Brush tool in 
Camera Raw

116 Enhance plain- 
looking skies
Fix dull-looking over-exposed skies 

by applying a gradated tonal adjustment using the 
Graduated Filter tool

118 Mask areas for 
selective edits
Discover how to make selective 

adjustments more accurately using Adjustment 
Brush masks

122 Make selective white 
balance adjustments
Warm up or cool down the colours 

in specific areas of a photo to remove localised 
colour casts

124 Focus attention 
on your subject
Use the Radial filter to reduce the 

impact of detail around the edges of your subject 
to make it stand out
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W
hen shooting in mixed lighting conditions it can 
be a challenge to capture an even exposure that 
features detail throughout the entire tonal range. 
In the location featured in our starting image we 

were faced with a bright sky and a patch of hill that was 
being directly illuminated by the sun. The rest of the hilly 
location was plunged into shadow. By setting the camera to 
its manual metering mode, we were able to capture detail in 
the sunlit section of the hill. It makes sense to prioritise 
capturing highlight detail because it’s harder to recover than 
under-exposed shadows. We used a narrow aperture setting 
so we could shoot in daylight with a slow shutter speed and 
turn the moving water into foam. This narrow aperture also 
contributed towards our under-exposed shadows.

Despite carefully setting up the camera, the unprocessed 
image looks disappointing. It lacks strong highlights and the 
shadows are hiding the main point of interest – the foamy 
water. However, because this is a raw file we can process it in 
Camera Raw and reveal colour and detail where it’s required. 
As the name ‘digital negative’ suggests, our DNG format 
image needs to be processed in the digital darkroom before it 
can look its best.

In traditional film darkrooms, photographers could use 
dodge and burn tools to vary the amount of light hitting 
the photo paper. This enabled them to make selective tonal 
adjustments to specific parts of high-contrast scenes. We’ll 
perform a similar technique using the versatile Camera Raw 
Adjustment Brush tool.

The power of the 
Adjustment Brush
Lighten or darken specific regions of an image 
using the Adjustment Brush tool in Camera Raw

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Open the image
Open PMZ28_adjustment in Camera Raw by double clicking 
the thumbnail in Adobe Bridge. Before making selective 

brush-based adjustments to specific tonal regions, it makes 
sense to use the tone-targeting powers of the various sliders in 
the Basic panel to fix as many problems as we can, because these 
enable you to alter large areas quickly and easily, and the image 
needs quite a bit of work.

3Recover the highlights
We can see from the healthy spread of tones in the Histogram 
that the brightened highlights aren’t technically clipped, but 

some of the colour and details are now missing from the sky. By 
dragging the Highlights slider left to -80 we can claw back missing 
detail and colour in the sky without darkening the newly revealed 
shadow details in the landscape. Pull Whites down to -40 to gently 
darken the brightest pixels in the picture.

2Boost the exposure
Normally, we might start processing a picture by fixing any 
colour balance problems, but because the image is under-

exposed we can’t clearly see the colours in the shaded areas. So with 
this type of under-exposed image, we’ll start by making a global tonal 
adjustment and drag the Exposure slider right to +1.40. This operation 
reveals more shadow detail, but it blows out detail in the highlights of 
the sky and the sunlit section on the hill.

4Lighten the shadows
Lighten the darkest shadows by dragging Blacks to +50. Press 
Q to cycle between the before-and-after versions of the raw 

file. Our selective tone-tweaking sliders have improved the shot 
as best they can. We can see more detail in the shadows and we’ve 
persevered most of the highlights. However, the sky and the water 
lack contrast and look flat. We can use the Adjustment Brush to 
selectively adjust the contrast in these areas.
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5Set up the adjustment properties
Press Q until only the edited version of the image is visible. 
Grab the Adjustment Brush from the toolbar (or press K 

to summon it). The Adjustment Brush panel will appear. Click to 
place a pin on the shaded hill. We’re going to selectively lighten 
the shaded areas, so set the Exposure slider to +1.20. To produce 
a stronger contrast, set Contrast to +74 and Clarity to +57. Push 
Sharpness to +21.

7Non-destructive editing
The Adjustment Brush is a non-destructive tool, so we can click 
a particular pin to access its slider settings and fine-tune them. 

The water is a little too bright, so drag Exposure down to +0.95 and 
reduce Highlights to -22. To bring out fine textures in the sky, click 
the New button (or press N). Click to place a pin on the sky. At this 
stage it will use the previous slider settings, so we’ll need to change 
them to more suitable ones.

6Reveal more shadow detail
To control the spread of the localised brush-based adjustment, 
set Size to 12. Create a soft edge to help blend the edited areas 

with their un-edited neighbours by choosing a Feather of 80. Paint 
over the shaded hill and river to lighten these areas and boost their 
contrast. Be careful not to paint on the sunlit section of hill or you’ll 
over-expose it. We now have a more evenly balanced exposure, and we 
can see more detail in the shadows.

8Enhance the sky
Set the new pin’s Exposure to +0.50, Contrast to +0.74 and 
Highlights to -43. To darken some of the greyer clouds set 

Shadows to -35. Tease out more fine midtone texture and detail 
in the clouds by setting Clarity to +57. Give the weak blues more 
impact by setting Saturation to +45. You can use the same Size 
settings to cover large areas quickly. Paint over the sky to selectively 
reveal more texture and detail. 
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O
n a bright day your camera can struggle to capture 
detail in contrasting lighting conditions. You could 
pop a neutral density filter over the lens to limit 
the amount of light hitting the sensor at the top of 

the frame. This physical filter enables you to set the camera’s 
aperture and shutter speed to reveal darker details in the lower 
section of the frame without over-exposing the brighter sky 
detail near the top. If you don’t have an ND filter, you can 
recreate the effects of one in Camera raw, courtesy of the 
Graduated Filter tool. In many shots you’ll see an overcast sky 
that appears to contain little detail. If you drag the Exposure 

to the left you’ll notice that there’s more cloud texture and 
colour hidden in the raw file’s sky. However, this global 
exposure adjustment will plunge your correctly exposed 
landscape into darkness. The Graduated Filter tool enables 
you to drop the exposure value at the top of the frame by a 
desired f-stop or two. It gradually reduces the strength of the 
exposure adjustment so that the brighter areas in the sky 
blend seamlessly with the correctly exposed landscape. As you 
can apply multiple Graduated Filters to the image, you can also 
selectively adjust blown-out sky reflections in the lower part 
of the frame, as you’ll see in our walkthrough.

Enhance 
plain-looking skies
Fix dull-looking over-exposed skies by applying a gradated 
tonal adjustment using the Graduated Filter tool

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2   Make exposure adjustments
Drag the Exposure slider to -1.60. By dropping the 
Exposure, you reveal a hint of sky detail, but the 

land is still looking too dark. Reveal more detail in the 
land by dragging the Shadows slider to +53. The trees now 
look better exposed.

1 Warm it up
Open PMZ_graduated. Before making gradated 
adjustments to reveal sky detail, lets get the over-

exposed darker terrain looking its best using the Basic panel 
sliders. The gradated sky adjustments will then blend with 
the correctly exposed land. Drag Temperature to 5800.

4 Boost the colours
Our starting image’s colours look drab, but there are 
colours hiding in the raw file that we can reveal. Boost 

Vibrance up to +47 to enhance the natural blues and greens. 
Increase Saturation to +27 to perform a global colour boost. 
The stronger saturation reveals extra textures.

3 Adjust the Clarity
To make the darker trees stand out more effectively 
against the lighter mountain, drag Clarity right to +33. 

This gentle midtone contrast adjustment makes the trees 
slightly darker so they pop out in contrast. It also gives the 
fine cloud textures more impact.

6Fix the reflection
Set Clarity to 40 to tease out cloud detail. Click the 
New button in the Graduated Filter panel. Draw a 

second gradient from the bottom of the frame to the horizon. 
Set Exposure to -1.5 to get a balanced reflection. Boost 
Saturation to +20 to reveal more cloud colour. 

5 Draw a gradient
Grab the Graduated Filter from the toolbar. In the 
Graduated Filter panel, set Exposure to -1.30. Drag 

from the top of the frame down to the horizon to draw a 
gradient. The exposure adjustment will be strongest near the 
top green line, and will gradually drop to 0 by the red line.
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GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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T  here are many ways to make selective 
adjustments in Camera Raw. Sliders such as 
Shadow or Highlight enable you to target and 
tweak similar tones in every part of the image at 

once. The Vibrance slider performs selective colour 
enhancements. It can boost the saturation of weaker colours 
without over-saturating stronger ones (and avoid causing 
skin tones to become too warm and orange). The White 
Balance tool finds and removes colour casts with a click. 
All these tools have their own unique selective adjustment 
role, and working together they can dramatically improve 
the colours and tones in a raw file.

The Adjustment Brush is arguably the most versatile 
selective adjustment tool in Camera Raw. Thank to the 
Adjustment Brush panel, you can change the properties that 

it selectively adjusts. We’ll show you how to use a negative 
Clarity value to create a smoother skin complexion, and 
then use the same tool to enhance lips. Unlike sliders such 
as Shadow or Highlights, the Adjustment Brush can be 
modified to edit other properties, such as the colours, tones 
and clarity of specific regions.

To help restrict the Adjustment Brush’s influence to 
particular pixels, you can use masking. Masks appear as 
a colour overlay to help you identify precisely which 
areas are being adjusted. You can then use the mask to 
fine-tune the spread of the adjustment. Thanks to the 
Auto Mask option, you can stop the Adjustment Brush 
tip from straying over a contrasting edge, which enables 
you to quickly smooth skin without accidentally blurring 
important facial features such as an eye.

Mask areas for 
selective edits
Discover how to make selective adjustments more 
accurately using Adjustment Brush masks
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1Analyse the problems
Open PMZ5_masking in Camera Raw. Before we selectively 
smooth the model’s skin and whiten her eyes with the 

Adjustment Brush, let’s make some more global adjustments to 
correct overall colour and tone. The photo has a warm, greenish tint 
that doesn’t flatter the subject. From the peaking graph at the right 
of the Histogram, we can see that the highlights are too bright. The 
image lacks strong shadows on the left of the graph.

3Correct the exposure
As the photo is a little over-exposed, drop the Exposure slider 
to -0.15. Reduce Highlights to -21. For more contrast, drop 

the Blacks slider to -17. The Histogram now shows a wider spread 
of tones. If you click the Before and After view you’ll see that the 
colours in the edited version now look more natural compared with 
the unprocessed original. We’re now ready to make more selective 
adjustments to improve the subject’s complexion.

2Correct the colours
Before adjusting any tone-related sliders, lets remove the 
slight colour cast and create healthier looking skin tones. 

Grab the White Balance tool. Click an area that should be white 
(such as the whites of the model’s eyes). This will adjust the 
Temperature and Tint sliders to create a neutral white in the 
sampled area, creating tint-free colours in the rest of the image 
at the same time.

4Set up the Adjustment Brush
Go back to Single View. Zoom in to 33% for a closer look at 
the subject’s skin. Grab the Adjustment Brush (or press K 

to summon it). In the Adjustment Brush panel, set Clarity to -58. 
Boost Saturation to +15 to add more colour to the model’s cheeks. 
Untick the Auto Mask box. Click to place a pin on her cheek. Paint 
over the cheek to smooth the pores. Avoid painting over important 
details such as the eyes.



Teach yourself Raw in Photoshop
SELECTIVE ADJUSTMENTS

121

5Modify the mask
In the Adjustment Brush panel, tick the Show Mask box. 
A translucent white patch will appear, indicating which areas 

you have adjusted. This white mask has a soft edge, so it could easily 
stray into other areas such as the model’s hair, which you want to 
remain as sharp as possible. Tick the Erase button and paint over 
areas that you don’t want to smooth. The mask will change shape to 
show the newly adjusted areas.

7Use Auto Mask
To make the Adjustment Brush’s mask more sensitive to 
changes in contrast, tick the Auto Mask box. Click the pin 

you placed earlier. Continue painting over the skin. Click the Add 
button at the top of the Adjustment Brush panel. As you paint, the 
brush will recognise contrasting edge details such as the lips and 
eyes and avoid softening them. The more intelligent mask will have 
a sharper edge to it.

6Change the mask colour
The default white mask colour can be hard to spot if you’re 
working on white areas such as eyes. Click the Color Swatch 

next to Show Mask. Choose a contrasting colour from the Color 
Picker. We chose this luminous green. Click OK. You can change the 
mask Opacity to make it more noticeable, but it helps to see some of 
the original details through the mask, so leave this Opacity slider at 
its default setting.

8Enhance the lips
To see the smoothing affect of the Adjustment Brush 
on the skin, untick Show Mask. Click the New button. 

Boost the Saturation slider to +35. Push Temperature and Tint 
to a warmer +25. Set Clarity to -10. Paint on the model’s lips 
to give them more impact. The Auto Mask option will stop 
adjacent areas such as the model’s teeth from being altered by 
this selective adjustment. 



Teach yourself Raw in Photoshop
SELECTIVE ADJUSTMENTS

122

N
ormally, white balance problems are easy to fix. 
If a shot suffers from a cold blue (or warm orange) 
colour cast, then you can drag the Basic panel’s 
Temperature slider to counteract the tint by 

warming up the image or cooling it down until the colours 
look more natural. If the scene is cloudy or sunny then you 
can experiment with various White Balance presets to remove 
blue or orange colour casts.

However, in our supplied starting image we have a scene 
featuring contrasting colours and lighting conditions. The 
orange sunset contrasts with the cold blue sea. Due to the 

mix of clear sky and clouds, some of the ocean’s colours are 
neutral, and don’t suffer from the blue colour cast that’s 
noticeable in the shaded foreground. If we warm up the 
photo’s colour temperature to remove the foreground blues, 
then the correct colours in the more distant part of the ocean 
will look too warm. In this walkthrough we’ll show you how 
to use the Color Sampler tool to help identify areas of the 
image that are suffering from colour casts, and which areas 
that are tint-free. You’ll then know which areas to selectively 
warm up and cool down. To make the selective white balance 
adjustments we’ll use the Graduated and Radial Filters.

Selective white 
balance editing
Warm up or cool down the colours in specific areas 
of a photo to remove localised colour casts

BEFORE
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2  Sample a colder spot
Click to sample a colder blue part of the ocean in the 
foreground. This creates sample number 2. In our 

example we’ve sampled an area with RGB values of 107, 131 
and 153. The numbers are much farther apart, indicating that 
this second sampled area has a colour cast.

1 Take a neutral sample
Open PMZ93_selectiveWB. Grab the Color Sampler tool 
from the toolbar. Click the cursor on a section of sea 

that looks close to a neutral white. We’ve sampled an area 
that has RGB values of 152, 157 and 154. If the area was totally 
tint-free then the RGB values would be identical.

4 Analyse the RGB values
Although sample 2’s RGB values are now balanced and 
tint-free, sample 1’s values are wider apart at 175, 157, 

and 139. This indicates the presence of a colour cast in our 
previously neutral area. We need to selectively warm up the 
cold foreground without making the ocean look too orange.

3 Adjust the temperature
Grab the White Balance tool. Click the colder sample 
2 icon. This tool will sample the RGB values, work 

out that there’s a colour cast and then adjust the values so 
that they are equal. This creates a tint-free colour in similar 
shaded sections of the sea.

6Add a radial gradient
To selectively colour correct smaller sections such as 
the cold blue patch of sea on the right, grab the Radial 

Filter. In the Radial Filter panel, tick the Inside button. Draw 
an ellipse. Push Feather to 68. Tweak the Temperature values 
to create a neutral colour inside the ellipse. 

5 Draw a linear gradient
Set the White Balance drop-down menu to As 
Shot. Grab the Graduated Filter. Drag a diagonal 

line from the bottom left towards the middle of the frame. 
Drag the green start point to create a narrower gradient. Set 
Temperature to +59 and Tint to +16.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Fine-tune the shape and size
If you decide to use the Crop tool to remove some of 
the empty space around the subject, you’ll need to 

reposition and resize the Radial Filter to suit the new compo-
sition. The alternative Post Crop Vignette will automatically 
reapply the vignette to the recomposed image. 

3Modify the effect
To create cool vignetted edges that contrast with the 
warm subject, drop the Temperature slider to -50. 

Push Highlights up to +64 to help over-expose the highlights 
in the vignetted area. To reduce distracting detail outside the 
Radial Filter’s ellipse, drop the Clarity slider to -100.

2Draw an ellipse
In the Radial Filter panel, set Exposure to +1.40 to 
lighten the edges. To make the Radial Filter alter 

details outside the ellipse, tick the Outside button at the 
bottom of the panel. Draw an elliptical shape that centres on 
the woman. Drag the filter’s control points to refine its shape.

1Correct the colour and tone
Open PMZ30_radial. Set the White Balance drop-down 
menu to Auto to quickly cool down the orange colour 

cast and create more natural-looking skin tones. The shot is 
a little lacking in shadows so set Exposure to -30, Contrast 
to +27 and Blacks to -28. Grab the Radial Filter.

I
n Camera Raw you can deliberately darken (or 
lighten) the edges of your images. By adding 
vignette effects you can reduce the impact of 
details around the edges of the frame and draw 

attention to the central subject. If your main subject is 
framed in the centre of the photo, then you can use the 
Effects panel’s Post Crop Vignette sliders to lighten or darken 
the image’s edges. If the subject is off-centre then the Radial 
Filter can be used to produce a similar but off-set vignette 

effect. Unlike the Post Crop Vignette tool, the Radial Filter 
enables you to edit extra properties such as colour 
temperature, so you can create cooler edges that contrast 
with the subject’s warmer palette.

In this tutorial we’ll demonstrate how to use the Radial 
Filter to brighten the edges in a way that complements 
the photo’s sunny location, creating an abstract high-key 
background that helps to focus attention on the correctly 
exposed woman in the lower part of the frame.

Focus attention
Use the Radial filter to reduce the impact of detail around 
the edges of your subjects to make them stand out

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Get the look
Discover how to transform your photos using 
Camera Raw’s creative image-processing tools

128 Convert your photos 
to black and white
Create stunning black-and-white 

pictures using the Grayscale Mix panel to lighten 
or darken specific colours

132 Split-tone your 
mono images
Add separate washes of colour 

to the highlights and shadows of a monochrome 
conversion to replicate the split-tone effect

134 Reveal fine detail 
using Clarity
Discover how to boost midtone 

contrast and give distant details in landscape 
images more impact

136 Create a 32-bit 
HDR image
Combine three differently exposed 

photos of the same scene to create a composite 
with a high dynamic range

140 Replicate the 
infrared effect
Create stunning pictures by 

mimicking the distinctive colours and tones 
produced by shooting on infrared film
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2Convert to grayscale
Boost the Vibrance slider to +35 to reveal more colours 
in the shadows. Click the HSL/Grayscale panel and tick 

the Convert to Grayscale box. This gives us a black-and-white 
version of the correctly exposed image. Click Auto to make 
the colour sliders lighten or darken particular areas.

1 Tweak the tones
Before converting an image to monochrome you’ll need 
to create a well-exposed shot and tease out the colour 

information so that you can use it to lighten or darken areas 
later on. Open PMZ48_mono. Drag Shadows to +70. Set 
Clarity to +30 for more midtone contrast.

n pre-digital days photographers would shoot 
with black-and-white film. By placing 
coloured filters over the lens they could lighten 
or darken greyscale tones in the captured 

image based on the original colours. For example, a red 
filter would darken blue skies, enabling white clouds to 
stand out more clearly in contrast.

You could create a black-and-white version of a scene 
in Camera Raw by dragging the Basic panel’s Saturation 
slider down to 0. Although this technique would remove 
all of the colour information, you’d probably end up with 
an indistinct wash of greyscale tones. Camera Raw enables 
you to mimic the traditional colour filter technique so that 
you can lighten or darken specific colours.

We’ll demonstrate how to use the Convert to Grayscale 
panel to remove the distracting colour information, and 
then adjust the colour sliders to lighten or darken specific 
regions in the scene. This technique enables you to 
produce mono conversions that draw attention to specific 
shapes and textures in a photo.

Convert your 
photos to mono
Create stunning black-and-white pictures using the 
Grayscale Mix panel to lighten or darken specific colours

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

BEFOREI
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4Target an adjustment
If you’re not sure what colour to tweak, grab the 
Targeted Adjustment tool. Click the water and drag 

upwards to lighten any colours in the sampled area. This 
brightens the Blues and helps make the water in the mono 
conversion stand out in contrast against the darker rocks.

3Lighten the yellows
Click default to reset the sliders to 0. We can manually 
adjust the sliders to lighten specify areas and create 

more contrast where it’s needed. There’s lots of vegetation in 
the scene, and this tends to contain yellow. Drag the Yellow 
slider right to lighten any vegetation and reveal its texture.
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By experimenting with the Convert to Grayscale panel’s 
coloured sliders you can produce a range of different 
looking monochrome prints from a single shot. This 
enables you to draw attention to various areas in the 
image and decide which look you prefer. These sliders 
work best with shots that have lots of different colours 
to play with, such as the colourful car in the image 
below. Here the Grayscale Mix sliders are set to the 

default of 0, so the conversion lacks contrast [1]. 
By clicking Auto, the results aren’t much different 
[2]. By manually increasing the Yellows to +68 and 
the Greens to +69 you can lighten the vegetation and 
make the darker car stand out more effectively [3]. You 
can create an even more striking contrast by selectively 
darkening the car’s paintwork  [4]. To do so, set the 
Oranges slider to -38 and the Reds to -71. 

1

3

2

4

Want to know more?
NOW TRY THIS…
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4Fine-tune the results 
Set the Shadows Hue to a cooler 224 to create a 
contrasting wash of blue. Set Balance to -52 to tint a 

wider range of shadows and midtones. You can then play with 
different saturation values until you achieve the desired split-
tone look. Finish off by adding a post-crop vignette. 

3Tint the tones
Crop the image using a 1:1 ratio. Click the Split 
Toning panel’s tab. Boost the saturation of the 

Shadows and Highlights to 20. By default both the shadows 
and highlights will be tinted red. Set the Highlights Hue to 
60 for a wash of sepia.

2Convert to monochrome
Click the HSL/Grayscale panel. Tick the Convert to 
Grayscale box. Click Auto to let Camera Raw produce 

a mono conversion based on the colours in the original shot. 
To create more contrast between the goat’s darker fur and its 
white markings, drag the Orange slider left to -46.

1Correct the exposure
Open PMZ58_split tone. The unprocessed image is very 
under-exposed, so boost the Exposure slider to 2.25 to 

reveal more detail and create a healthier spread of tones in the 
Histogram. Boost Highlights to +84 and Whites to +42. Push 
Clarity to +55 to reveal fine hair detail.

traditional way of creating an eye-catching scene 
is to remove the photograph’s original colour 
information. This helps the eye focus on tonally 
contrasting shapes and textures in the scene 

instead of being distracted by colour. You can enhance your 
monochrome conversions by gently reintroducing fine washes 
of colour to the greyscale image’s shadows and highlights. 
A hint of colour can make a monochrome shot look more 
interesting. The split-toning effect also helps change the 

mood evoked by the image. In the split-toned image on the 
right, the goat’s shadows feature a cool blue tint while the 
lighter highlights of the animal’s fur are tinted with a warmer 
wash of sepia. These contrasting cool and warm colours help 
tease out the different textures in the image.

Before adding a split-toned look to your image, you’ll 
need to make sure that there’s enough contrast between the 
shadows and highlights to add colours to, so we’ll kick off by 
adjusting the image using the Basic panel.

Split-tone  
your images
Add separate washes of colour to the highlights and shadows 
of a monochrome conversion to replicate the split-tone effect

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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2 Increase Clarity
Our histogram now has tones stretching from the 
shadows on the left to the highlights on the right. 

This indicates that the picture is now better exposed. By 
increasing the Clarity slider to +80, we increase midtone 
contrast and make fine textures and details pop out.

1Adjust the exposure
Open PMZ99_clarity in Camera Raw. We can see from 
the histogram that the image lacks strong highlight 

information, so it’s under-exposed. Drag Exposure to +0.40 
to brighten everything up. Boost the Highlights to +89 to 
selectively brighten them.

hen shooting a landscape, water particles in the 
air can cause details to become diffused. Closer 
objects will have a stronger contrast because 
there’s less moisture between them and your 

camera, while more distant objects may lack contrast. The 
most distant hills in our starting image nearly disappear 
into the clouds due to their washed-out midtones. If we 
boost the Camera Raw Contrast slider to try to darken 
the distant hills then we’d risk making the already darker 
foreground shadows under-exposed while blowing out the 
brighter highlights in the sky.

You can target and tweak the washed-out midtones in 
the distant mountains without altering the photo’s darker 
shadows and brighter highlights, courtesy of the Clarity 
slider. This enables us to selectively increase the midtone 
contrast and counteract the effects of the diffuse lighting 
in the most distant parts of the background. As a bonus, 
the Clarity slider also increases the midtone contrast in 
other areas, which helps fine textures stand out more 
effectively in our starting image’s rocks and water. 
You can also make brush-based Clarity adjustments 
to target areas with more precision.

Reveal fine detail 
using Clarity
Discover how to boost midtone contrast and give 
distant details in landscape images more impact

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

BEFOREW



Teach yourself Raw in Photoshop
GET THE LOOK

135

4Apply selective adjustments   
In the Adjustment Brush panel, set Exposure to -0.15, 
Contrast to +54 and Clarity to +100. Click to place a 

pin on the distant hill and paint to selectively boost the 
midtone contrast. Click the Zoom tool to exit the Adjustment 
Brush panel. Boost Vibrance to +45. 

3Select the Adjustment Brush
The increased Clarity setting creates more contrast 
between the white foam and the green sea, but the 

distant hills still look a bit washed out. To make a localised 
Clarity adjustment that gives the hills more impact, grab the 
Adjustment Brush from the Camera Raw toolbar.
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our camera can be set to reveal detail in shaded 
areas, but this can cause lighter sections of the 
scene to become over-exposed and lack detail. 
If you meter to capture highlight detail, then the 

shadows may become clipped and print out as pure black. 
You could try revealing missing tonal detail using the Basic 
panel’s Shadows and Highlights sliders, but there may still 
not be enough information available in the darkest or lightest 
parts of the image. Alternatively, you could try processing a 
raw file twice to create versions of the scene that show detail 
in the shadows and the highlights. You could then blend the 
correctly exposed areas of the two together using layer masks.

However, to capture the widest range of tones you can set 
your camera to shoot three bracketed exposures. One shot 

will capture shadow detail (although its highlights will be 
over-exposed), one will meter for the midtones, and the 
third will look under-exposed, but will contain all the 
location’s highlight information. These separate exposures 
will ensure that you have access to detail throughout a 
scene’s tonal range.

In this walkthrough we’ll show you how to combine your 
bracketed raw exposures together to create a single composite 
image with a high dynamic range. This means that more 
tonal detail will be visible in the composite shot’s shadows 
and highlights. We’ll show you a workflow that enables you 
to convert your raw source files into a 32-bit composite 
that can be processed in Camera Raw, after a detour through 
Photoshop’s Merge to HDR Pro command.

Create a 32-bit 
HDR image
Combine three differently exposed photos of the same 
scene to create a composite with a high dynamic range

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Merge to HDR Pro
Browse to the three bracketed starting images in Bridge. Shift 
click to select the three thumbnails. Go to the menu bar and 

choose Tools>Photoshop>Merge to HDR Pro. This will open the three 
images in Photoshop and place them into the same document to align 
their contents. By aligning them you’ll be able to merge the correctly 
exposed details from each shot. The images will then open in the 
Merge to HDR Pro window.

3Set the bit depth
By default the mode will be set to 16 bit. You could use the 
Merge to HDR Pro command’s sliders to mix the best bits 

from each shot together, but because the source images are raw files 
we want to squeeze more detail from them and do as much work as 
we can in Camera Raw. To do so, set the Mode drop-down menu to 
32-Bit. By default the Complete Toning in Camera Raw box will be 
ticked. Click the Tone in ACR button.

2Remove the ghosts
Your bracketed shots will be visible at the bottom of the 
Merge to HDR Pro workspace. If your scene features moving 

objects such as passing people or wind-blown trees, then you 
might notice blurred areas in the composite HDR image. To avoid 
the blur, tick the Remove ghosts box. A green box will appear 
around the least blurred shot. You can click to choose another 
image if you prefer.

4Adjust the exposure
This procedure will merge the bracketed exposures together 
into a 32-bit HDR file and open the composite image in the 

Camera Raw filter. You’re now ready to fine-tune the 32-bit image 
using the familiar Camera Raw tools and sliders to reveal detail in 
the shadows, midtones and highlights. Drag the Shadows slider to 
+80 to reveal more detail in the foreground terrain. Push Exposure 
up to +0.65.
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5Boost the colour and contrast
Press O to activate the highlight clipping warning. The red 
patches indicate that the sunset’s highlights are blown out, so 

drag Highlights down to -80 to claw back missing colour and detail. 
Drop Whites to -10 to reduce the highlight clipping even more. Increase 
Clarity to +66 to make midtone details pop out. Boost the Vibrance 
slider to +43 and the Saturation to +18 for the strong colours associated 
with HDR images.

7Open it in Photoshop
This will open the processed 32-bit HDR composite image in 
Photoshop. In the Layers panel you’ll see that the Camera Raw 

filter settings have been stored as a Smart Filter. Double click the 
Camera Raw Filter label to fine-tune any of the Camera Raw sliders or 
tools. You can save the image as a Photoshop file or a TIFF to preserve 
its 32-bit HDR quality and status. To save a JPEG version, follow the 
next step.

6Enhance the sky
To reveal even more colour and detail in the lighter sky, grab 
the Graduated Filter tool from the Camera Raw toolbar. Draw 

a gradient from the top of the image to the horizon. In the Graduated 
Filter panel, set the Exposure slider to -0.90. Boost the Clarity slider 
to tease out more fine cloud texture and detail. Push Saturation up 
to +15 to enhance the sky colour. Now that you’ve processed the raw 
composite, click OK.

8Convert it to 8 bits
The HDR composite is a 32-bit image, so many of Photoshop’s 
menu commands will be unavailable. To make your image 

more editable in Photoshop, go to the Image menu and click Mode. 
Tick the 8-Bits/Channel option. Click Merge. 32-bit images contain 
more luminance information, so you’ll need to tone map the image 
to convert it to 8 bit. Drop the Vibrance slider to -30 to make the 
colours less garish. Click OK. 
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he colours that we perceive are produced by 
different wavelengths of light. At either end of 
this visible rainbow spectrum are additional 
wavelengths that our eyes can’t see, including 

infrared light. In theory, digital cameras are capable of 
capturing infrared colours, but they wouldn’t equate to those 
that we see with the naked eye. To avoid capturing the ‘false’ 
infrared wavelength colours, manufacturers build filters into 
cameras to block the effects of infrared light.

Analogue film photographers could use a filter that stops 
the visible spectrum of light entering the lens but that 
admits light with an infrared wavelength. When infrared 
light hits infrared-sensitive film, a variety of interesting 
effects can be captured. In monochrome infrared prints the 
light bounces off trees and grass in a scene to create bright 
white vegetation. This effect enables you to reveal organic 
shapes and textures that contrast with darker, non-organic 
objects in the image. This glowing vegetation phenomenon is 
known as the Wood Effect.

By using colour infrared film, the effects are even more 
dramatic. Vegetation still looks much brighter while blue 
skies dramatically darken, making plants stand out even 
more. A blue sky can also take on a more cyan look, while 
vegetation tends to display a warmer orange hue.

In this walkthrough we’ll demonstrate how to use the 
HSL panels to target and adjust the hues and luminance 
of various colours to produce a false colour infrared look. 
We’ll also demonstrate how to recreate the Wood effect 
in a monochrome conversion.

Recreate the 
infrared effect
Create stunning pictures by mimicking the distinctive 
colours and tones produced by shooting on infrared film

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Turn the sky green
Open the PMZ10_infrared starting image in Camera Raw 
by double clicking the thumbnail in Bridge. Click the HSL/

Grayscale panel and then click the Hue tab. Drag the Blue slider to 
-48 to give the blue sky a cyan hue. Colour infrared film can make 
a sky look darker, so click the Luminance tab. Drag the Blue slider 
left to -38. You now have a darker cyan sky, which is one of the 
false colour hallmarks of colour infrared film.

3Lighten the vegetation
To create the brighter tones of vegetation captured on infrared 
film, click back on the Luminance slider. Drag the Red, Green 

and Yellow sliders up to +100 to selectively brighten plants and 
flowers featuring these colours. The vegetation looks too saturated, 
so click the Saturation tab and drag the Yellows to -38 and the Greens 
to -27. This makes the plants look less garish while preserving the 
saturation of the cyan sky.

2Adjust the colour of the plants
In colour infrared photography, organic subjects such as plants 
can take on a warmer reddish hue. Go back to the Hue tab. 

There’s a lot of yellow in the source image’s vegetation (as there is in 
almost any summer landscape image), so drag the Yellows slider left 
to -60 to add a more orange hue to the vegetation. Drag the Greens 
slider to -70 to warm up more of the plants in the scene. Set the 
Oranges slider to -50.

4Reveal distant detail
After selectively tweaking the photo’s hue, luminance and 
saturation to create false infrared colours, go to the Basic panel. 

When shooting with infrared film, you can capture more contrasting 
detail in distant mist-diffused midtones. Give the image’s midtones 
more impact by dragging the Clarity slider right to +43. Drop the 
Vibrance slider to -10 to desaturate stronger colours while preserving 
the vibrancy of weaker ones.
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5Save a snapshot
You now have a shot that features the false colour properties of 
infrared film. Before recreating a monochrome infrared Wood 

effect, lets save our colour version. Click Save Image. Set the Format 
drop-down menu to JPEG. Keep Quality at 12. Click Select Folder and 
choose a destination for your file. Click Save. Click the Snapshots 
panel. Click the Create New Snapshot icon at the bottom. Label it 
Colour Infrared.

7Lighten the vegetation
To create the luminous-looking vegetation associated with 
black-and-white infrared film, drag the Yellows and the Greens 

right to +100. There are some red leaves in the image so we can lighten 
these too by sliding Reds up to +100. Instead of using the sliders, 
you can grab the Targeted Adjustment tool from the toolbar. Click 
to sample a specific area (such as the sky). Drag down to darken the 
sampled colours, or up to lighten them.

6Create a mono conversion
We’ll now create a monochrome infrared version of our scene. 
Click the fly-out icon on the right of the Basic panel and 

choose the Camera Raw Defaults option. This will reset the image to 
its original colours and tones. Click the HSL/Grayscale panel. Tick 
the Convert to Grayscale box to access the Grayscale Mix tab. For the 
darker sky associated with monochromatic infrared film, drag the Blue 
slider left to -80.

8Save a monochrome snapshot
To give distant details more punch, go to the Basic panel and 
drag Clarity to +38. For a more striking contrast, go to the 

Tone Curve panel and click the Point tab. Set the Curve drop-down 
menu to Medium Contrast. Use the Save Image option to save a 
JPEG version of your mono infrared scene. Go to the Snapshot 
panel and create a new Mono Infrared snapshot. You can then toggle 
between the settings for either version with a click. 
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Creative 
effects
Enhance your images with special effects using 
advanced tools and techniques in Camera Raw

146 Create retro 
special effects
Give your digital images the filmic 

look by adding analogue photography artefacts 
using a host of techniques

150 Make stunning portraits 
using Camera Raw
Use a host of professional 

retouching tools and techniques to make your 
portraits perfect in Camera Raw

156 Turn a daytime scene 
into a night photo
Change the colour temperature 

and tones of a photo and add light effects to create 
a simulated nocturnal scene

160 Make creative 
adjustments to portraits
Take your portrait enhancements 

into the creative realm by subtly changing the 
lighting and colours

164 Double process a raw file 
to improve exposure
Process a raw file twice to reveal 

details in the highlights and shadows, and then 
combine the best bits of both versions
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our digital camera’s various shooting modes are 
designed to help you capture a scene’s true colours 
and display detail throughout a wide range of 
tones, while keeping artefacts such as digital noise 

to a minimum. Each shot is stored digitally, so its colours and 
tones won’t fade over time, and the image will always look 
as good as new. It therefore seems ironic to distress pristine 
digital photographs and make them look like analogue film 
prints that have faded over time, as well as producing images 
that appear to have been blighted by in-camera artefacts such 
as vignetted edges and foggy light leak patches. However, 
applying retro film artefacts in Camera Raw adds character 
to your digital shots and evokes a sense of nostalgia. In this 
walkthrough we’ll reveal how to use the Effects panel to add 

realistic clumps of analogue film grain (rather than unwanted 
dots of digital noise). This is akin to adding crackle and hiss 
to a digital sound recording to conjure up a vintage vinyl 
vibe. We’ll demonstrate how to fade colours and create 
a flatter contrast. We’ll also show you how to use the 
Adjustment Brush to mimic artefacts produced by less 
sophisticated analogue lenses, such as by blurring around 
the edges of the frame.

We’ll also demonstrate how to tinker with individual 
colour channels to create the cross-processed colours that 
are associated with old film stock and darkroom processing 
techniques. After spending time creating a retro look, we’ll 
save it as a preset, so that you can apply your analogue film 
effects to other pictures with a single click.

Create retro 
special effects
Give your digital images the filmic look by adding analogue 
photography artefacts using a host of techniques

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Cross-process the reds
Open PMZ02_retro. Click the Tone Curve panel and then 
click the Point Curve tab. Set the RGB drop-down menu to 

Red. Click to place a point in the centre of the curve at an Input 
and Output level of 128. Place a point lower down the curve with 
an input of 64 and then drag to create a lower output of 46. 
This operation adds a green hue to the shadows and magenta 
to the skin tones.

3Reduce the contrast
To reduce our digitally sourced photo’s strong range of tones, 
go to the Basic panel and increase the Shadows slider to +30. 

Lighten the Blacks to +30. Decrease the Contrast slider to -30 to 
produce more washed-out looking tones. Drag the Clarity slider to 
-15 to reduce the midtone contrast and produce a slightly softer-
looking photograph. In essence, we’re doing the opposite of what 
we would normally do to improve a photo.

2Produce filmic colours
Go to the Blue channel and place an anchor point in the 
middle of the curve line with the Input and Output levels 

at 128. Place a second point in the top half of the curve line at 
an Input of 192, and drag it down to a lower output of 154. By 
reducing the blue highlights, you add a vintage wash of yellowy 
green to the highlights. We now have a more filmic cross- 
processed colour palette.

4Over-expose the edges
Old film lenses could be less effective at exposing the 
negative with a consistent amount of light, leading to a 

change in edge exposure. To recreate this look, toggle open the 
Effects panel. In Post-Crop Vignetting, set Amount to +40. 
Set Style to Color Priority to include more of the cross-processed 
colours in the vignetted edges. Increase Midpoint to 65 to push 
the vignette towards the corners.
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5Add film grain
Double click the Zoom tool’s icon to magnify the shot to 
100%. This will help you to produce more effective-looking 

film grain. In the Effects panel, push the Amount slider up to 20 
for more noticeable grain. Set Size to 54 for larger chunks. Increase 
Roughness to 78. This mimics the more organic-looking clumps of 
film grain (instead of the sharp greyscale dots produced by high-
speed ISO digital noise).

7Add a light leak
To add a light leak effect, click the New button in the 
Adjustment Brush panel. Set Sharpness and Clarity back 

to 0. Increase the Exposure slider to 2.30. Click the Color 
swatch. Choose an orange colour with a Hue of 44 degrees and 
a Saturation of 90%. Set Density to 73. Click and paint down 
the side of the frame to create the blown-out tones and colours 
associated with fogged film.

6Blur the edges
Zoom out to Fit in View. Click the Adjustment Brush icon. 
Drag the Clarity slider left to -100. This decrease in midtone 

contrast will add a blur effect to your brush strokes. Drop Sharpness 
to -100 too. Set the brush tip size to 12. Use a Feather of 80 for a 
soft edge. Paint around the edges of the frame. Image details will 
become gently blurred, but the grain you applied in the previous 
step will remain.

8Create a preset
Once you’ve spent lots of time producing your retro look, 
it makes sense to save all the adjustments as a customised 

preset that you can apply to other shots with just a few clicks. 
Go to the Presets panel and click the New Preset icon at the 
bottom. In the New Preset window, label it Retro Preset. Leave 
all the boxes ticked. Click OK. The new preset will appear in the 
Presets panel. 
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hen processing a portrait in Camera Raw you may 
feel under more pressure to produce great-looking 
results, because you’ll want the photo’s subject 
to be pleased with your image-editing skills. 

However, there are a few factors that may conspire against 
your plans to capture a perfect portrait. For starters, your 
subject may be having a ‘bad hair day’ and it’s not until 
viewing the image at 100% that you’ll notice distracting 
fly-away hairs obscuring their features. Your model may also 
be suffering from spots, which they aren’t able to totally 
conceal with make-up. If you use a burst of flash to bring 
out the shape and form of your subject’s face then you may 
inadvertently create shiny hot spots on the skin that make 
the subject look unflatteringly sweaty.

Camera Raw has all the tools you’ll need to counteract shiny 
hotspots and remove other unsightly blemishes, as you’ll 
see in our comprehensive portrait-retouching walkthrough 
starting on the next page. We’ll also demonstrate how to set 
up and store custom Adjustment Brush tips that perform a 
range of selective enhancements, such as whitening teeth, 
teasing out fine iris details and removing unsightly veins in 
the eye whites. You can then call upon the services of these 
custom portrait-enhancing brush tips in the future and 
speed up your retouching workflow on other portraits. 
We’ll also show you how to create a smoother, more youthful 
complexion by selectively adjusting the Clarity of the skin 
and creating healthier, more natural-looking skin tones with 
help from the White Balance tool.

Retouch portraits 
like a professional
Use a host of retouching tools and techniques 
to make your portraits perfect in Camera Raw

BEFORE

W
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1 Improve the composition
Open PMZ51_portrait in Camera Raw. When shooting models 
it can be a challenge to capture a well-framed composition. The 

subject in this portrait looks off-balance as she’s leaning left, but 
looking right. There’s lots of empty space to her left too. It’s good 
practice to improve the composition first before you start fixing other 
problems. This saves you wasting time editing an area that will be 
cropped out later.

3Tweak the tones
Click another tool (such as the Zoom tool) to apply the crop 
and rotate the image. As well as straightening her up and 

repositioning her, the subject now looks more prominent in the frame. 
Her highlights are a little blown-out and lack detail, however, so 
go to the Basic panel and drop the Exposure a little to -40. Pull the 
Highlights slider down to -12. This restores more colour and detail in 
the brighter parts of the portrait.

2Rotate and reposition
Hold the mouse down on the Crop tool icon and choose 1:1. 
This will create a square crop. Drag to crop out some of the 

empty space around the subject. Drag just outside of the crop overlay 
to rotate it. This will counteract the subject’s lean and straighten 
her up once we apply the crop. Drag inside the overlay to create 
space on the right of the frame for the subject to look into, which is 
conventional practice in portrait composition.

4Balance the whites
Our subject looks a little warm due to an incorrect or 
ineffective white-balance setting in-camera. This makes 

her skin tones look too orange. You could experiment by applying 
different White Balance presets in the Basic panel, but for more 
healthy skin tones grab the White Balance tool and click her eye 
whites. This cools down the warm tint in an instant and creates a 
custom temperature of 4650 degrees.
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5Set up the Adjustment Brush
Use the Zoom tool to magnify the shot to 100% so you 
can work more effectively on the subject’s eyes. Grab the 

Adjustment Brush tool from the toolbar. The Basic panel will be 
replaced with the Adjustment Brush panel. Click to place a pin on the 
white of an eye. Drop Saturation to -53 to reduce the impact of veins. 
Push Exposure up to +0.25 and increase Highlights to +16 to brighten 
the whites. Set Size to 3 and Feather to 67.

7Refine the mask
The mask will reveal which areas are being brightened and 
desaturated as coloured patches. Auto Mask should protect 

neighbouring regions from being adjusted, but if the brush has strayed 
outside the eye whites or teeth, tick the Erase button. Paint over any 
masked areas to stop them from being adjusted. You can also click the 
Add button and paint to include areas of eye whites or teeth that you 
may have missed.

6Whiten the eyes and teeth
To lighten and desaturate the eye whites without altering the 
iris, tick the Auto Mask box. This helps restrict the Adjustment 

Brush’s behaviour to alter just the sampled eye whites. Paint over the 
whites of both eyes to lighten and desaturate them. Paint over the 
teeth to whiten them and remove any staining. To see precisely which 
areas are being adjusted, tick Show Mask. Chose a contrasting mask 
colour from the adjacent swatch.

8Fine-tune the adjustment
Once you’ve tidied up the mask, untick the Show Mask box 
so that you can see the edited tones more clearly. When 

retouching a portrait, it’s easy to go too far and create glowing white 
eyes. To tweak the results produced by a particular pin, simply click 
the pin to target it. The sliders in the Adjustment Brush panel will 
change to the values attached to the pin. In this case, push Exposure 
up to +0.35 for slightly brighter eye whites.
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9 Save a preset
Once you’ve spent time tweaking the Adjustment Brush’s 
sliders to produce a specific result (such as whitening eyes and 

teeth), you can save it as an easy-to-access preset. Click the little fly-
out icon at the top right of the Adjustment Brush panel. Choose New 
Local Correction Settings. Label the preset as Brighten whites and 
remove stains. Click OK. You can access this preset from the fly-out 
icon at any time.

11 Save an iris preset
To help tease out fine midtone textures in the iris, 
set Clarity to +35. To bring out more of the iris’s blue 

colouring, drag the Temperature slider to -18. Boost the Saturation 
slider to +15. Now that you’ve set up the iris-enhancing brush 
tip, save it by clicking the fly-out icon and creating a New Local 
Connection preset called Iris Enhance. Click OK. Paint over the 
subject’s other iris to create a matching pair.

10 Enhance the irises
The eyes are the first thing that people notice, so it’s worth 
enhancing the subject’s irises to give them more impact. 

With the Adjustment Brush still active, click the New icon in the 
Adjustment Brush panel. Click to place a pin on an iris. Paint with a 
small brush over the iris. If you keep Auto Mask ticked, the tip won’t 
stray past the contrasting edge of the iris. Set Exposure to +0.45 and 
Contrast to +30. Boost Highlights to +26.

12 Discover spots
Select the Spot Removal tool from the toolbar. The 
Spot Removal panel will appear. Set Size to 3. Set the 

Type drop-down menu to Heal. This will help to create a seamless 
skin graft when you transfer clean skin over an unwanted spot. To 
discover spots more easily, tick the Visualize Spots box. Adjust the 
slider to get a greyscale preview of potential spots. Contrasting spots 
will stand out in white.
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13Remove the spots
Click to place the cursor over a potential spot. A circular 
red overlay will appear over the spot. A connected green 

overlay will sample adjacent clean skin and place the sampled pixels 
inside the red overlay to hide the spot. Drag inside an overlay to 
reposition it. Drag the edge of an overlay to resize it. The white spots 
in the Visualize Spots preview should be replaced by black, which 
means they’ve been eradicated.

15Resample a source
When you click (or paint an irregular shape) to place 
a spot-removal overlay on a spot or hair, the Spot 

Removal tool will automatically attempt to choose a clean patch 
of pixels that have a similar colour and tone to the areas around 
the unwanted object. If it samples an area that isn’t suitable, 
try pressing the / key. This will cause the green overlay to 
automatically sample a new area.

14Remove unwanted hairs
In older versions of Camera Raw, you could only create 
circular shapes when removing spots. From Camera Raw 

8.4.1 onwards, you can paint over non-circular shapes to retouch 
the image. Our subject has stray hairs hanging over her brow. Paint 
irregularly shaped strokes over these hairs to replace them with 
adjacent patches of clean skin. Tidy some of the fly-away hairs 
around the edges of the hair.

16 Smooth the skin
Grab the Adjustment Brush once again. The New 
button will automatically be ticked in the Adjustment 

Brush panel. Zero the sliders apart from Clarity, which you 
should set to -51. Drop Contrast to -15. Untick Auto Mask so 
that you can smooth out contrasting shiny hot spots as well as 
the midtones of skin pores. Paint over the subject’s face for a 
more flattering complexion. 
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S  hooting a location at night can produce a photo 
with a moody and atmospheric look, but it also 
raises practical challenges in relation to your 
camera settings. You could open the lens’s 

aperture to let in more light, but that will result in a shallow 
depth of field that creates background or foreground blur. 
By bumping up the ISO speed you can shoot handheld with 
a faster shutter speed, but that could add unwanted and 
distracting chroma and luminance noise to your photo. If you 
have access to a tripod, you could use a lower ISO setting, 
a slower shutter speed and a narrower aperture to get more 
detail in focus, but that approach is more time-consuming 
and it might limit your compositional choices.

By using the Camera Raw colour- and tone-adjusting tools 
to fake a nocturnal look, you can capture any location during 

the day without having to lug a tripod around. This frees 
you up to capture spontaneous events with a wider choice 
of composition. In daylight it’s also much easier to capture 
a shot with both the foreground and background detail in 
focus. It’s also a fun project!

In this walkthrough we’ll show you how to produce 
a cooler, bluer colour temperature, which helps evoke a 
nocturnal light source such as the moon’s sunlight-reflecting 
surface. To help sell the nocturnal illusion, we’ll show you 
how to add a computer-generated moon using the Radial 
filter, and then duplicate and modify the filter to add a 
contrasting lunar corona. You’ll use the Adjustment Brush 
to add the moon’s reflection to the water. You’ll also make 
atmospheric shadows close in around the edges of the frame, 
courtesy of the Camera Raw Effects panel.

Turn day 
into night
Change the colour temperature and tones of a photo and 
add light effects to create a simulated nocturnal scene

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Cool down the colour
Open PMZ35_night in Camera Raw. Go to the Basic panel. 
Our starting image has a colour temperature of 750, which 

adds a warm hue to the scene. Drag the Temperature slider left to 
a cooler value of 5400 degrees K (or you might find it quicker to 
double click the Temperature field and type in the precise value). 
Already the image is taking on a nocturnal look, just with 
a simple temperature change.

3Desaturate the colour
Our cold blue colours look a little too saturated and garish 
(and may not print very well). For a more subtle blue cast, go 

down to the lowest section of the Basic panel and reduce the Vibrance 
slider to a value of -25. Drop the Saturation slider to -16. This should 
help to create a weaker wash of blue and mimic the effect of sunlight 
being reflected from the moon. You may need to tweak the settings 
further depending on your own monitor.

2Darken the shadows
The direct sunlight in our daytime-sourced starting image is 
too intense for our purposes. To reduce the brightness and 

evoke a weaker lunar light source, drag the Exposure slider left to 
a value of -0.70. Boost Contrast to +21. Set Highlights to -30. For 
darker shadows, drag Blacks to -45. Set Clarity to +35. Go to the 
Tone Curve panel’s Point Curve tab and set the Curve drop-down 
menu to Medium Contrast.

4Vignette the edges
To create a more atmospheric-looking nocturnal scene, you 
can make the shadows appear to close in around the edges 

of the frame. To do so, toggle open the Effects panel. Go to Post 
Crop Vignetting. Set the Style drop-down menu to Color Priority 
to darken the edge colours in a more natural way instead of simply 
tinting them with black. Set the Amount slider to -17 to add the 
moody vignette effect.
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5Add the moon
To add a convincing lunar light source, go to the toolbar and grab 
the Radial Filter. Set Exposure to 4 for a bright light source. Drop 

Feather to 11 for a relatively hard edge. Hold down Shift to constrain 
the shape to a circle, and drag to draw the moon. The apparent size of 
the moon varies naturally, so don’t worry about getting the size exactly 
right. You can reposition the moon to stop it overlapping the clouds by 
dragging the green pin at its centre.

7Create the reflection
Grab the Adjustment Brush from the Camera Raw toolbar. Set 
Temperature to a cool -45. Set Exposure to +1.20. Set Highlights 

to +47 to brighten the patches of blurred, foamy water. Drop Saturation 
to -35. Set Size to 12. Choose a soft edge by setting Feather to 80. 
Finally, set Density to 73. Paint over the sea to add a hint of the moon’s 
reflection in the water. Ensure the centre of the reflection lines up with 
the centre of the moon, or the effect will fail.

6Add the corona
Right click the Radial Filter’s pin and choose Duplicate 
from the context-sensitive pop-up menu. Hold down Shift 

and drag an edge control point to increase the duplicated Radial 
filter’s size. Drop Exposure to a weaker +1.65. Set Feather to 44 for 
softer edges. Increase Highlights to +26 to lighten the overlapping 
clouds. Increase Temperature to +95 for a warmer lunar corona that 
contrasts with the cool blue sky.

8Add the stars
You can fine-tune the position of the Adjustment Brush’s 
reflection by dragging its pin. You can click either pin and 

tweak any of the associated sliders to refine the effect that they 
produce. Finish off by grabbing the Radial Filter. Zoom in to 100% 
magnification. Shift drag to add a few tiny stars. Untick the Show 
Overlay box so you can see the stars more clearly as you draw. Resist 
the temptation to make too many! 
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BEFORE

W
hen we process a portrait in Camera Raw we 
attempt to edit its colours and tones to overcome 
problems with exposure or colour balance, so that 
the subject in the photo looks like they did in the 

studio. We may retouch the image to tidy away temporary 
problems, such as spots on the skin or stray fly-away hairs 
that went unnoticed during the shoot. This subtle 
retouching helps us get the subject to look their best. 
When posing for a portrait, the subject may experiment 
with different looks by the way that she applies make-up 
or styles her hair, for example. As photographers we can also 
experiment with different looks and moods by the way we 
light the scene.

In this tutorial we’ll demonstrate how you can continue 
to experiment with different looks after a portrait has been 
captured, thanks to the Camera Raw tool set. The model in 
our starting image has already bleached her hair blond, but 
she may want to see how she looks as a brunette. We could 
try to tint the blonde hair a different colour by using the 
HSL tab, but because the skin tones also contain yellows 
we’d end up tinting her face as well as her hair.

We’ll show you how to use the Adjustment Brush to 
digitally dye her blond hair brown. You’ll learn how to avoid 
dying her adjacent skin tones (and the background) brown by 
using the Adjustment Brush’s mask tool.

In our starting image, the side-on flash creates strong 
contrasting tones. For a more flattering portrait we could 
light the subject from the front to fill in the harsh shadows. 
By using the Adjustment Brush and Basic panel sliders, you 
can create a more flattering high-key lighting effect.

Transform 
any portrait
Take your portrait enhancements into the creative 
realm by subtly changing the lighting and colours

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Open in Camera Raw
Open PMZ90_creative. Before recolouring the subject’s hair 
it makes sense to create our high-key lighting effect, because 

this will restore detail to hair hidden in the shadows. In the Basic 
panel, drag the Shadows slider to +66 to selectively lighten the 
shadows. By dragging Highlights to +41 you can create a lighter, 
more friendly backdrop. Drop the Vibrance slider to -26 for a more 
subtle wash of colour.

3Choose a colour
In the Adjustment Brush panel, click New. Click the Color 
swatch. In the Color Picker, set Hue to 36 and Saturation to 

54 to choose an orange colour. We can’t see the brunette tint that 
we need, but we can use orange as a starting point. Click OK. Set 
Exposure to -3.35 for a darker tint. Drop Saturation to -100. Set 
Density to 100. Tick Auto Mask. Click to place a pin on her hair 
and paint to dye it brunette.

2Fill in the shadows
Grab the Adjustment Brush. In the Adjustment Brush panel, 
set Exposure to +1.00. Push Shadows up to +30. Untick Auto 

Mask. Set Size to 10, Feather to 51 and Flow to 60. Set Density to 
88. Click to place a pin on her cheek. Paint over the shadows on her 
face and hair to lighten them. This creates less contrast and makes 
the subject look like she was lit from the front, recreating a more 
flattering high-key lighting setup.

4Remove the stray paint
As you paint over the edges of the subject, the ticked Auto 
Mask box helps to stop the brush strokes from dyeing the 

background. Tick the Erase button and paint to remove any patches 
of digital dye that have strayed over the skin. Click back on the Add 
button and paint over any remaining traces of blonde hair. You may 
need to untick the Auto Mask button to dye contrasting blonde hairs. 
It’s a fiddly job, but well worth taking extra time to get right.
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5Soften the edges
Thanks to the Auto Mask option, you’ll notice sharp edges 
where the dyed hair overlaps the background. To soften these 

edges, click New in the Adjustment Brush panel. Click the Color 
swatch and drop the Color Picker’s Saturation slider to 0. Set the 
Sharpness slider to -70. Click to place a pin at the edge of the hair, 
and paint around the edges to soften any sharp sections where the hair 
overlaps the background.

7Smooth the skin
Click back on the Adjustment Brush icon in the toolbar. By 
default it will be set to new in the Adjustment Brush panel. Drop 

the Clarity slider to -100. Tick the Auto Mask button. Click to place a 
pin on her face. Paint over the skin to create a smoother complexion. 
Because you’re using the Auto Mask option, the brush shouldn’t 
soften contrasting areas such as eyes and lips. Tick Show Mask to see 
which areas are being smoothed.

6Remove the stray hairs
Some single blonde hairs will be tricky to dye brown, especially 
if they overlap the face or background. To remove traces of the 

original blonde hair, grab the Spot Removal tool. In the Spot Removal 
panel, set Type to Heal. Set Feather to 83. Magnify the image to 50% 
and set the Spot Removal tool’s Size to 4. Paint over unwanted strands 
of hair to replace them with appropriate skin or background pixels. 
Click unwanted spots to remove them.

8Add the finishing touches
Use the Zoom tool to magnify the shot at 33%. Click the 
pin that controls the hair dye. The sliders and colour will 

change back to the brunette dye settings. Reduce the Density slider 
to 18 for a more subtle effect. Make sure that Auto mask is ticked. 
Reduce the tip size to 3. Paint over the eyebrows to dye them a 
subtler brown. Lighten the dye colour by setting Exposure to -2.70. 
Push Shadows to +50. Set Saturation to -85. 
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W  hen shooting a high-contrast scene it can be a battle to 
capture detail in both the shadows and the highlights. If you 
expose to capture highlight detail in the sky then backlit 
objects can appear as silhouettes. If you meter to capture the 

darker details then you might clip the highlights. You could try 
exposing for the sky and illuminating foreground objects with a blast of 
flash, but this can cause lighter closer objects such as our starting 
image’s stalks of wheat to become blown-out too.

By shooting in raw we know that there is more tonal and colour 
information stored with the image than we can see when viewing the 
unprocessed photo. We can claw back missing highlight information 
with the Camera Raw Highlight slider while lightening the darker 
details with the Shadow slider. However, in some cases these 
selective tone-tweaking sliders might not be enough. We may need 
to claw back even more tonal and colour detail by making a global 
Exposure adjustment. This can cause us to lose detail in the shadows 
or the highlights. If the sky and the landscape are separate, then the 
Graduated Filter is the perfect tool to recover missing highlight detail 
or selectively brighten a dark landscape. However in shots such as our 
starting image, the darker foreground object overlaps the sky, making it 
harder to make a gradated tonal adjustments.

In this tutorial we’ll show you how to create two versions of a high-
contrast scene. One version will expose for the highlights and the other 
for the shadows. We’ll then take the two versions into Photoshop and 
use layer masks to combine the correctly exposed parts of the image.

Double 
process  
a raw file
Process a raw file twice to reveal 
details throughout the image

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Reveal shadow detail
Start by revealing colour and detail in the silhouetted farm 
machinery. Drag the Shadows slider up to +80 to reveal more 

shadow detail. To brighten up the foreground even more, increase 
Exposure to +0.30. As we’re exposing for the shadows we don’t need 
to worry about highlight detail. In fact, push Highlights to +70 and 
Contrast to +10 to make them brighter. This will help us select and 
replace the highlights with a correctly exposed version later.

3Save the shadow exposure
While you’re accessing the Detail tab, drag the Luminance 
noise slider to 17 to smooth out the noise caused by our 

starting image’s ISO800 speed. When you brighten up dark areas, the 
newly revealed colours will look rather drab. Set the Vibrance slider 
to +45 to reveal more colour information. Set Clarity to +35 to reveal 
fine details. Click Save Image. Name the image ‘Shadow Exposure.’ 
Save it as a Photoshop format file.

2Remove the colour artefacts
When you brighten up under-exposed shadows you’ll reveal 
more colour and detail. If you zoom into 100% magnification 

you’ll notice that you’ve also revealed colour noise and chromatic 
aberration – purple colour fringes clinging to the edge of contrasting 
objects. Click the Lens Corrections panel. Tick Enable Lens Profile 
Correction. Click the Color tab and tick Remove Chromatic Aberration. 
Go to the Detail panel and drag Color to 100 to remove colour noise.

4Save a snapshot
Go to the Snapshots panel. Click the New Snapshot icon. 
Label it ‘Shadow Exposure’. Click OK. This enables you to 

summon the shadow settings if you need to tweak them later. Go 
to the Basic panel and click the Default button. This sets the Basic 
panel’s tone-tweaking sliders to 0. Leave the Lens Correction and 
Noise Reduction settings as they are. You’re now ready to create a 
version of the scene that features detail in the brighter sky.
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5Reveal sky detail
Set Exposure to -0.65 to darken the sky. Drop Highlights to 
-46 to claw back more detail. Drag Temperature right to 7250 

to enhance the warm sunset colours. Grab the Graduated Filter. Draw 
a gradient down from the top of the frame. Set Exposure to -1.10 to 
darken the top of the sky even more and add drama. Boost Temperature 
and Saturation to +30 for even warmer colours. Save a version of the 
image called ‘Highlight Exposure’. Click Done.

7Refine the edges
Click to target the top layer. Grab the Magic Wand. Untick 
Contiguous so that you can select similar sections of sky. 

Increase Tolerance to 45 to select a wider range of highlights. Click 
to select the sky. If some of the darker sky tones remain unselected, 
hold Shift and click to add them to the selection marquee. Choose 
Select>Inverse. Click Refine Edge. Set View to On Layers. Tick Smart 
Radius. Set Radius to 2.7. Set Output to New Layer with Layer mask.

6Layer the images
In Photoshop, go to File>Open and browse to your Highlight 
Exposure.PSD and Shadow Exposure.PSD files. Shift click to 

select them and click Open. Click the Shadow Exposure document’s 
tab and choose Select>All. Choose Edit>Copy. Click the Highlight 
Exposure document’s tab and choose Edit>Paste. You now have a 
layered document. Label the top layer ‘Shadow Exposure’. Label the 
bottom layer ‘Highlight Exposure’.

8Tidy up the mask
The mask’s black sections hide the over-exposed sky on the 
top layer, revealing the correctly exposed sky from the layer 

below. Grab the Brush tool. Choose a soft-edged tip. Click the mask. 
Set the foreground colour to black. Paint over any holes in the darker 
stalks that overlap the sky to reveal missing detail from the lower 
layer. Set the foreground colour to white. Paint over any holes in the 
foreground to reveal missing shadow details from the top layer. 
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Advanced 
tips & tricks
Save time and effort with our little-known Camera 
Raw image-processing workflow shortcuts

170 Share your processed 
raw files
Discover how to ensure that the 

processed raw files you wish to share are accessible 
by anyone using any software

172 Process JPEGs 
in Camera Raw
Open and edit your compressed 

JPEGs as if they were raw files using Camera Raw 
tools and techniques

174 Open a raw file 
as a Smart Object
Give yourself more editing options 

later in the process by converting a raw file into a 
Smart Object

178 Save time with 
custom raw presets
Create and apply your own image-

processing presets in Camera Raw and Bridge 
to save time and effort

180 Correct distortions 
with a lens profile
Discover how to set up Camera 

Raw so that it applies lens profile corrections 
to your photos automatically
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Share your 
processed images
Discover how to ensure that the processed raw files you 
wish to share are accessible by anyone using any software

Store Camera Raw image settings inside your processed raw file

Photoshop Anatomy Save as a DNG

1 SAVE IMAGE

If you want to export your processed 
raw file as a Digital Negative, click 
this button here to access the Save 
Options window.

3 COMPATIBILITY

To open DNG files in older versions 
of Photoshop, click here. This setting 
allows our DNG to be compatible with 
CS6 and Lightroom 4.1 onwards.

2 DNG

If you set the File Extension drop-
down menu to DNG, the Format 
drop-down menu will change to 
Digital Negative.

4 EMBED DATA

Clicking here enables Camera Raw to 
open the file more quickly and apply 
stored adjustments, though it will 
increase the file size slightly. You can use 
a smaller Camera Raw cache preference 
setting if this option is regularly used.

 
5 LOSSY COMPRESSION

Ticking this option creates lighter DNG 
files, but you will lose some data and 
quality. Leave it unticked (or save a copy 
as a JPEG if you need a smaller version).

6 EMBED ORIGINAL

By ticking this box you can store the 
unprocessed raw file’s data inside your 
DNG. There’s no real need to do this and 
it’ll create a much larger file size.

O
nce you’ve spent time processing 
your raw files in the Camera Raw 
editor, you’ll need to save and 
share them. There are many 

different raw format files that you can edit in 
Camera Raw, from Nikon’s NEF format to 
Canon’s CR2. If you edit one of these formats 
using any of the Camera Raw tools and then 
click Done, a sidecar file will be created and 

stored alongside the edited raw image. This 
XMP format file contains a record of every 
tool and slider setting that you applied to the 
raw image. If you share the raw file, then you 
need to include the XMP file too if others are 
to see and access the changes that you’ve 
made. Different raw formats (and raw files 
from newer cameras) can be harder to access 
in older versions of Photoshop, which is why 

it makes sense to save your processed files in 
Adobe’s Digital Negative (DNG) format. This 
embeds the Camera Raw adjustments inside a 
single DNG file, so you can share it without 
worrying about sidecar files. Digital Negatives 
are also easier to open in older versions of 
Photoshop. We’ll show you how to save files 
in the DNG format and then explore other 
sharing formats. 

5

4

6

3

1

2

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Store and share copies of your edited work more easily

Overview Save in other formats

1 LOCATION

Click Select Folder to choose a location for the saved version of 
your edited file. You can save it alongside the original raw file or 
choose a new location.
 

2 JPEG

To save a lightweight version of your processed picture to 
share on a web gallery, social media site or email to family and 
friends, choose JPEG from this drop-down menu.
 

3 METADATA

All raw files contain data about the camera settings used to 
capture the image. You can include all of that data (or a more 
limited selection such as any attached copyright information) 
by using this drop-down menu, but it won’t make any difference 
to the file size.

4 QUALITY

You can create a smaller faster-to-download file by dropping 
the quality value – though this can add compression artefacts. 
If posting a copy to Twitter, you can tick here and choose a File 
Size limit of 100K.
 

5 COLOR SPACE

If sharing online, use a screen-friendly colour space such as 
sRGB. For more faithfully reproduced print colours, set this 
option to Adobe RGB (1998).

6 RESIZE

If you plan to print a copy of your picture, you can resize it to fit 
specific print dimensions such as a 10x8-inch print. It’s worth 
ticking the Sharpen for Screen or Glossy Paper option too, 
depending on the image’s destination.

1

5

6
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2Clipping and Clarity
The histogram demonstrates that our shot lacks strong 
highlights, so drag Highlights to +39. The highlight 

clipping warning helps you avoid blowing out the highlights 
more effectively than the tools in Photoshop. Increase 
Clarity to +36 to increase midtone contrast.

1Access Camera Raw Filter
In Photoshop, go to File>Open and browse to select our 
PMZ38_raw filter.jpg starting image. Click Open. By 

default, the image will open in Photoshop (unless you’ve 
changed the Camera Raw preferences). To take the shot into 
Camera Raw, choose Filter>Camera Raw Filter.

O
nce you’ve become familiar with the tools that 
you can access in Camera Raw, you may prefer to 
edit all of your image formats in this workspace, 
even compressed JPEGs. Although JPEGS lack 

the extra information about colour and tone stored in a raw 
file, Camera Raw still enables you to correct typical photo 
problems quickly and easily. Colour- and tone-tweaking 
tools are close to hand in the Basic panel. You can also 
summon a handy before-and-after view.

By default a JPEG will open in Photoshop, but if you 
go to Camera Raw and click the Preferences icon you 
can go to the JPEG and TIFF Handling section of the 
Preferences window and set the JPEG drop-down menu to 
Automatically open all supported JPEGS. Click OK. Now 
when you open a JPEG from within Photoshop, it will be 
taken straight to Camera Raw. 

Alternatively, you may prefer to start working on your 
JPEGs in Photoshop and then take them into Camera Raw 
to apply specific effects. The Camera Raw Filter enables you 
to open your edited JPEG in Camera Raw so that you can 
access tools that aren’t in the Photoshop workspace, such as 
the Split Toning tab and the Clarity slider.

Process JPEGs 
in Camera Raw
Open and edit your compressed JPEGs as if they were 
raw files using Camera Raw tools and techniques

BEFORE

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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4Add extra effects
The JPEG’s compression artefacts are noticeable in the 
sky. To disguise them and add character to the image, 

go to the Effects panel. Set Grain Amount to 42 and Size to 43. 
This is a much easier way to add grain than in Photoshop. Add a 
vignette to atmospherically darken the edges. Click OK. 

3Selective contrast boost
Once you’ve tweaked the tones to create a stronger 
contrast, you can be more creative. Click the HSL/

Grayscale panel and tick the Convert to Grayscale box. Push 
the Green and Yellow sliders to the right to lighten the 
vegetation and make it contrast with the darker rocks.
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BEFORE

O
ne bonus of editing in Camera Raw is the fact that 
it’s a non-destructive editing process. Any 
changes that you make using sliders or tools can 
easily be reverted to the original settings that you 

captured in the camera. A raw file’s non-destructive status 
means you can’t make any permanent mistakes and lose 
original file data, so you’re free to experiment with different 
looks. When you click Done, the changes will be stored 
alongside your edited raw file (or inside it if it’s you save it 
as a DNG format file). You can then open the edited image at 
any time in the future and fine-tune it, or reset it to its 
original unedited state.

However, once you’ve done all you can using the tools 
and sliders in Camera Raw, you may want to take the 
processed picture into Photoshop to continue editing its 
look with filters, or add text perhaps. By leaving Camera 
Raw, you lose access to its non-destructive editing 
abilities. You also lose access to the extra colour and 
tonal information stored in the raw file. 

By opening your edited raw file as a Smart Object, you 
can continue enjoying the non-destructive power of the raw 
format, and access valuable information, even after you’ve 
started to edit the image in Photoshop. A Smart Object is a 
separate file that stores all the information about the original 
image, so you can edit in Photoshop and then pop back 
to the Camera Raw file to tweak its sliders. You can then 
continue editing the fine-tuned file in Photoshop. Here’s a 
Smart Object workflow…

Open a raw file 
as a Smart Object
Give yourself more editing options later in the process 
by converting a raw file into a Smart Object

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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1Open the raw file
If you prefer to start your workflow from Bridge, select the 
supplied raw file’s thumbnail and choose File>Open in Camera 

Raw (or summon the same pop-up menu option by right clicking the 
thumbnail). If you prefer to start from within Photoshop, then you 
can choose File>Open As Smart Object. This will take the photo into 
Camera Raw too. Bridge users can convert the edited raw file into a 
Smart Object later, as we’ll demonstrate in this walkthrough.

3 Increase the contrast
Warm up this cold shot by dragging the Temperature slider 
to 5200. This setting also removes the starting image’s blue 

colour cast. Drop Exposure to -0.40. For a more dramatic contrast 
between shadows and highlights, drag the Contrast slider right to 
+28. To create the clipped shadows produced by the bleach-bypass 
process, drag the Blacks slider left to -19. We now have a more 
high-contrast look.

2Process the picture
However you decide to open your image into Camera Raw, you 
can process it using the following steps. We’ll use Camera Raw 

to emulate the subdued warm colours and the contrasting tones of 
the Hollywood-style bleach-bypass film-processing technique and 
then add a background bokeh to the portrait in Photoshop. We’ll 
then show you how to take advantage of the Smart Object format 
to go back into Camera Raw.

4Tweak the colours
You can double check that you have the characteristic 
clipped shadows produced by the bleach-bypass process 

by pressing U to turn on the Shadow Clipping warning. Clipped 
shadows will appear as patches of blue. To create the desaturated 
colours that are also associated with this look, drag Saturation 
down to -43. Boost Clarity up to +82 to increase the midtone 
contrast and give details more punch.
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5Open it as a Smart Object
We’ll now take the processed raw file into Photoshop and 
blur the background. If you chose to use Photoshop to open 

the raw file as a Smart Object, then click the OK button at the 
bottom left of Camera Raw. If you opened the DNG as normal, then 
you won’t see an OK button. Instead, hold down Shift and the Open 
Image button will change to Open Object. Click the button to take 
the raw file into Photoshop.

7Add a bokeh effect
Click the Smart Object layer’s thumbnail to target it. Go to 
Filter>Blur Gallery>Iris Blur. Set the Blur slider to 52 to blur 

the area outside the subject’s face. Drag the blur pin’s position, 
edges and control points to fine-tune which areas are blurred and 
which remain sharp. Increase the Blur Effects Light Bokeh slider 
until the highlights in the blurred parts of the image begin to flare. 
Click OK to apply the filter.

6Embedded Smart Object
Your processed raw file will open in Photoshop, giving 
you access to all the extra tools and filters that are 

unavailable in Camera Raw. Look in the Layers panel. You’ll see 
a little icon in the corner of the preview thumbnail that 
indicates the layer’s status as a Smart Object. We’ll use this 
status later on to fine-tune the file in Camera Raw after we’ve 
processed it a bit more in Photoshop.

8Back and forth
By double clicking the Smart Object layer you can go back 
into Camera Raw and claw back more highlight detail from 

the original raw file. Click OK to go back into Photoshop. Because 
you’re working with a Smart Object, you can double click the Smart 
Filter’s Blur gallery label and fine-tune the blur settings too. Thanks 
to Smart Objects, you can change any edited attribute in both 
Camera Raw or Photoshop. 
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Save time with 
custom raw presets
Create and apply image-processing presets in Adobe Camera 
Raw and Adobe Bridge to save time and effort later

Record slider settings and apply them with a click

Photoshop Anatomy Create a preset

1 ADJUST THE IMAGE

We boosted the Basic panel’s Contrast 
slider to +18, increased Vibrance to 
+62 and cooled down the Temperature 
to 4300.

3 NEW PRESET

After making adjustments, click here 
to save them as a one-click preset. 
The New Preset window will appear.

2 CROP

We cropped the shot to create a 
portrait-oriented image. The preset 
won’t store the composition change, 
just the colour and tonal adjustments.

4 SETTINGS

By default all the settings will be ticked. 
You can choose to save some settings 
but not others. Click to select a subset 
such as the Basic sliders.

 
5 NAME

Give your preset a descriptive name 
(such as ‘Contrast and colour boost’) 
so that you can easily identify and apply 
it to other images in Bridge or Camera 
Raw. Click OK to save the preset.

6 PRESETS PANEL

Any presets that you create will 
appear here. To apply a preset’s stored 
adjustments to a raw file, click its label. 
You can also click the fly-out icon on 
the right of the panel and choose 
Apply Preset.

Y
ou’ll probably spend lots of time 
correcting common problems in 
Camera Raw over and over again. 
Under-exposed photos will need 

to be brightened up and have their colour 
saturation boosted. Over-exposed images will 
need their clipped highlight detail restored. 
If you use the same camera settings to capture 
a batch of images on location then they may 

all need identical corrections in Camera Raw. 
Applying these corrections to each photo is 
unnecessarily time-consuming. After fixing a 
photo that’s representative of the problems in 
the batch, you can record the position of the 
various Camera Raw sliders as a preset and 
then apply the look that they produce to the 
other photos with a click. As well as typical 
photo-fixing presets, you can store a range of 

creative ones. This enables you to quickly 
experiment by applying special effects to your 
raw files, for example. Once you’ve created a 
collection of photo-fixing presets in Camera 
Raw, you can apply them to single shots or 
groups of images from Bridge, without 
needing to open Camera Raw. Check out our 
annotations to discover how to create and 
apply these time-saving presets. 
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GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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Edit colours and tones to a batch of files with a click

Overview Apply presets in Bridge

1 STORED ADJUSTMENTS

This icon indicates that the raw image’s colours and tones have 
been adjusted. We can also see that the shot has been cropped.
 

2 UPDATE THUMBNAIL

After making changes to a photo in camera Raw and clicking 
Done, right click the thumbnail and choose Generate High 
Quality Thumbnail. The thumbnail will update to show the 
colour, tonal and composition changes.
 

3 SELECT MULTIPLE

Here we have other photos captured in the same location as the 
edited image. To tweak their colours and tones using a preset, 
you first need to Shift click to select them.

4 BATCH PROCESS

After selecting a thumbnail (or multiple thumbnails), right click 
one of them and choose Develop Settings. Here you can access 
and apply any presets that you created in Camera Raw.
 

5 DEVELOP SETTINGS

You can also access and apply the Develop Settings menu to 
the selected thumbnails by clicking here.

6 REMOVE PRESETS

You can restore a file to its original preset-free look by clicking 
Clear Settings. It now reverts to its original state.
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1 Open the image
Open a raw file. In this example our raw image was produced by 
a Nikon D800 camera. Click the Open Preferences dialog button 

in the Camera Raw toolbar. In Default Image Settings, Tick the Make 
defaults specific to camera serial number box. Click Done. Now any 
custom default settings that we create (including those using a lens 
profile) will automatically be applied to other images that were taken 
on our Nikon D800 camera.

2 Choose a lens profile
Click the Lens Corrections panel. Click the Profile tab. Tick 
Enable Lens Profile Corrections. If the lens profile doesn’t 

appear automatically, choose an appropriate lens manufacturer (in 
this instance Nikon) from the Make drop-down menu. The lens 
model and a suitable lens profile will appear. Any image distortion 
and vignetting will automatically be counteracted without the need 
to manually adjust any sliders.

Correct distortions 
with a lens profile
Discover how to get Camera Raw to make lens 
profile corrections to your photos automatically

C
amera lenses can add geometric 
distortion to an image, especially 
when shooting at a wide angle. 
The edges of the frame might also 

be vignetted, causing them to contain darker 
colours and tones than the rest of the scene. 
Fortunately, Camera Raw has a handy Lens 
Correction panel that contains a Profile tab 
that can counteract these lens-induced 
distortions. By default, Camera Raw doesn’t 
automatically apply lens profile corrections to 

your raw files, so you need to manually click 
two tabs and then click a box. In this 
walkthrough we’ll demonstrate how to 
change the Camera Raw default settings so 
that it automatically applies lens corrections 
using an appropriate profile. We’ll also 
demonstrate how to make Camera Raw 
automatically apply a lens-profile correction 
to files produced by one camera, but leave 
another camera’s raw files uncorrected. Read 
on to find out how…

METADATA

After opening a raw file in Camera Raw, click 
Open Image to take the photo into Photoshop. 
Go to File>File Info. In the Camera Data tab you 
can see what lens and camera body were used to 
capture the photo. The Profile tab in Camera Raw 
uses the raw file’s metadata to discover which 
camera and lens were used to take the photo. 
Click OK and close the image without saving it.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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3 Save the new default
Go to the Set Up drop-down menu in the Profile tab and click 
Save New Lens Profile Defaults. Click the little fly-out icon 

on the right of the panel and choose Save New Camera Raw defaults. 
Click the little fly-out icon at the top right of the Lens Corrections 
panel and choose Save New Camera Raw defaults. Click Done. Thanks 
to this new default setting, a lens profile will automatically be applied 
to any unprocessed Nikon D800 raw files we open in Camera Raw.

5 Test the correction
Click the thumbnail and choose File>Open in Camera Raw. 
You may instantly notice the change, but to check that the 

lens profile corrections have been applied to our Nikon D800 image 
by default, go to the Lens Corrections panel and click the Lens Profile 
tab. The Enable Lens Profile Corrections box should already be ticked, 
thanks to our camera-specific default settings. Click Done to close the 
corrected image.

4 Clear the adjustments
Before we test the new lens profile default on another 
Nikon D800 file, browse to the photo we've just 

edited in Bridge and right click its thumbnail. Choose Develop 
Settings>Clear Settings from the pop-up menu. This resets 
the file to its original unprocessed state and clears out any 
associated XMP file that might override the Camera Raw 
defaults that we’ve just set up.

6 Camera-specific corrections
If you own another camera (such as a Canon), you may not 
want lens profile corrections to be applied by default. Open 

an unprocessed CR2 file and make sure that the Enable Lens Profile 
Corrections box is unticked. Choose Save New Camera Raw Defaults 
from the fly-out menu. Click Done. Now, when you open a Nikon 
D800 file, the profile corrections will be applied, but when you open 
a Canon shot, the box will be unticked. 
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Raw editing 
in Lightroom
Lightroom isn’t just an alternative to Photoshop. It’s a new 
way of working that combines cataloguing and raw editing

186 The Lightroom 
interface
Get to know the general layout 

and purpose of Lightroom’s photo organising, 
editing and sharing modules

188 Introducing the 
Library module
Locate, rate and keyword 

images, and apply quick photo fixes with this 
organisation module

190 Lightroom’s 
Metadata panels
Lightroom’s metadata panels are 

the engine room of its professional search tools. 
We explain how they work

191 Lightroom’s Quick 
Develop tools
Learn how to speed up your 

workflow by getting to grips with the Quick 
Develop tools

192 Introducing the 
Develop module
Discover how to make basic 

adjustments to images quickly and easily with 
this core module

194 Make selective 
adjustments
Edit selected parts of an 

image while leaving the rest of the image 
completely untouched

196 Make better prints 
in Lightroom
Discover how to make perfect 

prints of your photographs using Lightroom’s 
Print module

198 Share your images 
directly from Lightroom
Prints, Facebook and Flickr aren’t 

the only way to share your photos with others – 
Lightroom has three more



Teach yourself Raw in Photoshop
RAW EDITING IN LIGHTROOM

184

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

  
Master Lightroom
Lightroom isn’t just an alternative to Photoshop. It’s a whole 
new way of working that combines image cataloguing, raw 
file conversion and non-destructive editing
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I
magine a fusion of Adobe 
Bridge, Adobe Camera Raw and 
Photoshop. A place where you 
can organise your photos, search 

for images and create themed Collections, 
web albums and slideshows.

Lightroom also incorporates the non-
destructive editing tools of Adobe Camera 
Raw (ACR), including dynamic range/
tonal adjustments, curves, sophisticated 
colour controls, localised adjustments and 

more. But these tools are organised into 
a simpler, more efficient and streamlined 
user interface – and they work on JPEGs 
and TIFFs, too, so that all your file formats 
are integrated into the same workflow. 
The key point about Lightroom is that 
all your adjustments are non-destructive 
and stored within the Lightroom Catalog. 
You can apply a colour adjustment to an 
image, for example, and come back weeks 
later to change it – the sliders will be 

exactly where you left them. Lightroom 
also supports Photoshop ‘round-tripping’. 
You can open an image in Photoshop from 
within Lightroom, make your changes and 
save the image, and the edited version 
will appear alongside the original in your 
Lightroom Catalog. Lightroom isn’t a 
Photoshop replacement, then, rather it’s a 
complementary aid. And over the next 16 
pages we’re going to give you a glimpse of 
what it can do…
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01 Navigator
When you zoom in on an image, 
this displays a zoom marquee 

which you can drag around to examine different 
parts of the image. This, and all the other panels, 
has a disclosure arrow to expand or collapse it to 
make room for others.

02 Catalog
Use this to display all your 
photos, view the last batch of 

imported images, or access Lightroom’s Quick 
Collection – just click a shot and tap C to add 
it to the Quick Collection. Images selected in 
this way can then be added to a permanent 
Collection if required.

03 Folders
This panel displays your images 
in the locations where they’re 

actually stored on your hard disk or external 
drive. It’s useful for basic organisation and 
housekeeping, whereas Collections are best for 
specific projects and themes.

04 Collections
These are the equivalent 
of albums in other image 

cataloguing programs. They’re ‘virtual’ 
collections of images which are stored in many 
different folders. A single image can be added to 
many different Collections.

05 Publish services
You can publish photos directly 
to popular online services like 

Facebook and Flickr, as well as Adobe’s own 
subscription-based Revel services. Other 
services, such as SmugMug, are supported by 
downloadable plug-ins.

06 Smart Collections
These use search criteria 
to display matching images 

automatically. For example, you might create a 
Smart Collection to display images taken with a 
specific camera or lens, or of a particular subject. 
You don’t add images manually – Lightroom 
finds them automatically.

07 Toolbar
This has buttons for changing 
the viewing mode between Grid 

(thumbnail), Loupe, Compare and Survey views. 
You can choose additional buttons, too, for 
adding star ratings, rotating images, changing 
the sort order and much more.

08 Image display area
This displays thumbnails in the 
Library module and the image 

you’re working on in the Develop module. 
It’s the active screen area for the work you 
do in Lightroom. In the Library module, 
double click an image to view it and click again 
to zoom in.

09 Filter Bar
You can configure Lightroom 
to display images with specific 

ratings, keywords, labels and even more 
information. Custom filters can then be saved 
and accessed again in future via the drop-down 
menu on the right.

10 Library module
This is where you import images, 
browse, create Collections and 

Smart Collections, and use the Filter Bar to 
search for and display images. View images 
as thumbnails in Grid view, as seen here, 
individually in Loupe view, or sort them using 
Compare and Survey views.

11 Develop module
When you select an image in the 
Library module and switch to the 

Develop module, you can use Lightroom’s 
image-editing tools. Your adjustments are 
non-destructive, and can be undone and 
re-done at any time.

12 Map module
Lightroom can display the location 
of photos with geotagging as map 

pins, but you can assign untagged images to 
locations manually by finding a location with 
the search box then assigning co-ordinates 
to an image.

13 Web module
Use this to create ready-made web 
galleries. A number of customisable 

templates are available. Lightroom can even 
upload them automatically, though you’ll have 
to choose your own web host and enter the 
FTP details.

14 Tools panel
Tools change according to the 
module in use. In the Library 

module they include a Histogram, Quick 
Develop tools and Metadata. Click the arrow at 
the right edge to display the panel permanently 
or make it fly out on demand.

15 Print module
Lightroom enables you to print 
single images, contact sheets or 

‘picture packages’. It displays a preview of 
how the images will print with a selected 
page size and orientation, and includes 
Colour Management options and Print 
Sharpening for specific paper types.

16 Slideshow module
Use this to design slide shows to 
run on your PC or Mac, or to export 

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

The interface
There’s a lot going on in the Lightroom 
interface. Here’s our compact rundown…
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as videos to share online. You can choose 
how images are cropped to fit the screen, and 
what information you want to have displayed 
alongside the images.

17 Book module
This works in conjunction with 
online photo books specialist Blurb 

Books. Instead of using an external application 
or a web browser, you can design and order 
books directly within Lightroom. It’s ideal for 
personal projects and jobs for clients, and it’s 
dead easy to use.

18 Sync Settings
All the adjustments you make to 
images in Lightroom are non-

destructive and can be copied to other images. 
You hold down Ctrl and click additional 
images, then press this button – Lightroom 
prompts you to confirm the settings you 
want to copy. 

19 Filmstrip
This is particularly useful if 
you want to view or compare 

individual images in the main window. 

20 Sync Metadata
If you’ve added keywords, 
copyright information or 

captions, you can hold down Ctrl and click 
additional images and use this to apply the 
same information to them.

21 Filter/navigation 
controls
Use these to filter photos in a 

filmstrip by flag status, rating or any criteria 
already set up in the Filter Bar. This is brilliant 
for finding particular images.

11 12 13
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A  large part of Lightroom’s job is 
keeping your images organised. This 
becomes a progressively greater 
challenge as your image library grows 

in size, and the number of different ways you 
want to use your pictures increases, too.  It uses 
industry-standard ‘metadata’ embedded in your 
images to help, consisting of keywords, captions, 
copyright information and more. But it also 
offers quick-access Flags, Ratings and Labels and 
an interactive Filter Bar to help you quickly find 
and isolate the pictures you’re looking for.

1 Folders
This is where Lightroom displays the real 
location of your photos on your computer 

or your external drive. If you move photos and 
folders here, you move them on your computer. 
It’s important to realise, though, that if you 
move them on your computer instead, Lightroom 
won’t be able to find them any more and you’ll 
have to manually relocate them within Lightroom 
and re-establish the connection. You can use 
Folders as your main organisational tool, though 
many photographers prefer to use Collections 
and Collection Sets instead.

2 Smart Collections
Smart Collections can be created and 
stored alongside regular Collections, but 

they’re a very different thing. You should think 
of them as ‘saved searches’ instead. Imagine you 
want to find all pictures taken on a Nikon D700 
containing the keyword ‘snow’ and taken in the 
Alps in 2011. This is quite a long-winded set 
of search criteria you wouldn’t want to have to 

The Library 
module
Here’s a closer look at the key 
panels and controls in this 
key Lightroom component

TETHERED SHOOTING

Normally, you’d shoot pictures with your camera 
and then transfer them to your computer and 
then import them into Lightroom. Certain 
D-SLRs, though, can be used ‘tethered’. You 
connect the camera to the computer and then 
control it from within Lightroom. This can be 
useful when you’re shooting in a studio with a 
fixed setup and want to be able to control the 
camera remotely. Lightroom does not display 
a live image while you shoot, but it does enable 
you to instantly view the photo you’ve taken 
when Lightroom imports it.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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type in twice, but if you use a Smart Collection 
instead, your search is saved permanently among 
your other Collections. The key thing to know 
about Smart Collections is that you can’t add 
or remove pictures manually – they’re chosen 
according to their properties, so the only way to 
control what appears is to change the properties 
(keywords, for example) of the picture.

3 Collections    
& Collection Sets
These are like ‘virtual’ folders. They’re 

completely independent of the folders on your 
computer. You can create Collections for images 
you want to use as a portfolio, photos to show a 
client or as a way of bringing together pictures 
that share a common theme. Deleting a photo 
from a Collection doesn’t delete the photo, only 
that particular reference to it, and you can add 
the same photo to many different collections 
– but it’s still the same photo, not a copy. So if 
you apply any adjustments or effects to a photo, 
these will show up in all the Collections where 
the photo appears. Collection Sets are simply 
folders to help you organise your Collections. 
You can nest them one within another, just like 
nesting folders on your computer.

4 Filter Bar
The Filter Bar appears at the top of the 
main window in Develop module, and 

it has drop-down menus to help you filter the 

contents of your Collections or Folders according 
to the image keywords, captions, location (if you 
use the Map tools) and more. It has four buttons: 
Text, Attribute, Metadata and None. You can use 
the Text panel to carry out a simple free-form 
search for text such as keywords and captions, 
for example. The Attribute panel offers quick 
and simple visual filtering tools including Flags, 
Ratings and Labels, while the Metadata panel 
takes a more structured approach to searches, 
displaying drop-down menus which enable you 
to select and combine criteria like the date, the 
camera model, ISO setting, the lens used and 
more. The fourth, ‘None’ button on the Filter Bar 
simply removes all search criteria.

5 Filter Presets
The drop-down menu on the far right 
of the Filter Bar displays a list of default 

filter presets, which you might find useful. 
For example, the Exposure Info preset displays 
the Metadata panel with the menus set up to 
display camera shooting information. But you 
can also save your own Filter Bar settings by first 
setting them up manually and then using the 
Save Current Settings as New Preset command 
near the bottom of the presets menu. These 
presets essentially do the same thing as Smart 
Collections, but they are best reserved for 
common wide-ranging filter options because 
space on this menu is limited – use Smart 
Collections instead when your search is specific.

6 Flags
Flags are a very quick way of picking out 
the images you want to be able to see all 

the time, your best images and those you don’t 
want to keep seeing but that you don’t want to 
delete either. You can set the Flag status using 
the badge displayed on image thumbnails in the 
Develop module’s Grid view (depending on your 
viewing options) – clicking the badge toggles 
it between Unflagged and Flagged. Or you can 
use the keyboard shortcuts, and this is probably 
quicker. X rejects an image, P flags an image 
(think ‘P’ for ‘Pick’) and U unflags an image. You 
can then use the Attribute panel on the Filter 
Bar to quickly filter your photos to show only 
Flagged or Flagged and Unflagged photos, for 
example.

7 Ratings
This is another way of identifying your 
best photos, and it enables you to sort 

your photos by rating, so that you see your best 
images first. You can also use the tools in the 
Attribute panel to filter your photos by rating. 
You just click on the number of stars – for 
example, clicking on three stars displays photos 
with a rating of three stars or above. You could 
use this alongside Flags, but it’s more likely that 
you’d choose one or the other. Ratings are also 
displayed below the image thumbnails in Grid 
view (depending on your view settings), and you 
can set the star rating here, too.

6

PUBLISH SERVICES

You can upload pictures to Facebook and 
Flickr directly from within Lightroom. 
Adobe Revel is also supported, but this 
is a subscription-based service. Let’s 
say you want to upload a Collection to 
Flickr – first, you need to click the Setup 
button, and go through an authorisation 
process to link Lightroom to your Flickr 
account. Once you’ve done that, you can 
create new Photosets of images within 
this Flickr section which Lightroom will 
upload for you.

4
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METADATA PRESETS

These appear in a pop-up menu directly below 
the Metadata panel title bar. A preset can 
apply several metadata panels at once. For 
example, you could create a preset to change 
the Copyright Status to ‘Copyrighted’ and the 
Copyright to your name at the same time.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR

L
ightroom uses the industry standard 
IPTC system for tagging photos with 
keywords, captions, descriptions and 
more as ‘metadata’ – or data 

embedded invisibly in the image but available to 
programs like Lightroom, and newspaper picture 
editors, for example. It can also display the EXIF 
(shooting information) data embedded by your 
camera in every shot it takes. 

1 Keywording
Keywords are at the heart of any serious 
image cataloguing system. They’re words 

or short phrases which are embedded in the 
photo and used later to help locate specific 
images. You can use this panel to type in any 
keyword or keywords you like with one or more 
images selected. Lightroom will look for similar 

keywords you’ve already used as you type, to 
help avoid duplication and save time. It will also 
display recently-used keywords you can apply 
with a single click, and user-defined Keyword 
Sets which you use often.

2 Keyword List
You use this panel for large-scale keyword 
organisation and editing. It shows all 

the keywords that you’ve used in alphabetical 
order, and it also allows you to organise them 
hierarchically. To the right, Lightroom shows 
how many images have that keyword, and you 
can select a keyword and click the right-facing 
arrow to show them. To the left of the keyword 
name is a checkbox – you check or uncheck 
this to add or remove a keyword from a selected 
image or images.

3 Metadata
This panel can display both the camera 
shooting (EXIF) data and other IPTC 

metadata fields, and you choose what you want 
to see using the pop-up menu on the panel’s 
title bar. For example, if you select Minimal, the 
panel displays just the File Name, the Rating, 
any Caption that you’ve added and a Copyright 
message – for example, your name.

Lightroom’s
Metadata panels
Lightroom’s metadata panels are the engine 
room of its professional search tools

1

2
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1 White Balance
Choose As Shot to use the settings 
embedded by the camera, or choose one of 

Lightroom’s presets from the menu. (RAW files 
only). You can also adjust the Temperature and 
Tint values manually.

2 Tone Control
Use Auto Tone or adjust the settings 
manually. Single-arrow buttons make 

small adjustments, double-arrow buttons 
make large ones. Note the Reset All button 
at the bottom.

3 Saved Preset
Use this menu to choose one of 
Lightroom’s preset Develop effects – 

they’re the same as the ones in the full Develop 
module, organised into groups. You can also 
change the Crop Ratio to suit different screen 
or paper sizes.

Direct Positive
Produces a high-contrast, high-saturation look 
reminiscent of low-speed transparency films, 
and can give colour shots extra impact.

Aged Photo
This reduces the saturation, applies a warm tint 
and makes adjustments to the tonal controls to 
achieve a ‘retro’ look for the image.

B&W Look 1-5
Delivers an instant black-and-white conversion 
in five different styles – you can try them all to 
find the look that you want.

Bleach Bypass
Creates a high-contrast, cold, under-saturated 
and high-definition look that could be good 
for urban landscapes or male portraits.

B&W Sepia Tone
The classic black-and-white toned effect, but 
delivered with more subtlety and control than 
the sepia ‘effects’ in other programs.

Cross Process 1-3
Simulates the effect of processing film in the 
‘wrong’ chemicals and produces varying colour 
shifts according to which one is chosen.

Quick Develop
Learn how to speed up your workflow by 
getting to grips with the Quick Develop tools

1

2

3
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T
he tools in the Develop module are 
broadly the same as those in 
Adobe Camera Raw, but the layout 
is completely different. Lightroom 

works with JPEG and TIFF files, too, treating 
them just the same as raw files – though you 
need to shoot raw to take full advantage of the 
highlight and shadow recovery tools.

All adjustments that you make in 
Lightroom are non-destructive and can 
be returned to even after you’ve moved 
on to another image or quit and restarted 
Lightroom. You never ‘save’ your adjustments 
– they’re stored ‘live’ as you make them.

1Navigator
The Navigator has two uses here: if you 
move the mouse over a Lightroom preset, it 

displays a preview of the effect, and you can use 
it to pan around an image if you’re zoomed in.

2Attributes
As you’re working on your photos, you 
may to want to change their attributes to 

reflect your adjustments, such as their Rating, 
Flag or Label.

3Adjustment panels
These are where the serious image-editing 
work is done. You can use them in any 

order – there’s no specific workflow you have 
to follow – and you’ll find details on each 
panel opposite.

4Snapshots
Like Photoshop and Adobe Camera Raw, 
Lightroom lets you take ‘snapshots’ of 

stages in the editing process to return to later. 
Unlike the others, though, Lightroom stores 
these indefinitely.

5History
This panel displays everything you’ve 
done to an image from the moment 

you imported it, and this information is 
saved indefinitely, or until you click the ‘x’ 
(Clear) button.

6Collections
Lightroom doesn’t display Folders in 
the Develop module, but it does display 

your Collections – another reason for using 
Collections as your primary organisational tool.

7Copy and Paste
Once you’ve applied a set of adjustments 
to an image, you can click this Copy 

button, then select another image and Paste the 
same set of adjustments on to that one.

8Before & After
In the Library module, this button is 
used to compare different images. In the 

Develop module, you can use it to compare 
before and after versions of the image you’re 
working on.

9Filmstrip
There’s no Grid view in the Develop 
module – you have to swap back to the 

Library module to display images as thumbnails 
– so the Filmstrip is a handy way to display the 
contents of the current Collection.

10Histogram
The histogram is effectively a bar 
chart, showing how many pixels there 

are at the different brightness levels in between. 
The chief thing to check is that the histogram is 
not cut off abruptly at each end.

The Develop module
The Develop module is where serious image-editing happens…
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1Basic
These are your everyday tools. They 
include Lightroom’s redesigned 

Highlights, Shadows, Whites and Blacks 
sliders for more dynamic range control and 
a more powerful Clarity slider for adding 
localised contrast.

7Camera Calibration
Lightroom applies Adobe’s own generic 
interpretation for the colour and tonal 

rendition of raw files, but you can choose 
from a range of different camera-specific 
profiles to get much closer to the camera’s 
own colour rendition.

2Tone curve
This works just like the Curves Panel 
in Photoshop – you drag on the curve 

to reshape it and change the contrast 
properties of the picture. But you can also use 
the Point Curve gadget to drag up and down 
directly on parts of the image to darken or 
lighten those tones. 

3HSL/Color/B&W
HSL lets you adjust Hue, Saturation 
and Lightness. Colour offers simpler 

adjustments based on specific colours. The 
B&W sliders can be used to adjust the colour 
mix when converting colour images to black 
and white.

4Detail
Lightroom’s Sharpening tools 
include an Amount slider, Radius, 

Detail and Masking adjustments for 
maximum control, while 
the Noise Reduction 
sliders allow you to 
minimise both Colour 
and Luminance noise. 

5Lens 
Corrections
Lightroom can 

correct distortion and 
vignetting automatically 
in a larger number of 
lenses, or you can apply 
corrections manually. 

Lightroom 5 brings 
new ‘Upright’ tools for 
automatically correcting 
vertical and horizontal 
keystoning.

6Effects
Post Crop 
Vignetting tools 

can create a vignette 
effect on images after they’ve been cropped 
(hence the name), while Grain sliders can 
replicate the look of old-fashioned films.
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Y
ou’ll find the selective adjustment 
tools just below the Histogram 
panel, and they consist of a Crop 
tool, Spot Removal tool, Red Eye 

Correction tool and – most interesting of all 
– a Graduated  Filter tool and Adjustment 
Brush tool. Between them, these tools go a 
long way towards closing the gap between 
Lightroom and Photoshop. You can’t layer 

images in Lightroom – you’ll still need to 
export them to Photoshop for that – but you 
can fix minor blemishes and also apply 
localised adjustments.

Lightroom’s Spot Removal tool is especially 
effective, and after you’ve used the Graduated 
Filter tool a few times on your landscapes, 
you’ll never want to be without it again. 
These tools are also available in Adobe 

Camera Raw, but here in Lightroom they’re 
much more streamlined.  The other thing 
we’ve not mentioned yet is Lightroom’s 
‘Virtual Copies’. These are ideal for trying 
out different treatments on the same image 
without physically saving a new version to 
your hard disk. Lightroom simply creates 
a duplicate record of the same image and 
displays it alongside the original. 

1Crop tool
When you click on the 
Crop tool, a series of 

Crop and Straighten settings 
open out beneath. You can use 
the Angle slider to straighten 
your shots, but it’s not very 
precise, you’ll get better results 
with the Angle gadget – you 
drag out a line on the image 
corresponding to a horizontal 
or vertical edge that should 
be straight. Use the ‘Constrain 
to Warp’ box if you’ve applied 
Lens Corrections. You can also 
straighten images by rotating 
the Crop marquee – just move 
the mouse pointer outside any 
corner or edge control point. 
The Aspect menu lets you 
constrain the crop to a number 
of common proportions, such as 
4x6-inch prints or 16:9 TVs.

2Spot Removal tool
You can use the Spot Removal tool to cover up sensor spots in digital 
SLR images, and it’s extremely simple to use. First, choose a brush size 

slightly larger than the spot 
you want to cover up, then 
‘dab’ away the spot with a 
single click – Lightroom will 
automatically find a ‘clean’ 
area nearby to use as a source 
for the repair. This will show 
up as a second circle with a 
thicker outline, and if you 
need to, you can simply drag 
it to a different area to get a 
better result. 
In Spot mode, 
it matches the 
source pixels to 
the destination 
area, while in 
Clone mode it 
preserves the 
source pixels’ 
tones as it is. 

Selective adjustments
Did you know you could make selective adjustments in Lightroom?
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3Red Eye Correction tool
Red-eye is less common than it used to be, as on-camera 
flashes now use pre-flash to contract a subjects’ irises 

ahead of the main flash, or distance the flash from the lens 
with a pop-up mechanism. If you do have red-eye images, it’s 
simple to rectify. If the tool is already set to the right size (use 
edge markers as a guide), just click on the eye. If not, drag from 
the eye’s centre to adjust size. Lightroom now applies red-eye 
correction and displays Pupil Size and Darken sliders in case you 
need to make some further tweaks.

4Adjustment Brush tool
This offers the same adjustments as the Graduated Filter tool, 
but with additional brush options. Simply select the tool, 

brush size and start painting. Lightroom places a pin on the image 
where you start painting, and as you continue to paint over different 
areas, it adds to the adjustment ‘mask’. View the mask by moving the 
mouse pointer over the pin. You can change the adjustment sliders 
after you’ve used the brush, but you can’t drag the pin to a new 
position – you must use the Erase and Brush tools to change the 
area adjusted.

5Graduated 
Filter tool
The Graduated Filter tool 

is most useful for darkening 
bright skies in landscape shots. 
With the tool selected, you 
drag in the direction you want 
the gradient to be applied. For 

a landscape, for example, you’d 
click-and-drag upwards from 
the horizon line. 

The Graduated Filter panel 
shows a range of adjustments 
– to darken a sky, for example, 
you can reduce the Exposure 
value. Once the gradated effect 

has been created, you can drag 
on its ‘pin’ to move it, drag on 
the horizontal line through the 
centre to rotate it, and drag up 
or down on the outer lines to 
adjust the distance over which 
the gradient is applied. Far more 
convenient than a real ND grad!
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Printing options
Everything you need to get perfect prints is in this Lightroom module 

I
f you’re used to printing a single 
photo at a time on a single sheet of 
paper, Lightroom’s print layout 
settings might seem quite 

intimidating, but that doesn’t have to be the 
case. You can print multiple images on one 
page, soft-proof with your printer profiles 
and much more. Here’s our guide...

1Page Setup
This displays your printer’s standard Page 
Setup dialog. It’s important to set the paper 

size first, or the rest of the layout options in 
Lightroom will be affected. For example, if you’re 
printing on borderless A4 paper, you need to 
select that here or Lightroom will display a white 
border around your prints.

2Template Browser
If you find yourself using the same print 
layouts again and again, it could be worth 

saving them as your own User Templates 
to save time and effort on future projects. 
Lightroom comes with a wide selection 
of templates as standard.

3Preview
This panel shows how your chosen 
template will look – each template is 

made of up of ‘cells’ within which pictures are 
printed. A template for printing single images 
just has one cell. The Preview panel doesn’t 
show your selected images ‘live’, but if you click 
on a template to select it, you see them in place 
in the main window.

4Image Settings
Lightroom usually fits the whole image 
within the print ‘cell’, leaving space around 

the edges if the photo’s aspect ratio is different 

to the cell’s dimensions. To fill it, check the 
Zoom to Fill box – you must do this to get 
borderless prints. The Rotate to Fit box rotates 
images to suit the page orientation in the Page 
Setup dialog. If you want to select and print a 
series of photos with the same settings, tick the 
Repeat One Photo per Page box.

5Layout style
There are several Layout Styles. To print 
a single photo, choose a template with 

a single cell. To print a contact sheet, choose 
the number of cells in the Layout panel. Picture 
Package prints a number of copies of the same 
image on a single sheet. Custom Package enables 
you to print a number of different pictures at 
any size and in any configuration.

GET THE FILES HERE: http://bit.ly/PMZ38_ACR
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6Guides
Displaying Guides helps you plan print 
layouts and anticipate spacing between 

cells and margins at page edges. Checking 
the Dimensions box can be useful because 
Lightroom will display the size of each cell at the 
top left corner (you can change the units used in 
the Layout panel).

7Layout
The Layout panel offers detailed control 
over cells in your print template. Use the 

Margins sliders to control the space around the 
edges of the print – these need to be reduced 
to zero for borderless printing, for example. The 
Page Grid sliders are used to define the number 
of cells in a contact sheet layout, and if these 
are more than 1 then the Cells Spacing controls 
below are activated. The Cell Size sliders are an 
alternative way of adjusting the size of photos in 
single prints and contact sheets.

8Page
Here you can find options for customising 
the print appearance and adding 

information. For example, you can use a different 
Page Background Color. There is some crossover 
between Identity Plates and Watermarking. 
Both enable you to stamp your printed images 
with text, or with a graphical Identity Plate or 
Watermark which you create separately and then 
specify in this panel. The Photo Info option 
is especially useful, in that you can add image 
metadata to the print.

9Print job
This is where you make final adjustments 
to print settings, in particular the ‘output 

sharpening’. The degree and type of sharpening 
depends on print size. Choosing this at output 
stage is preferable – rather than sharpening ‘by 
eye’ during image editing. This is where you 
choose printer profiles, too – whether you use 
the profiles in the printer driver, or your own 
custom profiles. Lastly, if your prints are coming 
out too dark or light, tweak the settings here.
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GET THE FILES HERE: http://bit.ly/PMZ38_ACR

Y
ou can manually select individual 
photos from within an existing 
Collection or Folder, but it’s 
generally easier to gather the 

photos you want in a Collection of their own. 
You can then select a template from the list 
on the left [1], or start from scratch. 

Over on the right, the Layout Style [2] 
offers a choice of five main gallery types – 
three from SimpleViewer and generic Flash 
and HTML galleries from Adobe. You can 

download other galleries using the ‘Find More 
Galleries Online’ button. 

Below this, the Site Info and Image Info 
panels are used to input a title and  
description for the site, and to choose the 
metadata (captions, for example) displayed 
alongside the photos. 

The options will vary according to the 
template that you have chosen – with 
Lightroom HTML Galleries, for example, you 
can choose the size of the grid used on the 

index pages and the size of the images on the 
individual gallery pages.

The Upload Settings panel at the bottom 
[3] is where you type in your web host’s 
FTP upload details. You’ll need to know the 
name of the FTP server, your username and 
password. If you click the Create Saved Web 
Gallery button at the top right, your gallery 
will be saved permanently in the Collections 
panel, and you can return to it in the future to 
update the images or associated information. 

Sharing your images
Prints, Facebook and Flickr aren’t the only way to share 
your photos with others – Lightroom has three more…

L
ightroom also offers the ability 
to create Web Galleries, 
Slideshows and – new in 
Lightroom 4 – Books. The Web 

Galleries module follows the now-familiar 
Lightroom format of preset templates in 
the left sidebar and manual customising 
tools on the right. Each Web Gallery 

consists of one or more index pages linked 
to individual photos. Lightroom exports 
finished HTML files, which it can then 
upload directly to your web host (you will 
need a web hosting account and FTP upload 
details from your service provider). 
Slideshows are a good way to show off your 
pictures to friends or clients. Again, you 

have a choice of templates on the left, and 
manual controls on the right. The Book 
module has been produced in conjunction 
with online books publisher Blurb. Instead 
of using web-based layout tools or a 
separate program, you can design books 
entirely within Lightroom. You then upload 
and order your book from Blurb.

Create a website
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S
lideshows are a good way to 
showcase your photography, and 
you can either play them back on 
your own computer or export 

them in a format which you can send to other 
people. The Sideshow module offers a small 
selection of preset slideshow designs [1] in 
the left-hand sidebar and, as usual with 
Lightroom, you can adapt these or create your 
own templates using the manual tools on the 
right. Bear in mind that if you save a new 

User Template, you’re only saving the 
slideshow layout, not the photos used in the 
slideshow. To save the whole production, you 
need to click the Create Saved Slideshow 
button at the top right of the main window 
[2]. Your slideshow is then saved in the 
Collections panel on the left.

Lightroom doesn’t offer a large array of 
different transitions and ‘themes’. It relies 
instead on a simple Fade effect, and you 
adjust the duration of each slide and the 

length of this fade effect in the Playback panel 
[3]. The other panels – Options, Layout, 
Overlays, Backdrop and Titles are concerned 
mainly with the arrangement of photos 
within the slideshow window and the text 
to be displayed alongside. At the bottom of 
the left sidebar are two buttons. The Export 
PDF button produces a PDF version of the 
slideshow which will play back in Acrobat 
Reader on other people’s computers, though 
there won’t be any music.

T
here are no preset templates in the Book 
module. Instead, you create books manually. 
You start in the Book Settings panel [1]. Here, 
you have the option of choosing a printed book, 

a PDF or JPEG versions of your book pages. Below this are 
Size, Cover and Paper Type options based around Blurb’s 
own book formats. At the bottom is an Estimated Price, 
though this will change according to the number of pages 
in your book. The Auto Layout panel [2] will populate the 
book with your selected images, but if you want control 
over the layout of the individual pages, you’ll need to 
select them and use the Page panel and its drop-down 
layout menu to choose from a variety of single and 
multiple-photo layouts, some with text boxes. The 
templates contain photo placeholders [3] which may 
already contain a photo. You can drag photos from the 
Filmstrip onto these placeholders. The Filmstrip displays a 
number at the top of each thumbnail to show if it’s been 
used in the book, and how often. 

Create a slideshow
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Cromer Pier
By Daniel Tink, UK

Using Photoshop CS2

Shot in raw, this is my first attempt at HDR 
photography. My aim was to bring out the 
detail and exposure of the pier from beginning 
to end with an eye to keeping the shot as  
symmetrical as possible. The resulting five 
exposures covering the entire dynamic 
range were blended in Photoshop CS2 using 
layer masks. Although more post-processing 
time is involved, I can officially say I’m now a 
huge fan of HDR. The increased dynamism 
over flat images is truly amazing, and has 
opened up a new and exciting world for me. 
www.scenicnorfolk.co.uk
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Titan Gate
By Michael Theophan Lujan, USA

Using Photoshop CS

I’ve been shooting raw for about ten years now. I shoot almost 
anything that strikes my fancy, although if it makes for a good 
science fiction scenario, so much the better! If it provokes 
a sense of wonder, I want to capture it. I took the original 
raw image as is, properly-exposed and white-balanced, and 
duplicated it into another layer, on top of the original. Then 
I used the Vivid Light Blend mode on the duplicated layer to 
heighten the contrast and saturation of the image. And lastly 
I applied a Curves adjustment layer, using the individual 
colour curves to increase the red and decrease the blue.
www.photomenon.com
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My Little Horse Shoe
By Gaël Trijasson, France

Using Photoshop CC

Why do I love photography so much? It is a simple way to 
stop living in the moment. This is anti carpe-diem, in short. 
Our environment provides us daily opportunities to marvel. 
You just have to look at the right time! Today, I like to capture 
the beautiful things to share. This is a panoramic photo made 
from four pictures shot at 50mm. I used a panoramic head 
mounted on a tripod and a remote control for trigger to avoid 
camera shake. After developing the files using Camera Raw 
(to fix the exposure and contrast) I assembled the photos 
using Autopano-Pro. Then I added some filters and curves in 
Photoshop to complete the picture. 
www.gaelphoto.com
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Early Spring
By Leszek Paradowski, Poland

Using Photoshop CS4

This was taken at the end of winter and the beginning of 
spring, close to my home in north-west Poland. Its surreal 
feel doesn’t come from my own photographic skills, but from 
the place where it was taken. However, I did use a wide-angle 
lens so that I could highlight an interesting configuration of
clouds. The image was initially prepared with Camera Raw 5.7, 
then I brought it into Photoshop CS4, where I increased the 
contrast, sharpening and converted it to black and white.
www.paradowski.net.pl
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Pier Storm 2
By Geoff Love, UK

Using Photoshop CS

Despite the dark conditions I kept the ISO low for this shot
of Tynemouth lighthouse, giving a slow exposure that
retained some movement in the waves. A wide aperture
focusing on the lighthouse gave me the slightly softer
waves in the foreground. The raw file was processed twice. 
Once for the main part of the image, and again to retain the
detail in the sky.
www.geofflove.co.uk
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A Glass of Wine
By Els Baltjes, The Netherlands

Using Lightroom 5

Taking pictures is a way of looking for me. I cannot look at 
things without a frame around it. The world around me exists 
because of so many beautiful things, great and small. I try to 
capture this beauty and share it with everyone who wants to 
see it! If that’s you, then I hope you enjoy it!

This picture is shot in raw on an Olympus E-M1 for 
1/250 sec using f/2.8 and ISO400. The model is sitting at 
a table. You can see the dots in her clothes as well as on 
the tablecloth. In front of her is a big vase in the shape of a 
wine glass. By using the perspective, it looks like a normal 
wine glass. The water in it causes the effect of a mirror. It’s 
just a matter of positioning to get her face reflected in the 
vase. I imported the picture into Lightroom, and added some 
contrast and Clarity. After that I turned it into black and 
white using the neutral filter of Nik Silver Efex Pro, using the 
sepia toning. Again, I added some contrast and brightness, 
and I cropped a bit off the bottom of the picture. The final 
touch is the light vignette.
www.eb-fotoart.nl
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She’s Got The Black
By Petko Petkov, Bulgaria

Using Photoshop CS6

I try to make photos that would stick in people’s 
minds. I believe that in photography, quantity 
has nothing to do with quality, and every 
photograph speaks for itself. So I try to give my 
best to every piece of work I make, hoping it will 
be appreciated for what it is.

I wanted to create something provocative, 
different and unusual. This is how the idea to 
paint my girlfriend’s skin black occurred to me. 
The lighting was very simple. I put two 
softboxes right in front of the model and slightly 
overhead. I wanted to achieve a natural look and 
maximum symmetry. The session was easy for 
both of us. It didn’t take much time and I was 
very pleased with the results.
www.ppetkov.com
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A Life in the Night
By Jean-Baptiste Rambaud, France

Using Lightroom 5

This photo was taken in France, near Nantes with a Nikon 
D300 and a 70-210mm lens. I used a wide aperture in order 
to completely isolate the butterfly from the background. The 
retouch allowed me to give a dream-like character to this 
photo by changing the white balance to colder colours. The 
rest of the work consists in modifying slightly the 
lighting effects of the bokeh and the contrast with the 
butterfly. http://500px.com/jbaptiste
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Blackness Boats
By David Queenan, UK

Using Photoshop CS

As I was walking back up from the beach towards my car, 
I stopped to clean the mud from my tripod legs. Turning 
around, I saw this view. I decided I had just enough time for 
one last shot before the light completely faded. I’d normally 
have taken this with a longer exposure, but my very old, 
cheap tripod has seen better days. When I set up the camera 
in portrait format, it sometimes starts to slip, so I had to 
almost half-hold it in place and keep the shutter speed as fast 
as possible – hence the wide aperture and high ISO this was 
taken with. I also used a 0.6 ND grad to darken the sky, then 
further enhanced it in Photoshop by processing the sky and 
foreground separately from the same raw file.
http://dqphotography.com
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Fury
By Patrizia Burra, Italy

Using Photoshop CS5.1

Initially, I used the Dodge and Burn tools in Lab mode on 
this image. I then added a new layer with the Soft Light 
Blend mode before desaturating it. I like to work with masks 
because they allow me to hide parts of the layer without
harming a single pixel.
www.patriziaburra.com 
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